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Maulik Jasubhai Publisher

Your Digit Just

N MY LAST Publisher’s Note in August 2004,
I recounted the many firsts that set Digit
apart from the rest of the technology
magazines in India—the first magazine with
a regular CD, the first to bundle two CDs, the
first to give away a movie VCD and then
India’s first magazine to distribute a DVD
with every issue.

But last August was so long ago!

Our readers are demanding, and surely
are India’s most knowledgeable technology
users. You expect nothing but
groundbreaking innovation from your
technology navigator. Consistently.

Having said that, at Digit we believe
innovation does not mean adding DVDs or
CDs. Innovation must be inspired, and it
should serve a specific purpose.

Fast Track, the book accompanying Digit,
was born out of this belief.

Fast Track is Digit’s latest value addition.
Sub-titled ‘Your Handy Guide To Everyday
Technology’ this book, with 200-plus pages,
is the ideal partner to the main magazine.

Digit will continue to retain its flavour of
being Your Technology Navigator; reviewing
the latest products, satiating your appetite
for gizmos, giving you productivity
solutions, helping you in business,
introducing you to the other side of
technology and how it touches (and can
touch) our lives in a million different ways.

Publisher’s
Note

Got Better!

Fast Track, on the other hand, will
concentrate on one topic every month,
giving you comprehensive coverage on all
you really need to know on that subject.

We decided to begin with Digital
Photography, a domain most magazines
touch upon only in skimpy detail. You could,
of course, buy a book on the subject, but
that would only dent your pocket, not to
mention dealing with dilemma of which
author to go by. A quality book from your
favourite magazine, bundled free with
every issue, therefore, makes for a
perfect combination.

Value-additions like this one are the only
reason why Digit has consistently been able
to retain its leadership position among
technology publications in India. But the
secret to being India’s No. 1 magazine goes
beyond innovation. It’s about passion and
loyalty. The passion that every single team
member at Digit brings to work everyday, and
the unshakable loyalty that you—our
esteemed reader—have displayed. Leadership
is but the natural outcome.

/

maulik44@jasubhai.com



Editorial

Don’t Piss Me Off}

I DON'T KNOW who Vipin Saxena is, but he pisses
me offl

Saxena, who operates from the upscale Mumbai
neighbourhood of Nepean Sea Road, sent me an error-
ridden SMS recently that read: “CAD/ProE[iDEA
AutoCAD, AMDT Corporate Class Engg.Drawing
Classes Excelant dEsign Engg.Software”. This was fol-
lowed by three telephone numbers and an e-mail ID
that asked me to buy the software and services he sells.
To cut to the chase, I had received spim, or spam SMS.

Since I did not know Vipin Saxena from Adam, I
called him, and asked him why he sent me the SMS. He
said it was a promo SMS. Well, d-uh!

“Where did you get my number from?”

“I send promo SMSes to random numbers.”

“Can you tell me who gave you my number, and
also give me your details so I can register a police com-
plaint against both?”

“Of course,” he said, and sent another SMS with
his address and telephone numbers.

He also told me—very politely—to go ahead and reg-
ister a complaint. I realised that I was not the only one
he had angered, and that he must be getting several
such phone calls from “aggrieved parties”. He was
used to it.

Pavan Duggal, India’s leading authority on laws
that govern information technology, sympathised
with me on this, but told me plainly that Saxena can
very well tell me to go to the police because under the
Information Technology Act 2000 of India, I cannot
register an FIR against him for invading my privacy,
nor can I sue him for sending me spam SMSes. The
Indian IT Act 2000, while being stringent on e-com-
merce transactions, maintains a deafening silence on
privacy and spam. Saxena knows it.

Saxena represents a band of IT Act manipulators
who know spam is immoral and unethical, but not
illegal. I don’t know a single person who does not
receive SMS or e-mail spam. Yet, we only either pri-
vately crib about it, or ignore it as another fact of life.

Harsh Pathak, who recently got good press because
he filed a PIL against telemarketing calls, missed out
on spam e-mail and SMS. Why Pathak appealed only
against voice calls and not against SMSes, may remain
a mystery, but Duggal emphatically states that spam

“The time has come to
join hands against
spammers—both of the
e-mail and SMS kind”

too should be brought under the ambit of civil and
criminal liability. Right now, though, there is no legal
recourse against spam of any kind in India.

The time has come to join hands against spam-
mers. We could start waging small battles like calling
each spammer back and giving him a piece of your
mind until he cringes; and if we keep waging these
small battles, we may just win the war.

U

sachin_kalbag@jasubhai.com




didit

YOUR TECHNOLOGY NAVIGATOR
March 2005 ¢ Volume 5 ¢ Issue 3

Chairman

Jasu Shah

Printer, Publisher and Editor
Maulik Jasubhai

President and Publishing Director
L Subramanyan

Head, Publications & Web sites
Louis D’'Mello

Editorial

Executive Editor Sachin Kalbag

Associate Editor (Technology) Sumod Hajela
Deputy Features Editor Aditya Kuber
Senior Writer Ahmed Shaikh

Writers Meera Vankipuram,

Preethi Chamikutty

Copy Editors Robert Sovereign-Smith,

Ram Mohan Rao, Renuka Rane

Test Centre

Deputy Head Deepak Dhingra

Senior Reviewer Aliasgar Pardawala
Reviewers Sanket Naik, Varun Dubey,
Jayesh Limaye

Coordinator Gautami V Chalke

Design

Lead Designer Jayan K Narayanan

Senior Designer Shivasankaran C Pillai
Designers Atul Deshmukh, Shyam Shriram,
Binesh Sreedharan, Vijay Padaya, Sivalal S
Photographers Mexy Xavier, Jiten Gandhi
Coordinator Rohini Dalvi

Multimedia

Content Lead Ahmed Shaikh
Programming Pradeep D’Souza,
Ashwin Nikam, Sandeep Ayyer
Design Sani Mani

Marketing & Sales

Head, Consumer Sales Saurabh Pandey
Brand Manager Nabjeet Ganguli
Marketing Communication Ashwin Boricha,
Vasuki Padakandla, Siddharth Singh, Mona
Talati, Elizabeth Jacob, Anurag Acharya
Ad-sales Coordination Ramesh Kumar

Production and Logistics

Head Operations Shivshankar Hiremath
Managers Harish Suvarna, Shiv Hiremath
Manager (Operations) Shailesh lyer
Deputy Managers (Production)

Mangesh Salvi, Prashant Nair

Production Executives Ravindra Dighe
Logistics Sandeep Rane, Anant Shirke,
Sriram lyer, MP Singh

Audience Development

Head Vijay Adhikari

Asst Managers Puja Punj

Digit Patron Cell Ghazala Siddiqui

Customer Service
Arpita Ganguli, James D’Souza

Head Office: Editorial, Marketing

& Customer Service

Plot No D-222/2, TTC Industrial Area, MIDC
Shirvane, Nerul, Navi Mumbai 400 706
Phone: +91 022-27629191/9200

Fax: +91 022-27629164

Printed and published by Maulik Jasubhai on
behalf of Jasubhai Digital Media Pvt Ltd, 26 Maker
Chambers VI, 2nd Floor Nariman Point, Mumbai
400021, India and Published from Mumbai

Editor: Maulik Jasubhai

Printed at Magna Graphics (1) Ltd
101 C & D Government Industrial Estate Kandivli,
Mumbai 400 067

COVER

Design Ashwin Boricha

Photograph Mexy Xavier

Model Shadab Khan

Location Courtesy Tangent Furniture Mall, Vashi
Shadab’s Wardrobe Heritage, Vashi

Make-up Sandeep

DIGIT MARCH 2005

Tell us What You Feel About Digit
Each month, Digit walks through the

technology maze to bring you the most Company Page
relevant, most researched stories. If you have Amkette 15
an opinion about anything published in Digit, Busy 55
or about technology in general, please write to Canon 13
editor@thinkdigit.com .

Cisco Back Cover
Product Testing Dell 16,17
Want your product reviewed by Digit? HCL 87
Contact our Test Centre at: HP 99
testcentre@jasubhai.com HSBC 37
Software on CD IBM 4
To submit and suggest software for IIT Roorkee 27
inclusion in the Digit DVD or CD, contact us Lexus 31
at: cdcontent@jasubhai.com LG IFC Gatefold

Logitech 69
Help! Lo i Maxtor 105
For any subsgrlptlon or Fopy-rela!ted issues, Microsoft 7475

g send an e-mail to help@jasubhai.com )

You may also contact the following Mosgr Baer .....ceueueee Inside Back Cover
executives for local queries: Nokia 32,33
Bangalore: Marshall S (09341809286) Priya Ltd 51
Chennai: L R Laxmanan (09380229283) Ricoh 21
Delhi: Puja Punj (011'51608659) Samsung 9Y 109
Hyderabad: Norbert Joseph (09396229281) Scorpio 2223
Kolkata: Jayanta Bhattacharyya (09331829284) §
Mumbai: Arplta Ganguli (022‘27629200) Seagate ................................ 78,79,81,82
Pune: Sachin Kamble (09372429280) Top Gun 35

Viewsonic 25
Endorsements/Reprints Wipro 45
Interested in ordering article reprints, or Zenith 13

using our logos?
Contact: siddharth_singh@jasubhai.com

Digit Patron

Get more for being a loyal Digit reader.
Register for the Digit Patron programme at
thinkdigit.com/digitpatron, or send an

e-mail to: digitpatron@jasubhai.com
Disclaimer: For every Digit contest, there will be only
one winner, unless specified otherwise. In the event
of a dispute, the Editor’s decision shall be final

Product Index

Hardware Zenith Strategist Apple shuffle
Laptops 90 | ppA-Phones o7 | Kodak LS755

ACI Emerald C2 W MSI Mega View 561
BenQ Joyhook 5100U Nokia 7710 Portable Media Player
Fujitsu LifeBook 57010 Nokia Communicator One PC EX

IBM R51 9500 Seagate 2.5 GB Pocket
1BM T42 02 XDA Il mini Hard Drive

MSI MegaBook
Toshiba Satellit

Wipro LifeGenius 1000D
Wipro LifeGenius CP

Zenith Director

M510C
e

PalmOne Treo 600 325

New and Notable 70
Apple iPod photo
Apple Mac mini

To Advertise

Bangalore

Vasuki Kashyap
E-mail: vasuki_kashyap@
jasubhai.com

Phone: 53256

Chennai

Sahayaraj Prabhu

E-mail: prabhu_sahayaraj@
jasubhai.com

Phone: 28235186/89

Kolkata
Jayanta Bhat
E-mail: jayan

jasubhai.com
Phone: 22345100/5200

Mumbai

Bhavesh Thakor

E-mail:
bhavesh_thakor@jasubhai.com
Phone: 56310515/14

New Delhi

Arvind Prabhakar

E-mail: arvind_prabhakar@
jasubhai.com

Phone: 51608658

Pune

Bhavesh Thakor

E-mail:
bhavesh_thakor@jasubhai.com
Phone: 022-56310515/14

Secunderabad

Sahayaraj Prabhu

E-mail: prabhu_sahayaraj@
jasubhai.com

Phone: 044-28235186/89

70/88, 2899287

tacharyya
ta_bhattacharyya@

STATEMENT ABOUT OWNERSHIP AND OTHER PARTICU-
LARS ABOUT DIGIT, REQUIRED TO BE PUBLISHED
UNDER RULE 8 OF THE REGISTRATION OF NEWSPAPERS
(CENTRAL RULE), 1956.

FORM IV
(See Rule 8)
1. Place of publication : Mumbai
2. Periodicity of its : Monthly

publication
3. Publisher’s name
4. Printer’s name
5. Owner’s name

: Maulik Jasubhai
: Maulik Jasubhai
: Jasubhai Digital
Media Pvt. Ltd.

6. Whether citizen : Yes
of India
Address : 26, Maker Chambers VI,

Nariman Point,
Mumbai- 400 021.
7. Editor’s name : Maulik Jasubhai
Whether citizen of India  : Yes
Address : Plot No. D-222/2,
TTC Indl. Area, MIDC,
Shirvane, Nerul,
Navi Mumbai-400 706.
8. Name & Address of individuals who own the
newspaper & partners or shareholders holding more
than one percent of the capital.

Mr. Jasu Shah Mr. Maulik Jasubhai.
1100 Shanudeep, 1100 Shanudeep,

10 Altamount Road, 10 Altamount Road,
Mumbai-400 026. Mumbai-400 026.

Jasubhai Media Pvt. Ltd.
3rd Floor, Taj Bldg,
210, Dr. D.N. Road,
Fort, Mumbai-400 001.

1, Maulik Jasubhai, Hereby Declare That The Particulars
Given Above Are True And To The Best Of My
Knowledge And Belief

Maulik Jasubhai
sd/-
Publisher
DATED: FEBRUARY 8, 2005
Printed And Published By Mr Maulik Jasubhai For
Jasubhai Digital Media Pvt. Ltd.
Printed at Magna Graphics (India) Ltd.,
101, C & D Govt. Indl Estate, Charkop,
Kandivli (W), Mumbai-400 067
Editor: Maulik Jasubhai




10

18

Adnan Sami on
what tech
means to him
18

Made in India:
The Handheld
Of Tomorrow
19

Internet
Explorer
vulnerabilities
—yet again!

28

‘Pharming’ is,
of course, next-
gen Phishing.
Here’s how
they do it

29 The Attack Of The Mobile Gamers =
The statistics are all telling us that mobile
gaming will really take off very soon. We
track the people who make it happen

34 Jewellery For Your Phone

You’ve got that coveted cell. Here’s looking
at the accessories that will add both
functionality and flash value to it

38 Enter The Matrix

Imagine computing anywhere, any time,
and getting a bill at the end of the
month for how much you compute

46 Take a Crack

You could win if you can get Windows
to display your company logo before
the XP login screen

42 ‘How Do | Get There?’

Here’s about India’s own Mapquest-like
site—and the brains behind it is just a 19-
year-old

44 30 Days With...

Our reviewer gets his hands on the
Nokia 9500 Communicator and comes
away suitably impressed

47 Geek Dreams
Here’s taking a look at the luscious
Nokia 7710

Contents Magazine

Digital Tools

49 Blog On The Go
There happens to be only one Indian mobile
blogging site. Can one make money off the idea?

66 Bring It Home

Ever wondered how DTH—Direct-to-home—works?
Here’s an introduction to the technology, and an
explanation of how it works

68 Tech Nightmares
A look at how you get around the most
common Microsoft PowerPoint blues

70 New & Notable

A look at the most eye-catching products of
the month, including MSI’s portable player,
the Mac mini, and the iPod Shuffle

76 Keeping (AC)Count
It’s tax season again! We test the top
eight accounting/tax software available

83 Agent 001
Your beloved Agent 001 gets back to the
basics—and hunts for keyboards and mice
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85 No-Strings-
Attached
Hospitality
Wouldn’t it be nice if
every hotel and air-
port were Wi-Fi-
enabled? One hotel in
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to customer demand
for Wi-Fi access and is
truly making waves
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We said it before, and we'll say 4, -
it again: back up, back up, back P
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DIGITAL PASSION

Star Wars: Republic Commando

Enter the dark military side of the Star
Wars universe as a squad leader of a
Republic Special Operations unit.

FOUR FULL GAMES

m Grand Theft Auto

m Grand Theft Auto 2

m Wild Metal

m Steel Panthers: World at War

PLUS
Unreal Tournament 2004: Air
Buccaneers

GAMES KNOPPIX
A Live Linux CD containing more than
50 playable games!

Also Included
m KDE 3.3.2
m Mathematica 5.1

DEV TOOLS

m Java 2 Platform Micro Edition (J2ME),
m Wireless Toolkit 2.1

m J2SE and NetBeans IDE 3.6

m MinGW

LINUX

= MPlayer 1.0 pre6a

m MPlayer 1.0 pre6a Source Code

m 15 MPlayer skins

= MPlayer manual

m Prozilla1.3.3

m Prozilla GUI

m GNUsound 0.6.2

m Blender 2.2.5

m Yafray 0.0.7-2

m Kino

m mythTv

m mythTV Modules

m Skype 1.0 (for Mandrake 10.1 & FC3

Note 1: Grey areas show the content also available on the CD. The DVD contains all that is on the CD
Note 2: If you do not want to boot from the CD, remove it from the drive at startup

DIGITAL TOOLS
NASA WORLD WIND

World Wind allows any user to zoom
into any place on Earth, leveraging high
resolution LandSat imagery and SRTM
elevation data to experience Earth in
visually rich 3D

AUTOPATCHER XP

With the latest patches for Windows XP,
this release will work with ANY version
of Windows

MULTIMEDIA

m Template Package | for NeroVision
Express

m DJ Jukebox 5.2

m Acoustica Beatcraft 1.0

mLive 4.1

m Pulse Master 1.7

m AudioCommander 3.0

m Focus MP3 Recorder 3.0

m Rosoft Audio Recorder 3.6.4

SYSTEM
m Spyware Doctor 3.1

m 0SL2000 Boot Manager Platinum
Edition 8.79

m Recover My Files 3.10

m nVidia video driver 66.93

m ATl video driver 5.1

m VIA Hyperion 4 in 1 Driver 4.53v
m Password Depot 2.0.6

m System Cleaner 4.97

m BestCrypt 7.11.04

= BCWipe 3.06.3

m PowerStrip 3.56

m Blender

m Quick Heal

INTERNET

m Yahoo Toolbar with Anti-Spy 5.5.5
m Cold Fusion MX 2004 Developer Ed
m BookmarkSync 1.7.2

m GetGo 2.55

m Grouper 1.3 Beta

m GoGoData Toolbar 3.0.1

m Super Ad Blocker 1.0.1670

m All-in-One Secretmaker 3.9.8.5

m Trillian 3.0

ESSENTIALS
m Adobe Acrobat 7.0

m Ad-Aware SE 1.05

m avast! Home Edition 4.5.549

m Copernic Desktop Search 1.2

m Microsoft Windows AntiSpyware
m Quicktime Alternative

m VLC Player

m 7-Zip 4.15 beta

m WinZip 9.0

m DirectX 9.0c Redistributable

m Autopatcher XP Jan Edition

m Quintessential Player

m .NET redistributable

DIGITAL BUSINESS

BusyWin

Windows-based Business Accounting
Software covering Financial Accounting,
Multi-location Inventory, Sales Tax
Reports including VAT, Excise Registers,
Order Processing and Invoicing

Timeless Time & Expense
Schedules4Team is an ideal workgroup
collaboration tool allowing you to
create and access a common workgroup
MS Outlook calendar, Free/Busy time
and share appointments, meetings,
events, and resources without a server

=
A+l

WHITE PAPERS

m Managing and Securing IM in the
Enterprise: Why It Should Be a Top
Priority

m The Adoption of ITIL in Large
Enterprises

PRODUCTIVITY TOOLS
mECTI 1.5

m InBoxer for Outlook 2.0
m UseBestMail 1.0.1.18

m SpamWeed 2.0

m Biometric Employee Punch Clock 1.1
m Database Designer Enterprise Edition
= KnowHowDB 2.4

m Schedules4Team 2.51.0028

= Plan for Windows 2.07
m Easy Projects .NET 3.0
m DevPlanner 2.0.741

Contents Interactive

DIGITAL LEISURE

DESKTOP THEMES
m Universal Crystal XP BricoPack RC1

m 189 Tux PNG Icons from CrystalXP.net
m 100+ Icons for Windows

m High quality icons from the GANT
pack

m 15 WindowBlinds Themes

SMALL GAMES

m AstroAvenger

m AirStrike 2

m Mario Forever

m 2D Counter-Strike

m Frutti Freak for Newbies

m Magical Broom Extreme (FULL GAME)

E-BOOKS

m Just in Tokyo

m Books on the Laws of Physics
including:

BConservation Laws

BNewtonian Physics

®Vibrations and Waves
BIElectricity and Magnetism
mOptics

BThe Modern Revolution in Physics

WALLPAPERS

m 240+ Wallpapers including
Hollywood/Bollywood Celebrities,
Games and Cool Cars

Busy

Business Accounting Softwar

Fully VAT-Compliant
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MS Will Require Authentication Of Windows
Starting the second half of this year, users will have
to authenticate their copies of Windows before being
able to download updates etc. from the Microsoft
Download Centre or Windows Update, the company

said in a recent press release.

Adnan Sami
Musician

n accomplished concert

pianist, singer and
composer, Adnan Sami is
often called the ‘fastest
keyboard player in the
world’. A tech-savvy
musician, he does not
hesitate to try new gizmos.

B GE&{‘ How do you use

x technology on a
daily basis?

™ | e-mail often and

,'-,-,_ browse the

& Internet to read

& about the latest in

* \)?) techn.ology, software

and music.

What gadgets do you use?
| keep upgrading my
hardware and software. |
have an Apple G5, digital
and DV cameras (Sony), a
56-inch GVC Plasma display
TV, BMW home theatre
systems and Onkyo amps at
home. In the studio, | use a
Compaq laptop, Yamaha
mixers, Tascam tape
recorders and CD burners.
How does technology help
you create music?
My music production is
entirely digital-based. |
work in London and
Mumbai studios, use
numerous music creation,
editing and sound-related
software. | use several
synthesisers including
Roland Fantom and
Yamaha Motif.
How do you keep update
yourself about news and
technology trends?
I surf music and software
related sites and read The
New York Times and
Variety. However,
‘information overload’
makes it difficult for me to
sift the genuine news from
the trivial.

AN INDIAN RAINBOW

Sony Ericsson To Launch Walkman Phone

Sony Ericsson will soon cash in on the ‘Walkman’
brand. The Walkman phone, due to be launched in

March, will have sufficient storage for six to ten
CDs' worth of songs encoded in MP3 or AAC format.
Tracks will be copy-protected using DRM 2.0.

Made In India: The Handheld
Of Tomorrow

t looks like a PDA; it

weighs as much as and
feels like one. But
functionally, it is more like
a laptop computer and a
mobile phone shrunk into
the body of a pocket PC.
And it has been developed
by Indian engineers at
iWave Systems
Technologies, an up-and-
coming embedded products
firm based in Bangalore.

The ‘Rainbow’ handheld
mobility platform is one of
the first devices in the
world to exploit the power
of a new chip, the Bulverde.
The Bulverde was launched
by Intel just four months
ago to fuel tomorrow’s
‘convergence’ products.

The Rainbow has
multiple wireless Internet
options: GSM/GPRS via the
mobile phone, WiFi, infra-
red and Bluetooth.

It is also one of the first
handhelds to exploit the
Linux OS. There is 128
megabytes of on-board
memory and a gigabyte of
expandable disk space.

The full-function
keyboard is larger than
what most handheld PCs
provide, while the display is
a 10-cm diagonal screen,
which doubles up as a
touch-sensitive panel. A
camera is integrated.
However, it is the Bulverde
that gives the Rainbow its
real strength—for instance,
it also has the ability to
send and receive DVD-
quality digital still and
video pictures.

iWave first

demonstrated the Rainbow
a few weeks ago at the
Embedded Technology
Conference in Yokohama,
Japan. The company’s
engineers expect that the
end price would be
somewhere between that of
a high-end phone and a
laptop, which should make
it around Rs 30,000

in India.

THE ALIANCE WILL WORK
WELL FOR BOTH

NIIT Ties Up
With SAP

IIT Technologies has

entered into an
alliance with SAP, the
world’s largest enterprise

applications software
provider. The NIIT-SAP
alliance will focus on
implementing projects in
the Government and
Public sectors.

Arvind Thakur, CEO,
NIIT Technologies spoke
about the significance of
the tie-up. “India is the
fastest growing IT market in
the Asia-Pacific region. Our
strong competence in
providing solutions around
the SAP solution suite and
proven track record in
enabling government
bodies to be more effective
and efficient, will enable
both organisations to
grow,” said Thakur.

Alan Sedghi, President
and MD (Indian
Subcontinent), SAP, added,
“Governments in India are
increasingly taking
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IE Vulnerabilities

Security Watch

[

The problem

Explorer, which can be
exploited by people with

‘cross-site scripting’ and

sensitive information,
bypass certain security

a user’s system.
Cross-site scripting
occurs when a Web
application gathers data
from a user. The data is

of a hyperlink that has
Damages

The possible damages
include: (a) A hacker can
script code in a user’s

further be exploited to
execute arbitrary code.

clicks a link.
Precautions
from Microsoft. Here is a
partial list.

For Windows XP SP1:
http://snipurl.com/cvn9

http://snipurl.com/cvnb

On February 8, security firm
Secunia reported multiple
vulnerabilities in Internet

malicious intent to conduct

phishing attacks, disclose

restrictions, and compromise

usually gathered in the form

malicious content within it.

spoof the address bar and
execute arbitrary HTML and

browser session. This can

(b) Certain vulnerabilities
can be exploited to link to
local resources when a user

Apply the patches available

For IE6 on Windows XP SP2:

“I think py
L 'wer Monster f; =Y
since it is the power ster” fits the bill,

. centre o »
Nirbhay Kotharj, Rajast f the PC.

“Iwould call it ‘Super Tank’ because =
han it contains all devices and chips.”
Sameera Shaikh, Navi Mumbai

advantage of technology to
increase efficiency. This is
a major sector of focus for
us. Partnerships are key,
and we are delighted to
work with NIIT.”

PAINTING PUNE RED

Red Hat Now
Has Shades
Of Tricolour

Red Hat, the open source
company, inaugurated
its Global Engineering and
Support Center at Kalyani
Nagar, Pune, last month.

Red Hat CEO Mathew
Szulik had flown down for
the occasion. The India
support centre will address
the support requirements of
the growing customer base
in India, and also serve
customers in English-
speaking markets around
the globe.

The Pune centre will
provide services such as
Web ticketing support and
knowledge management,
and will also

have a test lab for hardware
and software certification.
Also inhouse will be a
localisation team that will
work on the localisation of
Red Hat Enterprise Linux in
Indian languages.

Red Hat’s Global
Support Services is a 24x7
network currently located
in North America, the UK
and Australia. These
centres address the support
requirements of customers
in North America, Europe
and Asia. India is a new
addition to the list.
Speaking on the occasion,
Javed Tapia, Director, Red
Hat India, said, “Pune was
preferred as it has a large
pool of engineering talent
and it met all our
requirements.”

Compared with other
centres across the globe,
the manpower in India is
highly qualified and
comprises mainly technical
engineers. The support
provided by the Pune
centre is only Web-based.
Besides Web-based support,
the Pune centre will also
provide
training for
Red Hat
certifications,
such as Red Hat
Certified
Technician
(RHCT), Red
Hat

Certified
Engineer
(RHCE) and
Red Hat
Certified
Architect
(RHCA). The
centre
currently
employs 150.

qube Governor’ as it i the
main circuit board,”
Prakash Sapra, Gujarat

Broadband
In late January, |
in a survey of

almost 2,000

ad executives,

brand
managers and academics by
online magazine
Brandchannel, Apple was
voted the world’s most
influential brand.

P
Google NQI
Google has been
ousted from last
year'stop spotin [Google
the same survey.

Google has been

beaten for its ability to

I | ‘capture the imagination’. Not
surprisingly, Google hasn’t

| fallen much, and comes in at

Szulik is bullish about
the Indian open source
scene: “Indian businesses
and professionals are eager
to embrace open source.
Also, the workforce here is
very educated, energetic
and qualified. Such rich
resources are certainly an
invitation to companies
like us.”

ASK JEEVES RE-EMERGES
A Firefox-
based Ask
Jeeves
Browser?

sk Jeeves and the
ozilla Foundation
have begun discussions
regarding the possibilities
of a Firefox-based Jeeves
browser, and of donating
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A Round-up of Technology News from Across the Globe

UNITED KINGDOM

UNITED STATES

The grade school in Sutter, California, is requiring
students to wear radio-frequency identification
badges that can track their moves. The system was
imposed as a way to simplify attendance-taking,
reduce vandalism, and improve student safety.

upgrading to 3G handsets.

In a poll of 2,000 UK customers, 71 per cent of

respondents believe that mobile phone services are
getting more complicated to understand and
configure. The poll suggests that ease-of-
use issues could deter them from

BRAZIL

Information Technology Institute.

JAPAN

Technology-induced memory loss is now a proven
social phenomenon. A study by Kohno Clinical
Medicine Institute said more people are suffering
from short-term memory loss caused by their
reliance on digital devices and a lack of interaction
with other people.

KOREA

Korea’s Internet penetration rate crossed
the 70 per cent mark at the end of 2004.
Korea also has the world’s highest per capita
use of high-speed Internet.

South America is warming to Open Source, and
Brazil is leading the way. The President sees Open
Source as an important means of bridging the
technology gap between Brazil and more advanced
economies. He recently appointed Sergio Amadeu,
an Open Source enthusiast, to head Brazil’s National

AUSTRALIA

eBay Australia withdrew a couple’s
attempt to sell the ‘naming,
advertising and promotional’ rights
to their unborn daughter for
US$750,000. In the ad, the
unnamed couple from Perth invited
bids for the right to name their
baby girl, due on March 1.

Jeeves’ desktop search
technology to Mozilla.

Ask Jeeves, which made
its name as a natural-
language Web search
engine, has recently
expanded into areas as
diverse as blog
aggregation and desktop
search. In a recent
meeting with Mozilla, the
two companies discussed
specifics of the
collaboration.

“The main purpose (of
the meeting) was to discuss
Ask Jeeves and mozilla.org
working together and how
Ask can make
contributions to Mozilla
that make sense,” wrote
Tuoc Luong, Ask Jeeves’
executive vice president of
technology, in a February
11 blog posting.

SMS-A-FLIGHT

SMS 676711
For Travel
Updates

Users of the Airtel,
Hutch, Reliance, Idea,
Escotel, MTNL, Spice and

BPL mobile services can
now SMS 676711 to receive
travel-related information
such as flight availability,
schedules and seats
available.

This two-way messaging
service, launched by travel
industry technology
provider Amadeus, will
provide instant travel-
related updates to users.

Apart from this,
Amadeus offers services
that help travel service
providers—such as airlines,
hotels and car rental
companies—disseminate
information about their
schedules, availability,
pricing and ticketing of
their worldwide services, to
end users.

DECOUPLED FROM WINDOWS

IE7 Soon For
Beta Testing

Microsoft chairman and
chief software
architect Bill Gates
announced that MS will be
shipping an update to its
browser separately from
Longhorn, the next major

The File Extension Source

You know what .exe and .dll files do,
but what is a .qxd or an .Izh file? What
do you do with them? To know more
about files whose extensions you don’t
recognise—for example, to find out
more about files with weird extensions
on your computer—head to this site.
There are thousands of file extension
entries, a search tool, and a discussion
forum, too.

www.invisible-web.net

The Invisible Web Directory

Use this site to search for information
from the ‘Invisible Web’—the part of
the Internet that search engines do not
normally crawl. You can search or
browse by subject. This directory does
not list everything that can be found in
the Invisible Web—they “have over
1,000 resources listed”, which is a
small portion of what’s available.

CERT Coordination Center

Established in 1988, the CERT
Coordination Center (CERT/CC) is “a
centre of Internet security expertise”.
Here, you'll find almost everything you
would want to know about the current
state of Internet security, in easily
browsable form. Information about all
the worms and Trojans out there, what'’s
being done about today’s problems, what
you can do, research and analysis—it’s all
there. Definitely a periodic must-visit.
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release of Windows. A beta
version of Internet
Explorer 7 will debut this
summer, Gates said.
Longhorn is still slated for
a 2006 release.

Mike Nash, an executive
in Microsoft’s security
business and technology
unit, said in an interview
that it has not been
determined how or when
the final version of IE7 will
ship. The new browser
version will run on
Windows XP Service Pack 2.

IE7 will have stronger,
inbuilt security features,
including new
protections against
viruses, spyware and
phishing scams. The move
is the latest in Microsoft’s
three-year effort to beef
up security
in order to protect its
software products.

The presence of
Firefox, with its rising
popularity, seems to be
playing a role in the
development of IE7: the
new browser could also
include interesting
features such as headline-
watching capabilities to
allow it to better compete
with Firefox.

e ——

Every month, Dl:git
something funnier,

RADIO, TIVO-STYLE

Podcasting
Save Radio?

odcasters are pioneers of
sorts right now. Like the
bloggers before them, they
are changing the nature of
the medium. Podcasters
may, indeed, revitalise the
art of radio itself.
Podcasting, which you

Illustrations: Shyam Shriram

will ce-lrry a capt
and beat the Digt

ion for a photo. Come up w.ith
it team at their own game!

will remember if you are a
Digit reader, is much like
an audio magazine
subscription: a subscriber
receives regular audio
programs delivered via the
Internet, and can listen to
them at leisure.

Podcasts differ from
traditional internet audio
in two important ways. In
the past, listeners have had
to either tune in to Web
radio on a schedule, or
they have had to actively
download individual files
from Web pages. Podcasts

Beat

That.

Digit Caption
So is this what Modern Art
has been reduced to?

Last Month’s Winner!
Beena Mohan, Bangalore, is the
winner for her caption:
“Technology a la carte?”

Send your captions to
beatthat@thinkdigit.com
and win the
Cricket 2004
full version
game,

worth Rs 999/-
from Gayatri
Impex Pvt. Ltd.

are more flexible and also
much easier to get. They
can be listened to at any
time because a copy is on
the listener’s computer or
portable music player, and
they are automatically
delivered to subscribers,
hence no active
downloading is required.
Podcasters are by
nature an experimental
group. Podcasters are now
experimenting with the
nature of radio itself:
unique placement of
pacing elements, new
forms of
narrative, and
SO om.

By pod-
casting, some
podcasters are
already
developing
broadcasting
skills that radio

.~ veterans have
spent years
learning.

Despite radio
stations’ best
efforts, radio is
rarely
considered
‘appointment
listening’ by the
audience in the
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Dhruv Chakrabarti vs Sneha Patel

GENDER

BENDERS

Finding The Hardware
Configuration

Dhruv looks completely ‘chillaxed’ and smiles at the
simplicity of the task. He promptly right clicks the ‘My
Computer’ icon and enters ‘Properties’. The ‘System
Properties’ dialog box soon appears, and he then clicks the
‘Hardware’ tab. Dhruv zeroes in on the ‘Device Manager’
that displays the hardware configuration of the entire
system. What, done already?

Sneha is slightly anxious. She clicks on the Start menu and
opens the Control panel. She selects the ‘System’ icon and the
same ‘System Properties’ dialog box appears. But instead of
clicking the ‘Device Manager’ tab, Sneha clicks on ‘Hardware
Profiles’, which is as good as a dead end. Repeated clicking
makes no difference. She finally sees the light and hits ‘Device
Manager’. She has it right, but just a little late.

same way that people
schedule specific times to
watch their favourite TV
shows. The answer, of
course, is to let the listener
pick the time. Podcasting’s
distribution model is
transparent: the shows you
want get dropped into your
mobile audio device as they
air, and you can listen to
them, pause them, and
resume listening whenever
you want.

Radio stations face an

uphill battle today getting
to this kind of position. A
station might own the
commentary and the voice
talent, and might even
have the rights to use the
music on air, but those
rights may not extend to
on-demand Internet
broadcast. Once these
licensing issues are sorted
out, radio stations and
networks might just find
huge success adopting the
podcasters’ model.

IT’S A CPU, IT'S A MODEM,
IT’S BOTH!

Cheaper
Chip For
Multimedia
Mobiles

Here’s a mobile phone
chip that combines
a modem and processor
on one bit of silicon! In a
bid to bring down the
cost of making mobile
phones capable of
supporting 3D gaming
and 30-frames-a-second
video, Texas Instruments
(TI) has developed the
OMAP-Vox chip, which is
currently being tested by
firms in Europe and Asia,
and could appear by the
end of the year.

TT’s initiative seeks to
make multimedia functions
such as video and gaming
more affordable.

FIRST SPAM, NOW SPIM

Spimmers
Beware!

S teenager Anthony

Greco, 18, has earned
the dubious distinction of
being the first person to be
arrested for sending
unsolicited instant
messages—or ‘spim’.

Greco is said to have sent
1.5 million messages that
advertised pornography and
mortgage-related
information to members of
MySpace.com, an online
networking service.

To top it all, Greco
allegedly threatened to
share his spam tools and

methods if MySpace.com
didn’t sign an exclusive
marketing deal that would
legitimise his messages.

Greco was apprehended
by the police in Los
Angeles International
airport after he made the
trip from New York. He
walked straight into the
trap that the cops had laid
for him—making him
believe that MySpace
President, Tom Anderson,
called him to LA to sign
the deal that would
legalise his spim.

The popularity of online
networking groups and IMs
have led to the rise of
unsolicited IM spim, which
is considered to be much
more obtrusive than spam—
because spim is delivered to
you wherever you are,
without warning and
without filters.

CENTRALISING COMPUTING
ASSETS

ClearCube
Brings PC
Blade to
India

ith most companies

trying to decentralise
operations, data security is
a growing concern.
ClearCube Technology, the
pioneer in PC blade
technology, announced its
entry into the Indian
market in a press
conference on February 16,
2005. ClearCube is targeting
mid-size and large
organisations. Commenting
on the India launch, Raj
Shah, Global Chief
Marketing Officer,
ClearCube, said, “We

Microsoft’s Peabody Platform

Buzzword

of theftmfONTH

Microsoft recently unveiled Peabody, a
GSM/GPRS mobile phone platform designed
and integrated by Singapore-based Flextronics.
The platform is based on Microsoft’s Windows
Mobile software, and is a low-cost option that
has almost all the common smartphone features.
Available only to OEMs, Peabody (named after

the charming and cerebral dog from the Rocky

to order.

features cheap.

and Bullwinkle cartoon show) can be made

It’s not so much that Peabody phones will be
crammed full of new features, but that they’ll be
crammed full of today’s common smartphone
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What is Pharming?
Pharming has been called the
‘next generation’ of Phishing.
Phishing requires a person to
respond to a phoney e-mail in
order to be taken to an
illegitimate site; in Pharming,
the targeted person need not
respond to anything—he or
she is automatically whisked
to the illegitimate site.
How does Pharming work?
Pharmers use ‘DNS
poisoning’, or domain hijacks,
to redirect users to
illegitimate URLs in an
attempt to gather personal
data. DNS Poisoning is when
your DNS files are ‘poisoned’
with bad information. So, for
example, if you have a record
that points to a trusted host,
a hacker with malicious
intent can change it and point
you in a different direction.
Domain hijacking is when
a hacker takes over a domain
name illegally and directs
traffic coming to that domain
to wherever he wants to take
it. Both methods can be used
to direct users to fake Web
sites that look like legitimate
ones, and make users
disclose personal
information.
When did Pharming first
appear on the scene?
Pharming is simply a new
application of well-known
security weaknesses. There is
no ‘first Pharming attack
ever'.
Who pharms?
Pharmers are the same kind
of identity thieves who used
techniques such as Phishing.
Pharming is more
sophisticated because it does
not require the intervention
of the user!
Where have | seen an
instance of Pharming?
The recent hijack of New York
ISP Panix is typical of the
type of threat that might
emerge—such a domain
hijack could well be the first
step in a Pharming attack.

hope to secure channel
partners in India with
vertical expertise in
financial services,
manufacturing, BPO and
healthcare, as we belive
that these sectors would be
the first adopters of PC
blades in our country.”

The ClearCube solution
aims at centralising all
PC computing assets into PC
blades at a secure location,
with end-users connected to
the blades through small
devices called User Ports.
The PC blade computing
solution comprises of
the User Ports, ‘cages’,
the PC blade, and the
ClearCube Management
Suite (CMS).

The User Port
connects computer
peripherals such as the
monitor, keyboard, mouse,
etc. to PC blades
at the data centre or
telecom closet. The
ClearCube cage is a
centralised chassis that
houses upto eight PC
blades. The PC blade is each
user’s actual computer. It
includes processors, RAM, a
hard drive and a video card.
The CMS helps IT
administrators manage
the complete ClearCube
infrastructure from
any location.

THE SCOTS ARE COMING

Scotland
Invites
Investments
From India

cottish Development

International (SDI), a
joint venture between the
Scottish Government and
Scottish enterprise, is
seeking to attract overseas
investors to Scotland. They
would like companies to
invest in R&D centres,
joint ventures with
regional
companies, and
technology
transfer
subsidiaries.

Shivendra
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Singh, country manager, SDI,
says, “We look forward to
Indian companies investing
in microelectronics, telecom
technologies, the animation
industry and life sciences.”
Scotland is one of the most
preferred European locations
for companies looking for an
offshore setup. Singh
attributes this to the high
quality of manpower,
number of graduates,
employee loyalty and the
cost of setting up shop.

Scotland is also a
preferred location for
contact centre operations.
The reason being cited for
this is high-quality
multilingual staff at lower
cost, low attrition rates, and
a favourable time zone.

Scotland recently won
the European Region of the
Future 2004-05 Award,
presented by FDI magazine.

Sounds like the good
times for India will keep
rolling!

DVD PIRATES AVAST!

New DVD
Protection
Technology

C ontent-protection
company Macrovision
has released a new DVD
copy-protection technology
in hopes of substantially
broadening its role in
Hollywood’s anti-piracy
efforts. The copy-proofing
on today’s DVDs was broken
in 1999; courts have ordered
that DVD-copying tools

be taken
off the
market,

but variations of the
software remain widely
available online.
Macrovision executives
said that even if it’s not
perfect, the new RipGuard
DVD technology can prevent
much of the copying done
with such tools and can help
bolster studios’ DVD sales.
“Encryption standards
either work or they don’t,”
said Adam Gervin,
Macrovision’s senior
director of marketing, “Now
the cat’s out of the bag.
(DVD sales) are going to be
one of the main sources of
revenue for Hollywood for a
long time, so why leave
billions of dollars on the
table when you can do
something about it?”

FASTER INTEL CHIPS
More Cache
Per Chip

ntel recently announced a

new line of Pentium 4
desktop chips, which
contain 2 MB of secondary
cache—twice as much as
current Pentium 4s.

The new 600 series of
Pentium 4s consists of four
chips ranging from 3 GHz
to 3.6 GHz—all of them with
an 800 MHz bus. Prices
range from $605 (Rs 26,300)
for the Pentium 4 660 (in
quantities of 1,000) and
$224 (Rs 9,700) for the 630.

Also unveiled was the
latest Pentium 4 Extreme
Edition family—running at
3.73 GHz with a 1.066 GHz
bus. These chips are made
for high-end gaming PCs and
serious technology geeks.

From mid-2005 onwards,
Intel will start selling only
dual-core processors.

These are not as fast
as single-core chips,
but with an

equivalent of two
separate ‘brains’,
will offer better

performance. m
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The Attack Of the
Mobile Gamers

The mobile gaming boom is upon us. Here’s how India is gearing up

) Big Business

Aditya Kuber Even now, the numbers are not small, given the
size of the market. It is believed that almost six

obile phone users in India grew to almost to seven lakh games are downloaded daily across

. 50 million in 2004, and now outnumber India. “Ringtones are the current leaders in
landline users in the country. While this downloads by mobile users, but games are catch-

has opened the doors to many allied industries, ing up slowly,” says Rajiv
mobile gaming is being seen as the next big thing. — Hiranandani,
And why not: in 2004 itself, the mobile gaming A e, ‘\{_ \ |T-II country head,
industry is said to have been worth $26 million [ i i "‘“-1;"_ / Mobile2Win.com.
(Rs 113 crore), and is believed to have the potential i K":" ] As has hap-

T ‘\‘__:?; pened with other IT
# services, India may

soon find itself the pre-
ferred destination for cre-
ating games as well. Given the

to grow to a massive $336 million (Rs 1,460 crore)
by 2009. Given the numbers, activity in this
industry is currently hectic, and all the major __
players want to carve out a niche for themselves &= ‘5_ :
before the big bang!

y
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Number Crunching The Mobile Gaming Industry

30

B The mobile gaming market was
expected to make about £13.8m

(Rs 113.16 crore) by the end of

2004, according to a report

by InStat

D1 Many Indian kids see mobiles as
must-have gadgets. This is the target
audience for games

DI Experts reckon that 22 crore people

across the world will be playing games
on their mobiles by 2009

&1 Qverall, the Indian mobile gaming
industry will experience growth from
three million annual game downloads
by the end of 2004, to 367.2 million
annual downloads by 2009, and
revenues will rise to $336 million

(Rs 1,461.6 crore) by 2009

fact that almost 70 per cent of the income for
the top three mobile gaming companies in India-
Indiagames, Mobile2Win and Paradox Studios—
comes from selling their games overseas, this
might not be an entirely outlandish thought.
Indiagames and Mobile2Win also provide games
to many service providers across Asia, Europe
and North America.

Friends Of The Games

Revenues for these companies have been on
the rise, and the industry overall has also seen a
substantial rise in game downloads. But what
kind of games work best in India? “Bollywood-
based games are doing very well right now, as are
games that are event-based—like the ones we
create for festivals such as Dussehra and Diwali,”
says Hiranandani.

Vishal Gondal, founder and director, Indi-
agames, agrees. “Bollywood is overrated, but the
games we create for them do work. Unfortunately,
their life is not as much as that of some others.
Bollywood movies often lack a theme or a story,
and are hence not as attractive for most gamers.
At the end of the day, it’s content that’s selling,
not Bollywood.”

While gaming enthusiasts are taking to the
new way of playing, service providers also need to
be ‘gaming friendly’. It is being said that Bharti
Televentures (Airtel) are the most game-friendly
network, followed by Hutch and Tata Teleservices.
“This is mainly due to the circles these providers
are present in. Bharti, Hutch and Tata are all
present in the metro circles, where the penetra-
tion of GPRS is higher. Mumbai, Gujarat, Delhi,
Punjab and Haryana are the top five circles for
game downloads,” says Hiranandani.

The Players

Bollywood is
overrated but the
games made for
them work

Vishal Gondal,
Founder-Director,
Indiagames.com

games are their favourite,” says Hiranandani.

A look at the break-up of the types of games
sheds more light on what’s popular in the Indian
mobile gaming arena. (See ‘The Pack Leaders’)

Interestingly, Hollywood games are the most
popular, and as Gondal says, “These games have a
better theme to go with them. Hollywood pro-
ducers understand mobile gaming as a market
and as a money-making proposition, and treat it
so. Creating games for a Hollywood movie can
start even six months prior to the release. In case
of Bollywood movies, producers sometimes come
in a week before the release, and that much time
is hardly enough for a quality game.”

While Hollywood has its share of classics,
including Prince of Persia, on mobile, Bollywood is
just waking up to the reality and opportunities
mobile games are offering. “The Sholay game is the
only one at present that has any chance of
becoming a classic. The rest are made just so they
coincide with the release of the movie and create
some more hype,” says Hiranandani.

Money Matters

Games for mobiles are normally priced between
Rs 50 and Rs 149. And contrary to belief, games
priced higher have seen greater downloads.

“On a particular day late last December, we
saw 8,500 downloads of games priced at Rs 150
while those at Rs 100 were downloaded about
3,600 times. But games priced at Rs 50 were
downloaded only 400 times. The problem here is
that the Rs 50 games are downloaded only once
and they don’t get popular. Word of mouth is a
very strong tool in this business, and games
priced at Rs 150 benefit from this, thanks to the
quality,” says Gondal.

Games end up being priced this high thanks
to the monies spent by these companies in
acquiring rights to various titles or properties.
More often than not, these are non-exclusive
deals, but still cost a lot of money. “Rights to Hol-
lywood movies and characters are the most
sought after thing because the brand sells the
games. This number can be as high as almost 50
per cent of all games sold. This is where we really
compete,” says Hiranandani.

While the GSM market is flourishing, COMA
is not far behind. Reliance Infocomm offers
games for free as of now, but will start charging
soon. Paradox Studios, a Reliance company, is
currently developing

The average age of
mobile gamers is a lit-
tle higher than the
average age of comput-
er gamers. “Ages 16 to
27 are our primary tar-
get group, followed by
the 25-35 age group,”
says Gondal. The sec-

ond group of gamers Hollywood .
prefers the slightly qui- = 22 %0 Cricket
eter and sportier 20 %
games, including Chess

and Cricket. But for The Pack Leaders

the former, anything
goes. “Racing, warrior
games and action
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games for them in
addition to contracts
from international car-
riers, including Ver-
izon. “With Reliance,
we see greater down-
loads daily, almost to
the tune of five to
seven lakh a day some-

® \\Vu“u

: times. So far, with
Action Reliance offering
15 % them for free, we

Racing have created about 55
15 % titles for them,” says
Bollywood others Salil Bhargava, chief
15 % 10 % marketing officer,

Paradox Studios.
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Bhargava agrees that other compa-
nies are realising the importance of
gaming and could be bigger competi-
tors on the global stage: “The race is for
intellectual property. We have the
rights to Jean Claude van Damme for
two games that can be sold globally.
Similarly, other companies could have
rights to other stars or actors.”

While other Indian companies
create and sell about 70 per cent of
their games internationally, Paradox
sells almost 90 per cent of their wares

fd Most-Popular Games

DI Cricket World Championship
D1 Spider-Man

B Munnabhai MBBS

DI The Fast And The Furious

B Van Helsing

D] Sholay

DI Speedforge

DI The Day After Tomorrow

B Main Hoon Na

DI Teen Patti

in the global marketplace.

Tech Talk

With the increase of Java-based mobile phone
handsets in India, most of the games being
churned out are, naturally, based on this plat-
form. But BREW, we believe, is the next big thing
waiting to happen. “We are already creating
BREW games for Hutch in Thailand so we won’t
be off-.guard when it’s time to do that else-
where,” says Bhargava.

Gondal agrees. Tata Teleservices has launched
BREW-based games in India: “BREW has a better
business model and also receives better support
from Qualcomm. With Java, there is no stan-
dardisation, since there are so many vendors for
it. In fact, in Japan, even Flash Lite has caught on
for games on mobile phones.”

But Hiranandani has a different opinion on
this. He believes BREW is “not gonna happen”.
“Right now, almost 80 per cent of the gaming con-
tentisin Java, and given the spread—existing and

future—of Java-based phones, BREW will not be
such a significant player,” he says.

Laws And Legality

In a country such as India that can be best
described as a lawless haven for Intellectual
Property Rights and cyber-laws, these companies
are taking it unto themselves with the help of
regulatory bodies such as the Telecom Regulatory
Authority of India (TRAI) to maintain the sanctity
of their property.

Recently, Indiagames took a competitor to
court for allegedly copying the source code of one
of their popular cricket games. The action sent a
warning signal that stealing is not acceptable.

“The smaller outfits, or what could best be
described as mom-and-pop shops, will not survive.
It’s not just about money but also about pro-
tecting whatever you have created,” says Gondal.
Bhargava and Hiranandani concur.

Future-Ready

As with computer games, the future of mobile
gaming, too, is with multiplayer and 3D gaming.
In Japan and Korea, multiplayer gaming is
already big, and community gaming is catching
on. “3G networks will fuel the rise of multiplay-
er gaming and give the industry its next big
thing,” says Gondal. Reliance is already offering
three multiplayer games, and is adding more
shortly, confirming this trend.

While mobility changed the way we worked
and lived, mobile gaming may just change the
way we entertain ourselves. Are you connected? m

aditya_kuber@thinkdigit.com
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Varun Dubey

re you one of the millions of cell
Aphone fanatics who go into

depression if the cell doesn’t buzz
for a while? Is your cell phone your loved
one? Do you want to pamper and spoil it?
We take you through the myriad acces-
sories available to dress up your beloved
and enhance its functionalities.

Standard Bundles
Most cell phones today come in a fairly
bulky package, which contains a
charger and a vanilla hands-free set.
More expensive models come with
driver disks and data cables for syn-
chronisation with your laptop or
PC. These, however, are just the
basics. A little more investment,
and you can get a lot more func-
tionality and convenience.

The Cosmetics

The first thing that people change on
their phones is the face-plate—Nokia calls
them XPress-On covers. The Nokia 3220, for
example, has Wave Covers—wave them in the

Phone!

Here’s looking at some eyeball-grabbing accessories for your cell

or your

air and they flash a message you have written
on them!

There are hundreds of face-plate options avail-
able that let you personalise the look of your
phone. Though the majority of face-plates will
only fit Nokia phones, alternatives for other
brands such as Sony Ericsson are available. If you
have the money, your phone can take on a new
avatar everyday—perhaps matching your outfit for
the day. The costs? As little as Rs 60 in the grey
market, for the popular mid-range Nokias, to as
much as Rs 2,500 for an original Sony Ericsson
P800 face-plate.

So, what next? You can now choose from a
whole range of stickers and cool flickering LEDs,
which can be stuck behind your phone, near the
antenna. These will jazz up your phone, and with-
out burning a hole in your pocket—the LEDs start
at as little as Rs 30. If you can afford them,
Swarovski crystal embedded tattoos will give your
phone the uniqueness you yearn for.

Free Your Hands!

Now that your cell phone is all jazzy-looking
with blinking lights and colours that border on
the outrageous, you probably never want to have
to pull it out of your pocket, except for special
occasions or when the lights go out! The solu-
tion? Go hands-free!




Headsets (regular) 100 - 500 phoﬁlzarglaigrs?frildﬁfs yv?zlillli
Headsets (Bluetooth) 2,800 - 6,000 liberat;e ou from the chore of
Bluetooth Enabled phones | 7,500 - 40,000 aey
USB/IR adapters From 1,000/500 | DUlling your phone out of your
Chargers 100 - 500 pocket every two minutes and
Nokia Medallion 8,000 15 seconds to answer a call or
Digital Pen 12.000 view an SMS. Just set the phope
’ to auto-answer, and plug in

your hands-free! Be careful
though—you will need to get used to people look-
ing at you strangely for walking about talking
to yourself]

So what’s available? A standard made-in-an-
Indian-back-alley wired hands-free for as little as
Rs 100, the real deal for Rs 400 or more, and futur-
isticlooking Bluetooth headsets that start at Rs
2,800 (grey market). Good Bluetooth headsets are
really tiny, have a range of about 30 feet, and cost
anywhere from Rs 4,750 to Rs 6,000. Check the
talk and standby time of the cheaper models.

Jabra has released its BT800 Bluetooth hands-
free, which has an LCD screen that lets you access
last-dialled and recently-called numbers, send or
read SMSes and access your phone’s voice tags—
remember, you still can’t access your phone’s
menu or your contact list!

Even if you are one of the unfortunate few
stuck with a phone without Bluetooth, there are
adapters available that set your phone free of
wires. Nokia retails theirs for Rs 2,300, and it
works with almost their entire range of colour-
screen phones.

More, More...

Another type of hands-free that is available is
radio hands-free. This headset has radio inte-
grated—you can hum your way through the
chores of the day! An original Nokia radio headset
is priced at around Rs 1,800. Local-made radio
hands-free sets are available for as little as Rs 100,
and their clarity is decent enough.

For MMS-enabled phones, Nokia has released
a headset with an integrated camera that retails
for about Rs 3,450. Now you can snap pictures and
share them via MMS. This will make your phone
look really cool and you, tech savwy—though the
ladies might avoid you like the plague!

Speaking of public broadcasting, who says
your hands-free kit and phone conversations need
to be personal? Get Bluetooth-enabled hands-free
speaker sets with inbuilt batteries. Now, people
can hear both you and your caller yelling over the
phone while travelling in crowded buses.

What is Bluetooth?

luetooth is a short-range communications standard for wireless data com-

munications. It works in the 2.45 GHz band, and allows various devices to
connect wirelessly. Bluetooth technology was conceived by Ericsson, but
founded and developed by Ericsson, Nokia, IBM, Intel and Toshiba.

The current Bluetooth technology provides for data transfer at a rate of 1
Mbps, with a personal area range of up to 10m-client-to-client and open air,
and 5 m when in a building. For client-to-access point connections, the current
range is 100 m in open air and 30 m in buildings.

Unlike Infra Red, Bluetooth does not require line of sight, as long as you
stay within the range you will remain connected. Setting up Bluetooth is easy,
just switch on both devices and let them find each other. Now all you have to
do is enter a common pass key and you can start exchanging data.

1 col Ad
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Some of these speaker sets are meant for your
car, and plug into your car using a cigarette
lighter adapter. Nokia sells one car kit for Rs
12,000—it comes with a phone stand, charger,
speaker and the option of using the car’s speakers
or headset. The cheaper version has a charger with
an inbuilt speaker for Rs 4,000.

Backup Your Data

Imagine losing your phone! More than the cost
of a new phone, people cringe at the thought of
having to re-enter those hundreds of contacts.
What if you don’t have a hard-copy backup of
your contacts? Such disasters can be soothed by
synching your phone with your PC. All you need
is the manufacturer’s software and a data cable.

Data cables from leading brands cost about Rs
1,600, though most higher-end phones come
bundled with them. Though most phones can
connect to a via IR and Bluetooth, most of us do
not have computers with IR and Bluetooth ports,
making data cables more popular. You can buy a
USB to IR or USB to Bluetooth adapter for Rs 500
and Rs 1,000 respectively.

Certain high-end phones with SD I/O (Secure
Digital Input/Output) interfaces, and no Bluetooth
functionality, can use Bluetooth cards that look
like SD memory cards to become Bluetooth-
enabled. The same interface supports Wi-Fi cards
and modems, too.

Powerless

Your standard phone charger is good for your
home, office or hotel room. What if you are trav-
elling by car and your batteries die? Buy a ciga-
rette lighter car charger for your phone, which
costs Rs 200. Now charge your phone using the
car battery. Not everyone is a Nokia fan, and as a
result, when leaving on a family trip, you have to
pack three or four different phone chargers. This
problem can be solved by buying a universal

There is another
type of charger
that uses your
energy! Connect
it to your phone
and start
winding. It gives
you talktime and
a great workout!

Staying connected all the time is now a reality!

Using Bluetooth, you can achieve data transfer speeds of 1 Mbps between your devices

Why is it called Bluetooth?

arald Bluetooth was king of Denmark in the

late 900s. He managed to unite Denmark and
part of Norway into a single kingdom and intro-
duce Christianity into Denmark. He was killed in
986 during a battle with his son, Svend
Forkbeard. Choosing this name for the standard
indicates how important companies from the
Baltic region (nations including Denmark,
Sweden, Norway and Finland) are to the commu-
nications industry, even if it says little about the
way the technology works.

charger, which has pins that connect to various
phone brands, an all-in-one adapter, and costs a
mere Rs 150.

Another cool accessory is the desk stand,
which lets you charge your phone sans the hassles
of attached wires—when the phone rings, the desk
stand’s speakers and mic let you accept the call
without having to touch the phone.

What happens when you are out in the wilder-
ness (read: away from a electric socket)? There is
a charger that runs on three AAA cells and can
restore enough power to your phone for about an
hour of talk time or four hours of standby time.
And all this for just Rs 120!

There is another charger that uses your energy!
Connect it to your phone and start winding. It
gives you talk time and a great workout! This prod-
uct is yet to make an entry in India.

Signal Strength

If you travel to areas with low signal strength, or
your operator has bad coverage, consider external
antennas. These attach to your car roof, connect
to your phone wirelessly, receive signals, amplify
them, and then send them to your phone—the
result is much higher clarity than normal.

Other Cellular Eye Candy

Almost all manufacturers offer external cameras
that you can use independently. The Nokia
Medallion costs Rs 8,000, can be worn around
the neck, and displays the photos you click.

Nokia also has the Digital Pen, for approxi-
mately Rs 12,000. You can scribble notes and
send handwritten personalised notes via MMS.
Whatever you scribble is stored in the pen itself,
and can later be transferred to a PC. It also boasts
of Bluetooth and an integrated camera.

Another useful but quaint accessory is the
Cell Socket. Connect your phone to its
cradle and receive cell phone calls via your land-
line—like an EPABX system.

Another cool accessory is the Travel Pac Wire-
less Handsfree Kit, which connects to your phone
speaker and beams the voice at any of two preset
frequencies that you can catch on your car’s FM
radio using the car speakers as a hands-free kit!

This is just the beginning. Accessories are
being invented by the thousands—just think of a
way life could be easier, and accessorise! Not all
the aforementioned accessories are readily avail-
able in India, but then again, what good are rela-
tives who live abroad? &

varun_dubey@thinkdigit.com
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Ram Mohan Rao and
Robert Sovereign-Smith

hink of the way you use
I your mobile phone,
anywhere you have
network. Think of how you
charge it: at least 10
points all over your
home, your office, your
car charger, in hotels,
airports, airplanes
and trains! Now,
think of these
network areas and
electric  supplies
~ becoming comput-
ing power outlets...
There’s a fundamental reason why
you cannot store a two hour DivX movie
on your handheld computer; it’s the
same reason you cannot do high-end video
rendering on your old Pentium III
computer. Resources!

From RAM to computing power and hard
disk space to optical drive resources to network
bandwidth, every aspect of our current
computing experience is marred by bound-
aries, by limitations. Computing technology is
on the verge of evolving past these bound-
aries—researchers have been coming out with
solutions to the current limitations.

1 Binesh Sreedharan

Imagine every device in a grid; imagine if every device
ould compute and store data like a supercomputer

The Computer Caste System

Just as in every other aspect of life, we have segre-
gation of the haves and have-nots in the comput-
ing world. Just as everywhere else, this boils
down to money. The reason why one of us has an
AMD Athlon XP 64 and the other still works
on a Pentium 3 500 MHz, is the Computer
Caste System.

What about electricity? Every little house in
India’s big cities enjoys the once-luxurious
commodity called power. Another example is
Internet penetration. This has increased in
orders of magnitude over the past decade. Why?
The keyword here is utility! A computer or a car
are examples of luxuries; electricity, water,
public transport and the like are examples of
utilities. You pay for as much as you use!

Most of us cannot think of buying a limou-
sine, but we can rent one to impress a client. So
imagine if you could use computing power as
variably as you do water or electricity. At the end
of the month, you receive a ‘computing bill’. This
is not a dream; in fact, experts say it’s only a
matter of time before it becomes the norm.

utility Computing

As we mentioned earlier, every traditional
computer environment setup is limited to itself,
every computer is self sufficient, or actually, self
limiting. Every component of a computer is
treated as an individual product—each
computer’s graphics card for example, dictates



What About Software?

Current software is as limited as our hardware,
but this will need to change in order to achieve
Utility Computing. In a true UC environment,
things such as an OS don’t mean a thing. Users
are not classified according to ‘Windows’ or
‘Unix’, but merely by the task they want done.
Yes, applications need to remain familiar, but
hardware and software need to become two
independent entities.

So You Mean Grid Computing?

No, we do not! Grids may simply enable utility
computing. Grid computing is used to achieve
impressive number crunching capabilities, as is
the case with the SETI@home project.

The Search for Extra-Terrestrial Intelligence
(SETI) revolves around capturing radio waves from
space and computing them to look for patterns—
as in communication. The problem is that all solar
masses in the universe release radio waves into
space. Essentially, the SETI project is looking for
the proverbial needle in a haystack the size of our
universe. Since they don’t have multi-billion
dollar research grants, they hit upon the idea of
using the Internet as a distribution tool and
getting computing help from the masses. If you

what that computer can achieve in terms of System Properties i IS
display. The same applies to hard drives and As tech nOIOgy SitamAasion: || Aummasalipdsss. | Raso
other components. Networking has reduced the becom (:'.'S more
limitations of storage space—now other compo-  pervasive than
nents of the computer need to break free. ever, your PC
In a Utility Computing (UC) scenario, noth- might soon wield Our Computer:
ing is bound to anything else. There is a virtual more power 70,65,345, users,
pool of resources, available to any task, and as a y 65, 43,58, 723 processes
result, any user, who needs it. The dynamics of than tOdaV S
this resource pool are constantly changing as Supercomputers b Resoliiees:
the needs of the collective user-base change. ﬂff;ﬁf;'\gzm s
In order to understand the functioning here, B,ég. 307 GHz =
imagine a PC just the way it is, with the difference
being the fact that none of the components in your
computer belong solely to you. In a UC environ-
ment, your computer’s unused resources could be
allocated to other users in the same UC grid. It all
boils down to leasing computing resources just as
we do for electricity. Billing can also be done easily
on a per-grid, per-group or per-person basis. We
could have next-generation Params sitting in [0k ]| comce |
government labs, computing for the masses.

Soon, My Computer will become ‘Our Computer’

download and install the SETI@home client, your
computer will download a small chunk of radio
data from SETI, and when you are not using your
computer, it processes the data.

Because of the millions of people running this
program, SETI benefits from free computing that
would otherwise cost them millions of dollars in
supercomputer time.

‘Our’ Computer?

Utility Computing, however, is not just about
number crunching. It is about sharing every
resource that a computer currently uses. And
more importantly, UC is all about ‘on-demand’
resources.

In the ideal UC scenario, terms such as speed
and capacity do not exist. When a task needs to be
completed, it is done as fast as the overall UC grid
will allow. So, say you want to render a two-hour
animation you created, you don’t need to worry
about which drive to store the large file on, or
shutting down applications to make the process
faster. Hard disk space and CPU and GPU
resources would be allocated as the need arises.
Gigahertz clock speeds and GBs of disk space
would mean nothing. A system specification

R74 A Chip That Computes 10 Times Faster Than Exisitng CPUs

BM, Toshiba and Sony recently collaborated on research for a new

chip called the ‘Hard Cell’ or ‘Cell’. This new chip will power Sony’s
upcoming PS3 gaming console. Toshiba will also put the Cell to use
in an upcoming line of HDTVS. The companies call it a
“supercomputer on a chip.”

The best thing about the Cell is that it is rated to be 10 times
faster than existing CPUs. According to IBM, it contains “eight
synergistic processors and top clock speeds of greater than 4
GHz (as measured during initial hardware testing).” This new
chip is capable of massive floating point processing—which is
required by graphics.

However, that’s not the reason why we mention it here. The
feature that excites us most is that the cell is a multi-core chip with
a difference: each processing unit in the Cell can process
information from different tasks. Existing chips can only handle one

task at a time, so even if the task is relatively small—using almost
nothing of the CPU’s capability—the processor does not accept more
tasks. With the Cell, however, multiple tasks can be executed
simultaneously, with the central Processing Unit (PU) deploying work
to the Attached Processing Units (APUS). This increases efficiency
tremendously, and is the reason why the creators are confident of
the Cell outperforming current chips 10 to 1. Since the APUs are sort
of like freelance workers, unused computing power can be shared
over a network of Cell-based computers, forming a computing Grid.
The ‘cell’ that gives the chip its name doesn’t refer to the
hardware, but to a virtual clump of software that roams the system
looking for computing resources. For Sony’s PS3, this means that a
network of PS3s can share resources so that everyone has a better
gaming experience. This could be the beginnings of Utility
Computing. At least we know now that the hardware already exists!
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query might return something akin to what
KaZaA displays—Our Computer: 70,65,345 users,
65,43,58,723  processes; Free  resources:
44,58,92,87,345 GB; 8,69,307 GHz!

Who Will Govern uc?

A valid question, but one that still has no clear
answers. In order for UC to become a reality,
governments will need to get involved. The infra-
structure required is tremendous, and more
than any individual company can finance. Of
course, software also has to be written to support
and share the hardware.

Another possibility is that, as with
SETI@home, groups may form to freely share
resources and form private grids. In this
scenario, everyone buys hardware and software
and then joins their favourite UC group. Perhaps
private groups will charge a nominal fee to
become a member and review each member’s
contribution, based on which the annual fee

Rv4 Communications Central

would increase or decrease. Everything will be able to communicate, and share resources

Another possibility is to leave UC to care for
itself, as happened with the Internet. Just a few
governing bodies here and there to prevent total
mayhem, but we’d still have the gigantic process-
ing power of every computer online!

What About Privacy And Security?
The greatest fear of using UC will stem from
privacy and security. Every computer out there,
whether at work or at home, contains some
information that the owner considers private.
People fear that joining a UC grid is akin to
publishing all your hard drive’s content on the
Internet—and with write access!

Perhaps that’s why governments need to be
involved. We need the accountability that is sorely
lacking with the Internet. The threat of spyware,
adware, viruses and worms from the Internet is
already invading our privacy—we don’t need less
privacy, we need more. Software and hardware
vendors will claim to design products that offer
you privacy, but they promise that already, and we
already know that everything tech is fallible.

What About Other Devices?
It’s not only computers that will benefit. With
pervasive computing and convergence becoming
reality, soon everyone will know how to use gadg-
ets, and will want to only work with gadgets. We
will forget about, say, standard refrigerators. We
will want a single input device, like the
computer, and expect everything else to know
what our computer does.

Let’s say you plan a two-week vacation; you tell
your computer this; the computer informs all your
gadgets. The fridge informs you that you better

M4suseria |
un Microsystems Inc. is ready to unveil its Sun Grid. It plans to open six grid
Scentres around the world.
Customers can access the grid and are charged a mere $1 per hour per CPU.
Out of the six data centres, three are in the US, two in the UK, and one in Canada.
The servers consist of both Sun’s SPARC and AMD’s Opteron processors, all
running Solaris 10. This is the first step to managed UC being offered around the
world. Sun plans to have a global grid, but with regional services.

remove the ripe tomatoes and the Macaroni Salad,
lest you want to come back to a messy and smelly
fridge. The washing machine reads the tags on
your clothing and tells you that you need to do a
quick wash if you plan to take your best clothes.
The car informs you that you haven’t had it serv-
iced this month, and you definitely need to do so
before your long drive. Your mobile automatically
selects and chooses the right roaming plan. You
give the go ahead, fall asleep, your body monitor-
ing-watch and alarm clock communicate and find
the ideal time to awaken you—they consider how
much rest you have got according to your body’s
readings, and also how much time you normally
take to get ready at this time of the day. You wake
up, your hot bath is already waiting for you...
This scenario seems out of place when talk-
ing about Utility Computing, but is a necessary
example to inform you that everything will have
an embedded chip soon, and everything will be
connected. Universal resources are the key; and
just as they are not hardware or software
specific, the are not device or task specific either.

Is Any Of This Actually Possible?

All of the above was theory of course, but theory
based on facts. (See boxes ‘Sun’s Grid’ and ‘The Cell’)
The fact is, companies have just started releasing
results of years of research. The Cell, for example,
was developed by IBM, Toshiba and Sony. It will
be the first processor that can share resources
with similar processors.

Sun’s UC plans also prove that there is a
market for on-demand computing, and that the
bigwigs are sitting up and taking notice. UC needs
the likes of Sun, IBM, Sony, and others, to take
interest in this promising field. Not only will this
increase competition, it will speed up the creation
of solutions to the problems faced by UC.

As technology becomes more pervasive than
ever, your PC might soon wield more power than
today’s supercomputers. And all this will come
at the price of your household utility bills! &

ram_mohan@thinkdigit.com
robert_smith@thinkdigit.com
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‘How Do | Get

This question
could well be
redundant,
thanks to
19-year-old
Rohan Verma’s
MapMyindia.com

Meera Vankipuram

he geographically challenged amongst
us have yet another reason to cheer.
Nineteen-year-old Rohan Verma from
New Delhi has helped create a Web site that
has digitally mapped several cities in India.
MapMylndia.com, one of the largest map
and digital information databases in India,
helps you access the map of a particular city,
town or village at the click of a mouse. Just
type in the name of the state, city and area and
bingo, you get a detailed map.
You can choose to zoom in or out further,
or even pan across the map to look for a
specific area. City maps have a greater resolu-
tion, and can be zoomed in to the street level.
Maps of rural areas have not yet been charted
in such detail.

Imaging Atul Deshmukh

re?

Cities in the level 1 to 4 segment have
maximum detail, and you can choose to plot
on the map anything from holy sites to rail-
way stations, and hotels, shopping centres,
historical landmarks, hospitals, and even the
nearest ATMs.

Digitising India

Created with the help of satellite images and
geographical surveys, digital maps resemble
photographs with information mapped in the
form of points—each point has a specific
colour, representing land, water bodies, roads,
etc. Digital maps are also accompanied by
databases of relevant information—a list of
popular tourist spots, for example.

Intended to be an Indian version of popular
international ventures such as Yahoo! Maps
and Mapquest, MapMyIndia was an idea born
during Verma’s summer internship with
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CE Info Systems, a Delhi-based company that
has been involved in Geographical Information
Systems (GIS) development for the past decade.

Says Verma, “I wanted to develop a service
that was India-specific. It was originally
intended to be an Indian version of Mapquest,
but now we’re thinking of adding more serv-
ices relevant to India.”

The MapMylndia team has currently
mapped about 35 cities and several villages,
with more being added on a weekly basis. The
team is also collaborating with state govern-
ments to execute the project.

Says Rakesh Verma, MD of CE Info Systems,
“We received numerous requests from users
and members of the GIS community to
prepare an interactive and user-friendly map-
based information services.”

By making the service available on the
Web, MapMyIndia has made it easy for anyone
with a PC and an Internet connection to
access the information. “We aim to empower
anyone who travels within India—be they local
residents or business travellers or tourists,”
affirms Rohan Verma.

MapMylndia also provides customised
solutions for businesses. Displaying the loca-
tion of a company, bank or hotel on an inter-
active map could be an attractive value-add
for a customer.

Says Verma, “We could extend our GIS
services to ATMs, for example. Using the

MapmyIndia

INDIA...ON A MAP...
Like never before

g =

al &

It (MapMylndia)
was originally
intended to be an
Indian version of
Mapquest, but
now we’re
thinking of adding
more services

Rohan Verma

The brain behind
MapMylIndia.com

3l

£

The more detailed the query,
the better the search results.

MapMyIndia also
provides customised business
solutions: companies, banks,
hotels, and the likes, could
be featured on the map of a
particular area

Vo Write In

Done something just
as geeky?

Tell us about it.
Write to editor@
thinkdigit.com

location.

BRusiness Solutions

MapmyIndia Business Solutions Suite

Conwert onling traffic inko physical custamers.

Where is your business location? How does a potential customer get
to wour business location? And finally, what is around wour business
location? MapmyIndia offers location-based business solutions that
leverage the reach of the internet to bring potential and existing
customers to your business location's doorstep,

Companies looking toimprove on their popularity, business and easy
accessibility in terms of both the incoming traffic to their websites
andjor their outlets can draw benefits from these business solutions,

By letking your customers know where vau are and how to get there,
wou can provide visitors to your website an enriched and more
informed online experience, associate yourself with cutting edge high
technology, and most importanly, conwvert online traffic into phwsical
customers by leading web surfers to the doorstep of wour phwsical

Locking at the different requirements and interests of different
customers, MapmyIndia business solutions offer diverse range of
lncation based products for bath online and offline applications.

Store/Enterprise Locator feature on the site,
people who are in a particular area can log on
and find an ATM.”

MapMyIndia will soon also provide busi-
ness listings, which can help customers iden-
tify business districts, restaurants, and so on.

Track Your Team

In 2000, CE Info Systems launched ‘Mappls
Mumbai Pathfinder’ in print and CD-ROM
versions, a comprehensive collection of digital
maps of localities in Mumbiai city. ‘Pathfinder’
covered over 800 square kilometres of
geographical area, demarcated by PIN codes,
telephone exchanges, police stations, munici-
pal wards and so on.

The collection is in the form of sectional
maps of 15 square kilometres, each linked to
the other. The maps depict every street and
road in a particular area, including prominent
landmarks, offering a magnified view of up to
one square kilometre of select localities—and
even individual buildings.

Although Pathfinder was a fairly compre-
hensive undertaking, an online venture, feels
Verma, would help a lot more people access
and utilise the digital map database.
MapMyIndia has now tied up with several
corporate organisations, as well as the
Government of India, to add more cities, towns
and villages to their database.

The company is also planning more
features such as car-based navigation systems,
and local tracking systems—for parents to
track children returning from school with the
driver, for example, or a company to track its
sales force through mobile phones and other
WAP|GPRS enabled devices. These services will
be made available to customers via
MapMyIlndia’s “Business Solutions” section.

Stanford Sophomore

Rohan Verma’s initial ideation was followed by
exhaustive research on the technology back-
end, the business model, and design specifics.
Post the launch, in the first month alone, the
Web site registered a million hits—a number
that has been steadily on the rise.

The MapMylndia.com team currently
comprises software developers, cartographers
and GIS digital experts.

Rohan Verma is currently pursuing a BS
in Electrical Engineering at Stanford
University in the US. At Stanford, Verma is
involved with the Hindi Film Dance club
(“There is only one kind of Indian dance out
here, and that’s the Bollywood kind!”), sports
and entrepreneurship cells.

He has earned many accolades, including
the ‘Best Work Study Student Award’ from the
Stanford University Registrar (for making the
Stanford Bulletin Web site more accessible and
Net-friendly), and the President’s Award for
Academic Excellence in the Freshman Year.

Verma foresees a career in chip design or
architecture. “I also want to develop and offer
some world class location-based services to
people in India,” he says. E

meera_vankipuram@thinkdigit.com
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...Nokia 9500 Communicator

. I found you can activate or deactivate Bluetooth,
Sanket Naik )
he Nokia 9500 C. i p IR, etc. using a shorteyr on the keyboard—hoy
a 80t to use the Nokia 500 Ommunicator for ; i
i '. about a month, Here’s a brief account of my thoughtful .Of Nokia, 'The Phone part of the 9500 is
fling with it. a usual series 40 Nokig Dhone. The keys are large,
however, the round five-directiong] rocker is quite
. Day 1 dodgy—you end Up getting into the wrong meny |
We received the 9500 Commumcator and as usual when you press the centre of the rocker.
The Question was asked: Who'l get it for a month?
Well, since I reviewed the eqrlier 9210i Day 7
. Communicator, | made my stand clear. [ opened

Decided to try out the PDA Junctionalities. The
menu structure is easy to grasp, and applications
are properly grouped, Synchronising the phone
with Outlook means you first need to instql] the
Nokia PC Suite from the CD. The Nokia PC Syite

the box, and behold, there it was—q big silver
chunk. Someone shouted: “It’s compass box!l” For

the moment, I slotted in g SIM card and hooked
. up the thing to charge it,

Places an icon in the system tray, and one can
Day 2 select the appropriate module, Using the software
. The sliver-grey outfit on the 9500 doesn’t do it is simple: just select, click Next’, and voila—ayp my
Justice; Nokia could have come Uup with a better contacts were in the phone, I qlso copied some MP3
colour scheme. This phone is much begter than the files and other data to the phone,
. . 9210i Communicator in terms of weight and

ergonomics. I found the JSull QWERTY keyboard q Day 13

bain to operate: the keys were cramped, | thought  Went 1o the Orange centre to activate GPRS on my
I'd get used to it over time. Typed in an SMS

SIM, and was politely made to wait Jor a halfhoyr
e proclaiming I had a 9500, qnq sent it to all my before they did the needful. It cost me Rs 500, T
Sriends. In the evening, they were drooling all tried some browsing, and though I'm not

over the thing. accustomed to a smqj] screen, I found it

reasonable. Filled in the mail server settings and

8ot all my maqils delivered right to my palm.
Fantastic!

- Day 4

" Used the device to take
some photographs, and

wanted to transfer Day 21

them onto my PC.
Went through the
menu looking for the
Bluetooth and

switched in on,

Transferring Jiles three hours, (Frankly speaking, I am not good
was a piece of at networking,)
. \\ cake. Later on,

. .
d

Day 23:
The 9500 Communicator is a great device,
loaded with Jfeatures, easy to use, and the best
thing to show off with. Though the keys are
small, getting used to them is a matter of
days; in my case, 15 days!

Day 30
What everyone’s got to say about the
9500 is, it’s g great device if you don’t

mind keeping it gripped in your palm
all the time. /

sanket_naik@thinkdigit.com
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How would you
display your company
logo before your
Windows XP Login
screen?

Send your solutions
to takeacrack@
thinkdigit.com

LAST MONTH’S CHALLENGE

Take a Crack

and Win

Programming with Visual
Basic 6.0

By Mohammed Azam
Published by Vikas Publishing
House Pvt. Ltd

WINNER
Mangesh Patki

Rules and Regulations

[»] Readers are requested to send
in their answers by the 15" of the
month of publication.

[»] Employees of Jasubhai
Digital Media and their relatives
are not permitted to participate
in this contest.

[»] Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

[»] Jasubhai Digital Media is
not responsible for any damage
to your system that may be
caused while you are solving
the problem.

DIGIT MARCH 2005

THIS MONTH’S CHALLENGE

Displaying Your
Company Logo
Before The
Windows XP Login

Screen

Creating A Windows XP Boot CD With SP2

Prerequisites

D] Windows XP CD

1 Windows XP SP2 archive

D1 CD-RW Drive

D] CD-Writer Software with
Boot CD feature

D1 A software that can
extract Boot image from
Bootable CDs

B Around 1 GB of free space
on hard drive. This can be
freed once the CD is
created.

A Three-step Process

First, create a folder
STEP on your hard drive

e.g. D:\XPCD. Now,
copy the entire contents of
existing Windows XP CD to
this folder. The Windows XP
SP2 executable file is an
archive of the Service Pack 2
files, so you can use WinZip
and extract SP2 files to
another folder say D:\SP2.
Now, locate update.exe under
D:\SP2. This can be found
inside the sub-folder named
‘update’. Go to the DOS
command prompt and
change your directory to this
‘update’ folder. Run the
command “update
[integrate:<dir>" where
“<dir>” is the directory you
saved the Windows XP CD
files to, (“D:\XPCD” in our
case). This will start
integrating SP2 into the

Starting the Integration Process

Windows XP Installation
files saved at D:\XPCD.
You should get message
box confirmation that
integration was successful.
Now the D:\XPCD folder
contains Windows XP
installation files with

SP2 integrated.

Extracting the boot
STEP image from the

existing Windows XP
bootable CD is easy. You need
to use software that can do
this. Bart’s Boot Image
Extractor (BBIE) is a simple
but useful utility and is
available for download from
http://www.nu2.nu/bbie|.

Insert the Windows XP

CD into the CD drive, and go
to the command prompt and
change directory to the folder
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Selecting the boot image options

where BBIE is located. Run
“bbie -v <CD drive letter>” e.g.
“bbie -v F:”. You should now
find a file named ‘image1.bin’
being created in the same
folder from where bbie.exe
was run. This file is the
Windows XP Boot image.

Insert a blank CD-R
STEP media into your CD

Writer. Use burning
software such as Nero to

Starting the burning process

create your boot CD. Go to
File > New, select ‘Boot CD’
and select the boot image file
that you created in Step 2.
Make sure that emulation is
set to ‘No emulation’. The
boot segment is automatically
filled in by Nero—all you need
to do is set the number of
loaded sectors to 4. Select
Mode1 and ISO Level 2, from
under the ISO tab. Enable all
options under ‘Relax ISO
Restrictions’, and use the ISO
9660 Character set. Under the
Label tab, enter the same
label name as that of the
original CD. To find this, just
insert the Windows XP
Installation CD into your CD-
ROM drive and open Windows
Explorer to see the name
displayed against your CD
drive. Click ‘New’ to open the
File Explorer browser. In the
file browser, select all the XP
Installation files with SP2
integrated (from D:\XPCD in
our example) for writing to a
new CD. Finally open the CD
Write dialog box, and under
the ‘Burn’ tab, enable the
Finalize CD option. Now,
write the compilation to the
blank CD-R.

You have successfully
created a bootable Windows
XP installation CD with SP2.
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When they said
widescreen, they
meant it. The 7710
looks good from
any angle

cursory glance at recent Nokia products,
Apoints to an alien race of engineers
employed by the Finnish giant. The snake-like
button layout of the 7260, absence of a keypad
on the 7280, alien symbols etched on the
products... evidence of Martians who like to
experiment with mind-altering drugs.

In this range of flower phones, the Nokia
7710 resembles a yuppie—with silver hair, a grey
suit, and a big, bad, gorgeous screen. At a
resolution of 640 x 320, with 65,000 colours and
a comfortably-wide viewing angle, the screen is
a beauty to behold. With touch sensitivity
alongside some nifty software, the unit shines
as a personal information device.

Based on the Symbian Series 90 OS, the 7710
has 90 MB of internal memory, expandable to 1
GB via MMC cards. The widescreen is put to
good use with an Internet browser, a PIM suite

Nokia 7710

Imaging Sivalal S. Photograph Ji

the businessperson’s best friend with support

and readers for Word, Excel and PowerPoint.
Multimedia dances to an integrated music
player with stereo audio, a one mega pixel
camera with 2X digital zoom, an extensive set of
video features such as playback, streaming and
recording, and an FM radio, which the Martians
like to call the ‘Visual Radio’.

Underlining its yuppie leanings, the 7710 is

for SMTP, POP3 and IMAP4 e-mail protocols,
along with VPN support, Bluetooth, GPRS,
EDGE, HSCSD (did we mention that the 7710 is a
phone?), conference call, fixed dialling number,
a flight mode...if you are a gamer (who isn’tl),
this Nokia promises much love with support for
MIDP 2.0 and CLDC.

Nokia 7710%, proof that Martians are a
friendly race.

* Read our Test Centre’s review of the Nokia 7710
in the cover story of this issue
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Sumod Hajela

long time ago in a place far, far away, the

A\évonderful concept of bookmarks was
orn. Fast forward to today, the collection

of a few hundred bookmarks in your browser is
nowhere as useful as the simple text entry box
on the Google homepage. If you have been book-
marking the Web over a couple of years, you
know what a mess the most studiously organ-
ised collection of links can become.

It all begins with the problem of categoris-
ing. Bookmarks tend to be organised as a folder
hierarchy where each folder is the equivalent of
a category and various sub-categories. This is
your personal taxonomy. Now you must answer
this simple question—where should a link be
saved? Eleanor Rosch, who has been credited
with revolutionising the science of categorisa-
tion, asks, “If you’re to identify true or false, an
apple is a fruit, you're fast. A boysenberry is a
fruit? A bit slower. A kumquat is a fruit? Pause:
uuuh, I think so.”

Selfish, individual work can indeed have a
collective effect—given the right tools and context

sumod Hajela, Associate
Editor (Technology) is Digit’s
Alpha Geek. His pastimes
include creating new software
during lunch hours, and
mastering just about every
computer-related technology
that there is. Write to him at
sumod_hajela@thinkdigit.com

So where does a page about configuring a
Windows 2003-based Web Server go for you? If
you put it under Windows, you may not be able
to locate it when you think of Web servers
because you are thinking of IIS, Apache, Xitami,
Abyss, etc. Web server software, and contrari-
wise if you are thinking based on the OS. If you
put it under both, are you complicating
retrieval or simplifying it?

Separating where the object is stored and
how it is marked for retrieval is the biggest step
to organising information the way our brain
wants to get it back. The same memory could be
triggered by many different stimuli. It’s hard
enough to remember things as it is—imagine
how hard it would be if there were only one
handle to pull the memory out with.

Today, the new shared power marking tool is
Del.icio.us. It’s a Web-based service that allows
you to save your bookmarks online, with a twist.
Much like Furl or Spurl or Backflip, it makes
stored links publicly viewable on its home page.
The twist is that you can associate tags—just
words—with links, and those tags become pub-
licly available too. This means that if you go to
Del.icio.us (http://snipurl.com/cxkp) and look at
Del.icio.us/tag/Apache, you can see all the pages
people using Del.icio.us thought were related to
Apache. Look at Del.icio.us/tag]
Apache+Windows, and you get the subset of
pages that other people thought were related to
both these concepts. Any tag that you use that
has not been used before only adds to the vocab-

ulary of the system. You can try any combina-
tion of tags to slice your view of links the way
you want. For a detailed overview, check out this
Us.ef.ul page.

The interesting new concept is the collective
effect of selfish individual work. Because your
link is added to a collective heap of tagged links
from which people can sort out things of their
interest and slap on their own tags to organise
their view of the heap, it becomes a great medi-
um for social discovery and meaning.

The concept of the Semantic Web (http://
snipurl.com/cxkv) is a tantalising one, where all
pieces of information on the Web are described
by a computer readable global taxonomy so you
can always find exactly what you are looking
for. The forces that make Wikipedia a fantastic
resource despite its incompleteness, shortcom-
ings and serious problems of arbitration are
being brought to bear around the Tagged Web
concept. According to the Semantic Web, the
meaning must be connected to the categorisa-
tion so the world can make sense of it. The
Tagged Web believes that 10,000 monkeys can
indeed create something meaningful. Just slap
on words that make the resource meaningful to
you, and given enough other people doing the
same, the resource will be well-defined enough.

Whether you use Del.icio.us to browse pages
or flickr (http://snipurl.com/cxla) to see photo-
graphs, there is a constant side list of related
tags that encourages you to explore. In your
own link collection, you can see tags that other
people have applied to your tagged links or pho-
tographs. You can see who else is marking up
the same things that you have.

Stewart Butterfield, CEO of Flickr, says,
“We’ve done step one of relatedness of tags,
which is just cluster analysis of how people tag,
and then we suggest related tags. So if you tag
‘Italy’, it will suggest ‘Rome’, ‘architecture’, ‘trav-
el’, ‘food’, ‘Europe’, etc. And it works astound-
ingly well.”

Says the scientist Howard Rheingold, “I look
to see who the other people are on del.icio.us
who tag the same things that I think are impor-
tant. Then, I can look and see what else they’'ve
tagged... And isn’t that part of the collective
intelligence of the Web? You meet people who
find things that you find interesting and use-
ful—and that multiplies your ability to find
things that are interesting and useful, and other
people feed off of you.”

The DMOZ Open Directory Project (http://
snipurl.com/cxll) works on a system of trusted
‘editors’ responsible for a small slice of their cat-
egory tree who are permitted to add links to
their categories. While it isn’t languishing,
there is a real shortage of people volunteering to
handle the less ‘popular’ categories. With a serv-
ice like Delicious where everyone is responsible
only for their personal view of tags and links,
the emergent behaviour will take care of that
problem too. Part of that emergent behaviour
are the many cool tools that hook into
Del.icio.us (http://snipurl.com/cxlc).

If you are looking for needles, try browsing
Del.icio.us links via fac.etio.us (http://snipurl.
com/cxlw) for a serendipitous experience.X
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Jumpstart

83 Back To The Basics

Blog On The Go

Deepak Pawar marries the growing capabilities of mobile phones with the next big thing on

the Internet—blogging. The result is a potential moneyspinner

Aditya Kuber

logging, with an esti-
E mated 25 million active
users, is the next big
thing, say pundits all across
cyberspace. Taking this to the
next level-mobile blogging—
would be logical thing to do. But
how will this work? Are there
enough people interested in
blogging using their
mobile phones?

Deepak Pawar of Midas
Events, the company that has
put up Mobylog.com, India’s
first and so far, only mobile blog-
ging site, thinks the concept will
certainly work.

“As of right now, there are a
number of mobile phone users
who have upgraded to camera
phones, and these guys are not
sure how to share their photo-
graphs. Such a site would help
them by not just storing their
photos, but also sharing them with

minimal fuss and least require-
ment of technological know-how,”
says Pawar.

The idea was born when Pawar,
a self-professed tech freak, was
wondering what to do with the
hundreds of photos he had on his
phone. Scouring the Net for a
resource, he found a few, but they
were all either paid or did not facil-
itate mobile blogging.

DIGIT MARCH 2005
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“We will endeavour to keep
this site free. This would encour-
age more users to sign up. Our
revenue would mainly come
from advertising. There are some
corporates who are already
asking us about the possibilities,
and this would form one
revenue source for us,” elabo-
rates Pawar.

Mobile Blogging has been
around for almost a year now.
Nokia had launched ‘Lifeblog’, a
software that allowed users of its
7610 model to upload to a Web
site and create their own photo
blog. This, however, cost a whole
lot more! The software had to be
bought for $30 (Rs 1,305) and a
subscription to TypePad, where
the blog would be hosted, cost
about $5 (Rs 218) per year. So,
after you had paid nearly Rs
28,000 for the phone, only an
additional cost of approximately
Rs 1,600 would let you host your
own mobile blog.

Other services available are
restrictive in nature and do not
support all service providers or
cell phone models. Pawar would
not like to have any restrictions
on Mobylog, though, and plans to
support every service provider.
“That would be the strength of
our offering... if we started charg-
ing or restricting, the site would
end up as a dud,” says Pawar.

The Cost Factor

But setting up something like
this would come at a price, and
Pawar is ready to bear these
costs. “I'm emotionally attached
to this idea and I will do
anything it takes to ensure its
success,” he says.

So far, he has spent close
toRs 35 lakh on setting up the
back-end and employing a
team to develop the service. “We
are a team of 15 and this could
expand later. We have set up
three servers, one that handles
all the e-mails coming to the site,
one for the database and one
that mirrors the site so that we
are not crippled
in case of an

...if we started
charging or
restricting,
the site would
end up as a
dud.

Deepak Pawar
Midas Events

R74 More Moblogging Sites

eventuality.”
Options of www.Mlogs.com
uploading to the

site include e-
mailing a given
address using
the secret word
or MMSing your
photos and text.
Just like that!

www.Typepad.com
www.Buzznet.com
www.Easymoblog.org
www.Blogplanet.net
www.Phlogger.com

The
database
this site
would gener-
ate would also
be humongous.
Every user would S
have his/her own ‘secret
word’ that would be a part of the
e-mail sent to the site and would
identify the sender. This would
ensure that the photos are
uploaded on to the correct blog.
“We are using the .NET frame-
work and the site is logically
very strong. We do not expect
too many problems once we go
live,” says Pawar.

Ouch! Numerical Keypads
Once you start thinking about it,
doesn’t it seem excessively
painful to enter text using a
numeric keypad for input?
Of course millions of teenagers
send gazillions of characters of
SMS text to each other using only
a numeric keypad, but compar-
ing text messaging to blog
entries is not fair. SMS messages
are short by necessity, and the
people that use them have devel-
oped elaborate shorthand which
speeds up input. A blog entry, on
the other hand, tends to be real
prose, with real sentences and in
many cases multiple paragraphs
per blog entry.

If textual blogging has a
future on mobile devices, it will
most likely succeed on devices
that have more sophisticated
input mechanisms than a
numeric keypad alone. Palm OS
devices, for example, have a stylus
that makes it significantly easier
to enter text. Other devices, such
as the BlackBerry and Nokia
Communicator phones or Sony
Ericsson’s P910 series include a
small QWERTY keyboard that
could make this easier.

But photo blogging is not
restricted by any such problem. All
you need is a camera phone, and
even a numeric keypad for a short
caption is enough.

Connectivity Woes
Bandwidth is the only major cost
that Mobylog is currently facing.
But with sponsors and advertisers
coming in, this could also be han-
dled, feels Pawar. As of now, Airtel
would be the main sponsor, but
this would not keep other service
providers away. Pawar is hopeful
that soon, other service providers
would want to be a part of this.

But would-
n’t these guys
rather put up their own
site? “That threat exists, but we
are the pioneers and will remain
free and allow users of any service
to use it. If a service provider were
to set up his own site, chances are,
they will not allow users of other
services to use their service. But
we are really not that worried
about this. It’s easier for them to
partner with us than go on their
own. Our real threat is from
portals such as Yahoo! or
Rediff.com,” says Pawar.

Security

There are other issues, though.
While this will enable and
help the spread of blogging, given
the recent DPS MMS incident,
policing the content would be of
paramount importance. “Yes we
will be monitoring the content
that is put up but we will, at no
point, get intrusive. If we find
offensive or obscene material, it
would be ‘flushed’ instantly,”
assures Pawar.

The blog could also have an
impact when helping law enforce-
ment authorities. “Imagine an
accident or an incident or a crime
happening in front of you. To
maintain your anonymity, you
could post the photograph on the
blog, or we could alert the author-
ities if we were to come across
something offensive in any of the
posts. This could be a strong tool,”
asserts Pawar.

He is also sure that this could
be a strong platform for artistes to
display their work. “Artistes need
to reach out to a wider audience
and this tool could sure facilitate
that need.”

Whatever the need or the use,
mobile blogging is a strong tool,
and the power to post from
anywhere is perhaps the first step
to truly unleashing the potential
of mobile computing. ®

aditya_kuber@thinkdigit.com
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It’s that time of year again—tax season! We take a look at the top nine tax and accounting
software available to help you decide which the right one for your company is

Deepak Dhingra,
Preethi Chamikutty and
Robert Sovereign-Smith

he air is musty and carries

the stench of old books. An

old, balding, bespectacled

man  sits  punching

numbers at an ancient

machine. People have long since forgot-

ten his name, and know him only as

‘Munshiji’. The name is always spoken

in fearful awe; for Munshiji is the be-

all and end-all of all things financial

in the company. None dare disturb him
when tax season comes rolling in...

If this sounds like the begin-

ning of a fictional whodunit, it’s

only because Munshiji no longer
exists. He was replaced by a
computer and accounting soft-
ware. The air is no longer musty,
and the old ledgers have been
incorporated into the
computer’s hard disk—always
available as hard copies, cour-
tesy the printer. Today, even
small companies need to imple-
ment a corporate style of process
management, and accounting is
one aspect they can least afford
to skimp on. Luckily, profes-
sional accounting software solu-
tions don’t cost an arm and a leg.
Neither do they threaten to peer
into your souls through ancient

Imaging Atul Deshmukh

spectacles if you dare inquire
about Form 16...

We take an in-depth look at
the top nine tax and accounts
packages available in India to help
you decide which one suits your
needs best.

The software—ACE 7, atACC,
BUSY, Ex Personal Accountant,
Expert Quick Accounting 3.0,
Simply Accounting Pro, T++, Tally
6.3 and Wings EZ—are packed
with tools and functions that can
make cash adjustments, debit,
credit and invoicing a lot easier,
maybe even fun... maybe.

Early on, this test discovered
that all nine had nearly identical

DIGIT MARCH 2005
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features, and the differences
across the software were mini-
mal. This was expected, as they
are all accounting software, all
made to take care of the well-
defined, result-oriented task that
is accounting. There really
aren’t too many different ways
to balance your books, now,
are there?

ACE 7.0

www.coralindia.com

ACE is a strong contender for the
crown, and hits back with a set of
decent features. The most note-
worthy feature is its excellent
support for ASCII dot-matrix
printers, so you won’t have to
invest in a new printer and spend
so much more money on paper

SAAPER- =S STAe

ACE 7.0 has support for ASCII
dot-matrix printers

sheets and ink—medium-sized
companies where thousands of
account reports have to be
printed every week are sure to
appreciate this feature.

ACE 7.0 is totally compatible
with Windows, and can Zip and
e-mail reports to your clients. It
can export or save files in MS
Word and Excel, or HTML for
those who need to publish
reports online. The interface is
pretty easy to get used to as well.

The software isn’t taxing on
the system either; it performs
commendably in terms of speeds,
even on older, slower computers.
It has some great features, such as
bank reconciliation, tracking
duplicate cheque numbers,
managing multiple purchase and
sales accounts, calculating
commissions based on quantities
sold, calculating discounts, prod-
uct-wise  price lists, and
much more.

In terms of inventory manage-
ment, the software offers options
such as batch-wise stocking, vari-
ous inventory evaluations such as
LIFO, FIFO, market, average, stock
ageing analysis, calculating profit
and loss on a per-product basis,
and loads more.

Though ACE can create user-
defined reports, you might need
to be a software engineer or a
programmer to be able to do so! It
has a native barcode reader for
importers and exporters, and has
a very useful inbuilt data backup-
and-restore function.

Overall, ACE is a very good
software product, and it has what
it takes to be your businesses
accounting solution.

atACC

www.atlanta-it.com

atACC, apart from having a cool
pun for a name, is another
offshore product that doesn’t
really come preset for the Indian
accounts system. The software is
extensive, and has every feature
that you would expect accounting
software to have. However, there
are too many useless fields in a
form, and all of them are prede-
fined. So you end up with fields
that are displayed but will never
be used. In order to disable these
fields, you have to set up the
account tree with the items, and
then edit the master.

Accounts and items can be
grouped for convenience, but there
is no option for a multi-line inven-
tory. Thus, each pack size would
need to be an individual entry.

Once you have created your
masters, however, things begin to
flow a little better. You can enter
transactions related to banks,
cash, purchases, sales, and more.
The most noticeable advantage of
this software, however, is the abil-

software handles them.

inventories, etc.
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atACC doesn’t come preset for the Indian accounts system

The most
noticeable
advantage
of atACC is
the ability
to increase,
decrease
and
transfer
stock from
one code to
another

Ease of use is important for any software, but since the focus is on the SoHo
community, who may not have a full-time accountant doing their accounts, we gave a very
high weightage to how easy the software is to install and use. How easy it is to set up new
companies, users and master accounts was given due weightage. Since we are focused here
towards the SoHo and small trader community, we focused only on those features of the
accounting packages that are relevant for these communities. Therefore, features such as
accounting without codes, receivables and payables management, multi-company
accounting, invoicing, printing features, etc. were given higher weightages.

ASCII dot-matrix printing is of importance to the SoHo community, so this feature, if
available, was awarded points. The reporting features of the packages and their ability to
export reports to other formats such as Microsoft Excel and Adobe Acrobat were noted.
Other features such as multi-currency accounting, multiple users, and online publishing
were not considered very important. Since most of these software also support inventory
management, we noted features such as re-order levels, multiple units, batch wise

Finally, the cost of the software was taken into account to decide the winners.

ity to increase, decrease and
transfer stock from one code to
another. Using this, you can
manipulate your stock better and
prevent shortages or excesses of
stock across your company. It also
has an inbuilt ‘Free Quantity’
feature, which will help you keep
track of all the freebies that you
give away with your products.
The software religiously keeps
reminding you to back up your
data every time you exit it.
atACC seems to be really effi-
cient when going all the way
down to the voucher level from
the reports, but we realised that
the values were not being
refreshed after saving and closing
the report. The software also
limits you to three tax types, and
there’s no way to add a fourth.
Also available is the inventory
handling option for shortages,
excess and damages. atACC also
helps define services and keeps a

8] How We Tested

Il the software we tested were targeted at the SoHo segment. Here, ease of use and

features are overshadowed by the total cost of ownership factor.

We roped in a couple of external consultants to help us evaluate the software. Both
qualified chartered accountants, they set up multiple dummy companies, used dummy data
and entered standard trading transactions to figure out how easily and how well the
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track of the service tax, which isa
helpful option for the
service industry.

On the whole, atACC has a
very good feature set, but misses
out on ease of use, and a few basic
features that would make the
accounting experience easier.

BUSY Business Account-
ing Professional Edition
www.busyinfotech.com

BUSY works only at the 800 x 600
resolution, which is irritating.
However, the software is easy to
set up and has an easy-to-under-
stand interface. There are only a
few noticeable differences
between BUSY and the rest.
BUSY’s sale purchase form is a
little more out of place than in
other software. It has an option
that allows you to easily track
receivables from parties or forms
issued for purchase.
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A highlight of the BUSY package is a very good analysis of

sales and purchase

One highlight of the package
is a very good analysis of sales and
purchase. The package lets you
search for individual options
such as transaction, item and
amount. Other features in terms
of accounting and inventory
maintenance are similar to those
in other accounting packages.

EX Personal Accountant
www.tcs.com/0_products/exper-
sonnal/products_expersonnal.htm
This accounting solution has a
very easy installation procedure
and interface navigation. Setting
up your account is easy as well.
You can set up accounts under
different groups, unlike in other
software, where you have to first
define a group, and then go to
ledger accounts and define
accounts under that group. Apart
from the standard feature set,
sales tax handling for purchases
and sales are done through the
Charges Module, the setting up of

which is also a snap. You have the
flexibility to apply charges on the
invoice as per the requirement-
other software offer predefined
fields which you have to select.

The software gives you the
option to adjust open debits and
credits, which is useful for
maintaining receivables or
payables. This is a plus point, as
such features are only found in
ERP packages and not in
accounting packages.

EX Personal Accountant also
gives you the option of generating
various MIS reports such as
Income-Expense analysis, Sales
Purchase analysis, Cost Centre,
Account and Item-wise analysis.
The software also has a feature
that calculates the interest for you.

One more unique feature is
the Customer folder, which gives
you an overview of all transac-

tions with the specified
customer, such as sales, receipts,
sales returns, opening

debit/credit, etc. The Cost Centre
that is present in most software
is called Budget Variance in EX
Personal Accountant, but it only
allows you to allocate budgets
for different activities, and not
plan for contingencies.

You can export reports to the
MS Word and Excel formats, and
the software has full support
for dot matrix, inkjet and
laser printers.

Expert Quick

Accounting 3.0
www.compubrain.net

Unless you run your screen at a
resolution of 800 x 600, this soft-
ware will irritate you from the
moment you install it. It auto-
matically forces your screen reso-
lution to 800 x 600 mode. As long
as the program runs, you cannot
change the display back to
normal, even from the system
display properties.

Stock valuation options in
Expert Quick Accounting 3.0
range from LIFO, FIFO, Cost, HIFO
and Weighted Average. The
Account Receivable and Payable
option in  Expert Quick
Accounting 3.0 is limited, and
does not offer a bill-wise
outstanding amount.

The software is not user-
friendly, and is not recommended
if you are running accounting
software for the first time. When
compared to the other software,
Expert Quick Accounting seems
to be overpriced, especially for the
plain features it offers.

Simply Accounting

Pro 2003
www.simplyaccounting.com/asia/
This was the only software in this
category to offer Web store inte-
gration. This is a function that
allows a company to set up a Web
site for selling goods, and auto-
matically add all orders made
online to your books. This feature
is a must-have for all online

32 Our Expert Panel

Ithough we have a battery of technology experts right here at Digit, they’re not quite
professionally trained to test accounting software. So we brought in a couple of
accounts experts to help us test software the lineup. Here’s a little information about them.

f R

Anish Mehta,
Chartered
Accountant

lubricants trade in India. He can be reached at
anish@lubricantsindia.com.

Mehta is a Chartered Accountant.
He has 13 years’ experience in
accounting and finance. An
alumnus of Ruparel College, he
also holds a diploma in Business
Administration. His interests
include reading, learning about

Shah is a Chartered
Accountant and
consultant who writes
regularly on technology
and related issues for
various publications. He
assists companies in

software technologies, and .Net Vipul Shah, testing pre-release
programming. A partner with R Chartered products, and also
M Mehta and Co, Mehta is a Accountant reviews released

consultant for the industrial

products. He can be
reached at digit@
vipulshah.com
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Simply Accounting Pro offers Web store integration

businesses, and even those small businesses that
plan on making their online presence felt in the
near future.

The major problem with this software in terms
of setting it up is that none of the ready template
accounts match the account heads we use here in
India. You will have to modify the existing templates
to match the Indian accounting system. The other
option is to start from scratch and create your own
template of basic accounts, groups and items.

The software was tested using the predefined
templates of ‘Retail Dealer’, ‘Generic Company’ (a
predefined account head as per the American
accounts system), as well as a blank company, where
the minimum set of account heads was created as
required by the Indian accounting system. All
account heads that were irrelevant to Indian
accounting were deleted.

Simply Accounting Pro allows an excellent
grouping and sub-grouping facility. The inventory
allows multi-line products to be defined. For exam-
ple, you can easily create different pack sizes for the
same item, say 100 gm, 200 gm and 500 gm packs of
butter. The Sales Tax module covers VAT as well as
the current tax system, provided you define the
correct values in the system settings.

Some of the main features of this software
include a per-account, line comment capability,
enhanced password security, departmental
accounting, sorting of recurring entries, HTML
report generation, and by far the best feature—Web
store integration.

The interface, though akin to older DOS-based
programs, does not easily reveal the countless func-
tions of the software as easily as it should. The Daily
Business Manager feature, however, is a boon, as it
ensures that you never leave anything pending. It
reminds you to make or receive payments or orders
due on that particular day. The software also has the
inbuilt capability of supporting electronic fund
transfers for a wide range of currencies.

On the whole, Simply Accounting Pro is a neces-
sity for those businesses with an online presence,
though others might be a little put off by the entire
American style of account head arrangement.

T++

www.tplusplussolutions.com

Anish Mehta, one of the experts, was thoroughly
impressed by T++. He called it “clean and refresh-
ing.” The interface of the package is a cross between
a Web browser and Windows Explorer. It has

Is Your

Accounting)Software
VAT Ready?

Switch to fully VAT-compliant

Busy

Business Accounting Softwar

e Financial Accounting e Multi-location Inventory
e User-configurable Invoicing e Order Processing
e Sales Tax / Excise / VAT Registers

Already Available
Haryana VAT Registers

Over 12,000
Installations

Also Available

Item Barcode Printing Solution

Install 30-Days Free Trial Copy from
CD enclosed with this Issue

Developed & Marketed by :

Busy Infotech Pvt. Ltd.

206, M.G. House, 2 Community Centre, Wazirpur Industrial Area, Delhi - 110 052
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Fax : 011 - 2737 4358 » e-Mail : info@busyinfotech.com
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e
The interface of T++ is a cross between
a Web browser and Windows Explorer
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a professional layout, with the
menu laid out on one screen, so
you don’t need to hunt around for
the various options. The home
page of the software provides all
accounting data at a glance, and
this can be configured. The data
entry forms are also very user-
friendly, making data entry quite
easy. The browser interface of the
software means that you have
buttons for back, forward, home,
etc, which make navigation
through different forms a snap.

T++ has a feature set almost
identical to Tally’s, with a few
extras thrown in. Of all the soft-
ware tested here, our expert
Anish Mehta rated T++ as the soft-
ware with the best interface, func-
tionality and ease of use. The
inbuilt help function makes
understanding the software a lot
easier-even for those who have
never used Tally before.

The software saves data in tiny
file sizes, so you can back up and
entire year’s accounts on a floppy!
eBiz Technologies, the developers,
claim that 5,000 entries of data
can be backed up in a file no
larger than 200 KB. The software
also has an option to import data
from Tally, so switching over to
T++ should not be a problem at all.
The import is done using XML, so
you can import everything from
masters to transaction records.

Invoices can be customised,
and you can insert your logo into
the voucher. The software uses the
XML file format, which you can
edit in SVG (Scalable Vector Graph-
ics), which is bundled along.

The Advanced Search function
in the Search option helps you
perform complex searches, and
also allows you to save search
criteria for future use. There are
two options to define inventory,
‘groups’ and ‘category’-most soft-
ware offer only one of these
options. These groups and cate-
gories can be divided into various
levels, which will let you have

multi-level groups within a level;
most other software restrict you
to a maximum of only two levels.
The reports page of the soft-
ware shows you the entire set of
reports at a glance, and you can
go down to the voucher level in
each report. Reports can be
exported in various formats,
including e-mail. Reports can also
be customised and exported to MS
Excel as a template.
Overall, this
Mehta’s pick.

Tally 6.3
www.tallysolutions.com

Tally has always set the bar. Tally
is to accounting what Microsoft is
to OSes—it’s not necessarily
better, but it’s so common and
popular that finding accountants
proficient at it is an easy task. It is
quite truly the king of accounting
land, and every other software in
this test is attempting to steal a
little of its market share. The ease-
of-use factor is very high here,
perhaps because of the familiar-
ity of accountants with the prod-
uct—virtually every accountant
training course teaches the
basics of Tally.

Tally has an intuitive interface,
and has features that will take care
of just about any accounting
requirement. Though the feature
set isn’t really very different from
other software, it’s the easy menu
layout and accessibility of func-
tions that earns Tally top marks in
terms of ease of use.

One feature that sets it apart is
its inbuilt Web browser, which the
others don’t offer. The integrated
Web browser permits accountants
to browse the Net via the interface
itselfsupposedly useful when look-
ing online for a solution to an
accounting problem, or seeking
help from the online Tally
helpdesk. However, though differ-
ent, this feature isn’t really as great
as it seems—let’s find out why.

A major irritant with Tally 6.3
is the product activation process.

was Anish

Tally is
quite truly
the king of
accounting
land, and
every other
software in
this test is
attempting
to steal a
little of its
market
share
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Tally is to accounting what Microsoft is to operating systems

As with other software vendors
such as Microsoft and Symantec,
Tally too, demands activation of
the product before you can use it.
Sounds simple enough, right?
Wrong! Most small businesses
have standalone computers for
accounting, and they don’t risk
connecting this computer to the
Internet, or just don’t have an
Internet connection—which is
why the inbuilt browser isn’t
really a great feature!

However, coming back to acti-
vation, if the computer you use
for accounting isn’t connected to
the Internet, you will need to
install Tally on to a computer that
does have a Net connection, and
then activate the product, and
then, transfer all the software
files to your accounting
computer. Though this compli-
cated process helps curb piracy, it
will also act as a deterrent to
those looking to purchase it.

Tally also sports additional
features: it lets you easily export
data to ODBC software such as MS
Word or Excel; it offers a print
preview of accounting reports; it
allows you to export your data in
the XML format—this goes a long
way in allowing those without
Tally installed to view or use the
data. Tally also allows for unified
ledgers, ratio analysis, and more.

Overall, those with earlier
versions of Tally might not want to
upgrade, for three reasons: the irri-
tating activation feature, the price,
and of course, the faster speeds
that the earlier DOS-based versions
of Tally, such as Tally 4.5, offer.

Both our experts were unani-
mous about Tally 6.3’s easy-to-use
interface. Also, they were both
quick to point out that the surplus
of Tally-trained professionals who
are looking for jobs would reduce
the total cost of ownership of the
package, as no additional training
would be required.

Wings EZ
www.wingsinfo.net
Wings EZ was our winner last year.
Compared to the other software we
tested, Wings offers more or less
the same features. It is easy to use,
and has a very simple interface. All
the reports generated have a very
similar look, and can be compre-
hended easily. Extra columns can
be added to the report to display
any extra information required.
Wings EZ has an option that
allows you to keep track of PDCs
and bounced cheques. It allows
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Wings EZ was the winner in our
accounting software test last year

stock valuation only by the FIFO
and Weighted Average method.

Wings EZ allows for customis-
ing of reports, fonts, page setup,
and the date and number system.
There is also the option of setting
commas as per the Indian or
American style.

One helpful feature in Wings
EZ is the repair data function—
this function enables the user to
upgrade data present in a previ-
ous version to a new version of the
software. Also possible is the
recovery of a data backup using
MS Word or Excel.

The only drawback of the
package is, it takes quite a long
time to start up, and setting it up
is rather difficult.

Conclusion

All the software we tested had
the same basic functions. Though
there was a little variation here

and there, but overall, it doesn’t T++, with then instead of only the pending
matter. Each vendor is just trying .. _ " . .. uantity being displayed, the
to outdo the other.J Tallyy6.§ !tS intuitive gntire (?;der is ;ghowrlfag};in. This
offered online help, and thisisa interface would confuse the user, as he or
decent feature. Simply Account- and she may not be very sure how
ing will %gt yotzitake tyoulr1 bltlfsli- wholesome ml(IjCh }Illaihalreigy been billed
ness online. Almost a e and whether there is excess
software mentioned lets you set of billing against that order or not.
print graphs and reports for features, This is taken care in T++, where
presentations. The software help impressed the subsequent sales invoice only
for all the packages was good, US a great shows the pending quantity
but Wings EZ was the best. deal in the sales order, and there is

Choosing a winner from
amongst the eight is possibly the
hardest thing to do right now.
Considering its widespread
use, affordable price and
easily accessible support, Tally
should remain firmly on its
throne. However, T++, with its
intuitive interface and whole-
some set of features, impressed
us a great deal.

For an online business, nothing
beats Simply Accounting Pro. If
your company plans to take its
business online, we recommend
you opt for Simply Accounting Pro.

We declare T++ the winner
based on the following: while
doing Sales Order Processing in
Tally when an order is created for
a party, if the billing is only done
for part of the quantity and the
pending amount has to be raised
in the subsequent sales order,

no repetition.

The next point where T++
scores over Tally is the tracking
number—in Tally, the same track-
ing number can be assigned to two
different customers, leading to
errors when reports such as pend-
ing invoices etc. are generated.
Since the tracking number is
common to both transactions, it
will become difficult to trace that
particular transaction at a later
date. In T++, however, the tracking
number is unique to each transac-
tion, and hence, the chances of
such errors are eliminated.

T++ comes built in with the
Tax Deducted at Source (TDS)
function, which is absent in Tally.
This will cost you Rs 4,500 more if
you want it. ®@

deepak_dhingra@thinkdigit.com
preethi_chamikutty@thinkdigit.com
robert_smith@thinkdigit.com

VAT Demystified

AT, or Value Added Tax, is a multi-point

levy of sales tax, which enables one to
claim a set-off of the tax that he or she pays
on purchases. VAT is levied at every stage of
production, and is levied only on the value
added by the last seller. All over the world,
VAT is payable on goods and services, as
they form a part of the national GDP.

VAT is a form of collecting sales tax,
under which tax is collected in each stage
on the value added to the goods. Here’s
how it works: a dealer charges tax on the
full price of the goods sold to the consumer,
and at every end of the tax period, reduces
two things—(a) the tax collected on the
sale, and (b) the tax charged to him
by the dealers from whom he purchased
the goods. He then pays this to the
Government as tax.

The VAT system is so designed that the
final burden of the tax on goods is borne by
the final consumer. Firstly, the tax liability
on the sale made by the dealer will be
calculated on lines similar to the present
Sales Tax Act, and thereafter, tax paid on
purchases will be deducted—and the net
amount will be paid, or claimed for refund,
by the dealer.

VAT has gained substantial importance

due to the decision of the Government to

introduce VAT in the states from April 1. It

has been introduced with the primary

objective of bringing into the legal system a

neutral tax regime, and removes the
overlapping effects of taxes.
In simple words, VAT will replace the

present sales tax system. Under the current

single-point system of tax levy, the

manufacturer or importer of goods into a
state is liable to sales tax. There is no sales
tax on any further distribution channels. It
is a multi-point levy on each of the entities
in the supply chain with the facility of set-
off of input tax—the tax paid at the stage of
purchase of goods by a trader, and on
purchase of raw materials by a
manufacturer. Only the value addition in
the hands of each entity is subject to tax.

VAT levies will be administered by the
Value Added Tax Act, and the rules made
thereunder.

Let’s take an example: Dealer A
purchases goods for Rs 100, on which a tax
of Rs 10 has been charged. Now he sells the
goods for Rs 120 to dealer B, on which he
charges a tax of Rs 12 at 10 per cent. The

tax payable by dealer B will be only Rs 2,
being the difference between the tax
collected of Rs 12 and tax already paid on
purchases of Rs 10. Thus, dealer B has paid
tax at 10 per cent on Rs 20, which is the
value addition at his hands.

Purchase price: Rs 100

Tax paid on purchase: Rs 10
(input tax)

Sale price: Rs 120

Tax payable on sale price: Rs 12
(output tax)

Input tax credit: Rs 10

VAT payable: Rs 2

Sales not liable to be taxed under
the VAT Act

Since the VAT Act applies only to sales
within a state, there are some sales that
will not be governed by the VAT Act :

D] Sales in the course of inter-state trade
or commerce, which shall continue to be
liable to tax under the Central Sales Tax
Act, 1956

b1 Sales that take place outside the state
D1 Sales in the course of export or import
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ADOBE PHOTOSHOP

Fix The Colour

When opening graphics

in Photoshop, Web
designers will notice drastic
colour shifts. The new colour
management system in
Photoshop reinterprets files
by default. If you work with
Web graphics, you need to
turn this feature off. Go to
File > Color Settings >
Profile Setup. Under ‘Embed
Profiles’, un-check ‘RGB’, and
under assumed profiles,
select ‘None’ from the RGB
dropdown. Under ‘Profile
Mismatch Handling’,
select ‘Ignore’.

Photoshop 7 Easter Egg

Hold down [Ctr]] and

[Alt] and click on Help >
About Photoshop. When the
‘Strange Cargo’ splash screen
appears, type in ‘burp’ and the
crate will open slightly with a
big electric cat peeking out.
Type the cat’s name, “Udo”, to
hear him meow. Press [Alt] to
speed up the scrolling credits.
Scroll to the end of the credits
to see a name you will
recognise. ‘Strange Cargo’ and
‘Big Electric Cat’ were the
codenames for Photoshop 5
and 4 respectively while they
were being developed.

A Full Scratch

If you get a warning that

says, “Your scratch disk is
full,” you can free up some
space by saving the file.
However, sometimes
Photoshop will not let you save
the file. To remedy this, create
a small file, say 3x3 pixels, and
save it in the Photoshop
format. Photoshop will now
flush the scratch, and you will
be able to save the previous
file that you were working on.

Logo Stamp

If you have an image

that you use over and
over again, such as a logo or
signature, you should make it
into a brush. When creating
custom brushes from image
files, Photoshop saves the
image on your ‘Brushes’
palette. Select the image, click
on the Menu arrow on the
‘Brushes’ palette and select
‘Define Brush’. The image
now appears on the palette.
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You can use it just as you do
with other brushes.

Save Photos As GIFs
Photoshop has improved
its index colour

conversions, which allows for

higher quality 8-bit, 256-

colour conversions from 24-bit

images. Although photographs
are normally saved as JPG
images, the improved colour
conversion will let you convert
them to GIFs for Web use. This

reduced file size will still
retain image quality. To save
an image as GIF, go to File >
Export > GIF89a Export.

3D Transform

The new 3D Transform

plugin lets you work
with 2D images as if they
were solid 3D objects, so you
can adjust the perspective on
an image from straight-on to
various angles. Click on Filter
> Render > 3D Transform.
Draw a wire-frame over your
image and use the Pan

Illustration Harsho Mohan Chottoraj

Camera and Trackball tools to
manipulate the image
perspective, and click OK.

Make It An Action Item
Actions automate
routine tasks and save a

lot of time. To create an

‘Action’, click on the ‘Menu’

arrow on the ‘Action’ palette

and click on ‘New Action’.

Click ‘Record’ to start

recording and carry out all

the steps for the action you
perform regularly. Once
you’re done, click on the

‘Stop’ button on the Action

palette. To repeat the action,

select it and click on the Play
button on the palette.

Make Your Images Fit
The ‘Fit Image’
command resizes
an image to fit within a given
area without altering its
aspect ratio. Click on File >
Automate > Fit Image. Enter a
new width or height and click
‘OK’ to resize the image.

Memory Errors
Sometimes, Photoshop
reports an ‘Out of

Memory Error’. Just

acknowledge the dialog box
and select Edit > Purge > All

(or Undo, Pattern, Clipboard,

and/or Histories).

Open your ‘System
Properties’ (Virtual Memory
Settings) by going to Start >
Settings > Control Panel >
System, and under the
Performance tab, clicking the
button labelled ‘Virtual
Memory’. Change your
minimum and maximum
virtual memory settings to two-
and-a-half times your RAM—for
example, if you have 256 MB of
RAM, enter 640 in both fields.
Ignore the Windows warning
that pops up!

Now, in Photoshop’s
preferences ([Ctr]] + [K]),
under ‘Memory & Image
Cache’ ([Ctr]] + [8], or File >

®

Centre An Object

If you need to position an
image at the centre of the
canvas, there’s no need to
calculate image parameters
and reorganise the image. All
you have to do is to cut the
object and paste it back.




Preferences > Memory &
Image Cache), enter 75 per
cent for ‘Used by Photoshop’.

IMAGEREADY

Slow Display

ImageReady can

become very slow when
working with large images.
The program works best
with only 72-dpi images. All
other editing should be done
with PhotoShop; resize to
this resolution and then
work in ImageReady.

Saving a Proper PNG (for
the Web)

The Portable Network
Graphics (PNG) is a
remarkable image format with

a ton of features—true colour

48-bit (or 16-bit greyscale),
alpha channels, interlacing
(progressive display), gamma
correction, and lossless
compression! Of course, if you
have ever saved a PNG from
Photoshop without correcting
all the above parameters, you
will not like the result.

The PNG format allows
applications to write a chunk
that determines what gamma
correction to use to display the
image properly. Photoshop 5
has a bug that incorrectly
saves images with a gamma
chunk that is off by a factor of
exactly 2.0. Photoshop 5.5, 6
and 7 are better, but the
gamma information is still
incorrect. Though Photoshop
doesn’t make errors when
actually writing the pixel data,
applications that use the
embedded information are
misled, and will display an
overly dark image.

As far as Web images
go, it’s better to use the

®
Better Text Effects
When using anti-aliased text
with a transparent background,
set the Matte colour the same
as the background colour on
your Web page. This removes
the halo effect around the
edges of the text. To specify a
Matte colour, select it from the
‘Matte’ dropdown on the
‘Optimize’ palette. You can also
select either the foreground or
background colours as the
Matte colour from here.
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Surprise

gamma = 2.2 colourspace,

so that applications that
ignore gamma information
will display the image as their
creator intended—this works
because typical PC monitors
have an inbuilt gamma of 2.2.

to utilise the ‘Transparent’ and
‘Matte’ options.

In order to save a
transparent image, you must
first create or save a
transparent image using one
of the following techniques,
and then reload it into
ImageReady:

Either use the ‘Magic
Eraser’ tool ([Shift] + [E]) to
erase the region(s) you wish
to make transparent, or use
the ‘Magic Wand’ tool, [W], to
select the colours you wish to
make transparent and then
delete them.

Now, if the ‘Optimize’
palette is not already visible,
press [F10], or choose
Window > Show > Optimize
from the menus. Select your

Save Transparent GIFs
And PNGs

A common

misconception is that
enabling the ‘Transparent’
option and choosing a
Matte colour, from the
‘Optimize’ palette, will save
your image with a
transparency. In fact, the
image should already contain
a transparency, which
ImageReady will display with a
checkerboard pattern, in order

Set the Matte colour the same as the background colour on your Web
page. This removes the halo effect around the edges of the text.

preferred visualisation tab,
choose a default optimisation
setting from the Settings
combo box, and save your
settings by selecting ‘Save
Settings’ from the ‘Optimize’
palette menu.

Finally, save the optimised
(transparent) image by
pressing [Ctrl] + [Alt] + [Shift] +
[S] (or File > Save Optimized
As). You are done!

Control Dithering

The dither Algorithm

dropdown on the
‘Optimize’ palette lets you
choose a dithering method
for the image. The ‘Dither’
percentage slider lets you
control the range of colours
simulated by dithering. A
higher dithering per cent
creates the appearance of
more colours and more
detail in an image, but can
also increase the file size. For
optimal compression, use the
lowest percentage of
application dither that
provides the colour detail
you require.

Lights, Camera, Action
Use actions to automate
repetitive tasks and

save time. To create an

Action, click on the ‘Menu’

arrow on the Actions palette

and click on ‘New Action’.

Provide a name for the

‘Action’ and click ‘Record’ to

start recording. Carry out

the steps for the action, in
the sequence that they
should occur. Click on ‘Stop’
once you are done. To apply
an Action, select it and click
on the Play button on the

Action palette.

Favouring Colours
Indexing an image is
tough—you play with

all the settings to achieve

satisfactory results, and
sometimes you still can’t
achieve it. For example,
when indexing an image
with many colours, or
forcing an image to use less
than 256 colours, you may
end up with bad dithering
patterns and colours. You
can use the selection tools to
select or isolate problematic
colours, and Photoshop will
favour these colours when
choosing the palette.
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Jayesh Limaye

How many times have
you found yourself
wishing that the Search
Companion in Windows XP
could turn up results
faster? You have probably
also wished that the search
interface could have been
simpler, too.

At first glance, the
Windows XP Search
Companion looks
complicated, but it
happens to be a valuable
and versatile tool for
searching for files gone
astray. However, it is true
that it is agonisingly slow
when searching for
keywords contained in files.
And when it starts
searching through
compressed files, your
computer comes to a virtual
standstill, because the
search tool decompresses
the files and then searches
their contents.

However, there is a
nifty and lesser-known
feature in Windows XP
known as the Indexing
Service, which can index
all files on your computer
and make searching for
files a whole new
experience. We take a look
here at how to implement
the Indexing method.

Open It Up
STEP Go to Start > Search
> For Files or
Folders. The Search
Companion will open.

Enable Indexing
STEP In the Search

Companion, click
on ‘Change preferences’. In
the next window, click on
‘With Indexing Service (for
faster local searches)’. Now
click on ‘Yes, enable
Indexing Service’.

How do you want to use
Search Companion?

3 Mwithout 'a"ﬁ'éﬁiiﬁéié&éc“rééﬁg
character
£ with a different character

&3 with Indexing Service (For
Faster local searches)

&3 Change files and folders

search behavior

Use the Indexing Service to
search better

Customise It
STEP Ifyou wish to

customise the
folders to be indexed, click
on ‘Change Indexing Service
Settings (Advanced)’. In the
Indexing Service window
that opens, double-click
‘System’. Double-click
‘Directories’. Now, the
folders being indexed will be
listed. You can remove a
folder from the list by
clicking on the folder and
pressing [Delete]. To add a
folder, click on ‘Action’,
then on ‘New’, and then
on ‘Directory’. Enter the
name of the folder to index,
and click OK.

The indexing process
will begin. It might take
several hours to complete,
but it takes place in the
background. Once the files
have been indexed, you will
notice a vast

2 Indexing Service
File Action Yiew Help
mEE @ »

BT

| Catalog | Location | Total Docs

Fdsystem  Ciisyst,

Advanced Indexing Service
settings

*% Indexing Service

File Action ‘iew Help

& 2
_-Name |
i 1 Directories

I Properties
| (3] Query the Catalog

Double-click Directories to see
which folders are being indexed

Add a directory for Indexing

information using certain
prefixes. For example,
‘@filename wash’ will
display all filenames that
have the word ‘wash’ in
them, whereas ‘twash’ will
find files that have the word
‘wash’ somewhere in them.
You can also use
advanced search features:
for example, adding * (an
asterisk) to the end of

Enhanced Search Using The Indexing Service

Search in Windows XP is more powerful than it seems. Here’s how to exploit it

’ How It Works

he Windows Indexing

Service uses a document
filter that parses through a
document, extracts text and
properties and passes it on
to the indexer. This process
is known as indexing. The
indexed files’ information,
such as the file name,
author’s name, keywords,
size, etc., is stored in the
Catalog file.

‘wash’, as in ‘wash*, will
search for other words such
as ‘washer’ or ‘washing’.
Boolean operators, too, are
supported.

You can also search for
documents based on
properties. For example,
specifying ‘@DocLastAuthor =
Mahesh’ will search for
documents most recently
edited by someone called
‘Mahesh’. Specifying
‘@DocWordCount = 500" will
search for documents whose
word count is 500. For more
information about such
properties, refer to the
‘is.chm’ file in the Help
folder in your Windows
directory. The file is usually
C:\Windows\Help\is.chm.

jayesh_limaye@ thinkdigit.com

%mprovement If you are Query What it What it
m the' speed searching for language term means searches for
at which Two terms in the same gold & coin gold AND coin Documents with both the
search results |document words ‘gold’ and ‘coin’
are achieved. |Either of two terms gold | coin gold OR coin Documents with either of the
Just type the in a document words ‘gold’ and ‘coin’
information One term without a gold & ! coin gold AND NOT coin Documents with the word ‘gold’
about the secondtterm being but not the word ‘coin’

. presen
Feqmre‘d file Documents not matching ! @size = 300 NOT {prop name=size} Documents that are not 300
in the ‘A Word a property value =300 bytes large
or phrase in Two terms that are close  gold ~ coin gold NEAR coin Documents with the word ‘gold’
the file’ box— together in the same following or preceding ‘coin’
the indexed |document
files can be Either of two terms, and  gold | coin &! gold OR coin AND NOT  Documents with the word ‘gold’ or

searched on
the basis of
this

not two other terms if
they are close together

(leather~hag)

(leather NEAR bag)

‘coin’, and not with the words
‘leather’ and ‘bag’ if the latter are
within 50 words of each other
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Remove All Formatting
From A Document

In Word 2002, to remove

all the formatting from
a Word document or from a
selected portion of the
document, select the whole
document by pressing [Ctrl] +
[A], or just select the portion
of the document you want to
remove the formatting
from. Now just press [Ctr]] +
[Shift] + [N].

Status Bar Shortcuts
The status bar—the area
at the bottom of Word
documents—provides shortcuts
to a number of very useful
features. Here are a few. (If the
status bar is not visible, go to
Tools > Options, and in the
‘View’ tab, check ‘Status Bar’.)
D] To open the ‘Find and
Replace’ dialog box,
double-click any location
indicator on the status bar,
such as the page number or
section number.
Bl To turn the macro recorder
on or off, double-click ‘REC’.
D] To turn the ‘Track
Changes’ feature on or off,
double-click ‘TRK.
D] To turn extend selection
mode on or off, double-click
on ‘EXT.
B] To turn overtype mode on
or off, double-click ‘OVR’.
DI To change the language
format of selected text,
double-click Language.
D1 To resolve errors in
grammar or spelling, double-
click the Spelling and
Grammar Status icon.

Formatting Using The
Task Pane
You can use the ‘Reveal
Formatting’ task pane in

aim e
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Word 2002 to view a detailed
description of any text in
your document. You can also
use it to modify or clear the
formatting, compare the
formatting of different
selections, or to find blocks of
text with similar formatting.
Here’s how to use it: select
the text you want to examine
or reformat. From the
‘Format’ menu, select ‘Reveal
Formatting’. (Note that you
can open the ‘Reveal
Formatting’ task pane by
choosing ‘What’s This?’ on the
‘Help’ menu, or by selecting
text within your document
and pressing [Shift] + [F1]) Now
do any of the following:
b1 To change any formatting
properties, click one of the
underlined commands from
within the task pane, and then
change any options you want
in the dialog box that appears.
D] To determine the
formatting source, such as
whether the
formatting
comes from a
style, select the
‘Distinguish
style source’
check box.
B To show
formatting
marks, such as
paragraph marks
and tabs, check
the ‘Show all
formatting

Formatting made easier using the Task Pane

marks’ checkbox.

D] To format a text selection
like the text that surrounds
it, select the text. In the
‘Selected Text’ box, click the
arrow, and then click ‘Apply
Formatting of Surrounding
Text’.

D To view a feature-by-
feature comparison of your
text selection with another
block of text, check the
‘Compare to another section’
checkbox and then select
another block of text.

Place Tables In Adjacent
Columns

Use this in Word to put

two tables adjacent to
each other on a two-column
page: first insert two tables,
one above the other. Adjust
the column widths to
ensure the total width of
each table is less than half
the width of the page. Select
both tables. Now on the
‘Standard’ toolbar, click the
‘Columns’ button, and then
drag the pointer to select
two columns.

Creating A Picture Of A
Toolbar Icon In Word
To create a picture of a
toolbar icon, you can

use a screen capture program.

But you can also try the
following: in any Office
program, right-click the
button you want an image of,
and then click ‘Customize’ on
the shortcut menu. With the

‘Customize’ dialog box open,
right-click the button again,
and then click ‘Copy Button
Image’ on the shortcut menu.
Click ‘Close’. Now you can
paste the button image into
your document.

Make Graphics Line Up
Precisely With Text

You might sometimes

need to include a
picture of a toolbar icon. If
you just copy and paste the
icon into a line of text, the
graphic usually appears
higher than the text adjacent
to it. To resolve this, do the
following: first, select the
graphic. Then on the ‘Format’
menu, click ‘Font’, and click
the ‘Character Spacing’ tab.
Click ‘Lowered’ in the
‘Position’ box, and then
specify how much space you
want in the ‘By’ box. Three
points is usually enough for
most toolbar icons.

Customise Comment Text
If you find that the
default settings for

comments in Word 2002 are

a little too small, changing

the size and font is easy. You

can use standard formatting
commands to modify the

text in comment balloons as
you type. Here’s how: on the

‘Format’ menu, click ‘Styles

and Formatting’, which will

open the Styles and

Formatting task pane in the

right margin. In the task

pane, under ‘Pick

Formatting to Apply’, make

sure the ‘Comment Text’

entry is visible.

If it is not visible, then on
the ‘Show’ drop-down menu,
click ‘Custom’; and in the
‘Format Settings’ dialog box,
under ‘Styles to be visible’,
click ‘Comment Text’, and
then click ‘OK’.

Now that the ‘Comment
Text’ entry is visible, you can
go ahead: under ‘Pick
Formatting to Apply’, right-
click the ‘Comment Text’
entry, and then click ‘Modify’.
Select any of the options you
want. To see more options,
click ‘Format’, and then click
the attribute that you want to
change. Click ‘OK’ after
changing each attribute.
Repeat the last two steps for
any additional attributes you
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want to change.
A Shortcut To Modify
Bullets and Numbering

Do you get tired of

searching through menu
commands to make changes
to the numbering schemes in
your Word documents? Skip
the menus, and use this
shortcut instead: to open the
‘Bullets and Numbering’
dialog box and adjust the
numbering scheme, just
double-click one of the
numbers in the numbered list!

Create A Custom Word
Template

If you don’t like the

default font and other
settings in Word, you can
create a template of your
favourite font styles and sizes
and use it whenever you
want. To create a custom
template, first, on the View’
menu, select ‘Task Pane’. If
the ‘New Document’ task
pane is not visible, select it
from the drop-down menu in
the upper right corner of the
task pane. Now, in the ‘New
Document’ task pane, click
‘General Templates’. In the
‘Templates’ dialog box that
appears, select the ‘General’
tab, and click ‘Blank
Document’ once to select it.
This will be the base for your
new template. Under the
‘Create New’ section, click
‘Template’, and click OK. In
the new template, add any
text and graphics that you
want should appear in all
new documents that you base
on the template, and delete
any items you don’t want to
appear. Make the changes you
want to the margin settings,
page size and orientation,
styles, and other formats.
Finally, on the ‘File’ menu,
click ‘Save’, give your
template a name, and then
click ‘Close’ on the ‘File’
menu. Your new, customised
template will then be
available as a choice under
‘General Templates’ in the
‘New Document’ task pane.

Navigate Long Documents
Easily with Hidden
Bookmarks
When you work with
long documents in Word,
it can be difficult to remember
where certain text appears.
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You can use hidden
bookmarks to quickly navigate
to that text. To add a
bookmark, first, in your
document, click where you
want to place a bookmark. On
the ‘Insert’ menu, click
‘Bookmark’. When the
‘Bookmark’ dialog box opens,
name your bookmark. Then
click ‘Add’. To find your
bookmark, press [F5] to open
the ‘Find and Replace’ dialog
box. Click the ‘Go To’ tab, and
type the bookmark name in
the ‘Enter Page Number’ field.
Click the ‘Go To’ button to get
to the text you bookmarked. In
Word 2002, click ‘Bookmark’
in the left of the ‘Go To’ tab,
and select from the list of
bookmarks that appears.

Keep Links Up-To-Date

In Excel, you can create

formulas in one
workbook that link to data
stored in another source
workbook. But if your source
workbook changes regularly -
for example, if you update the
source and save it under a
new name each month—it can
be very time—consuming to
find and update links to the
old source workbook. But
there’s an easy way to do this.
First, open the workbook that
contains the link(s). On the
‘Edit’ menu, click ‘Links’. In
the ‘Source’ box, click the
name of the link with the

source you would like to
change. Click ‘Change Source’.
Finally, in the ‘Change Source’
dialog box, click the source

workbook you want to refer to.

Of course, to successfully
change source workbooks,
the linked data must reside
in the same cells in the new
source workbook as they did
in the old one.

Removing All Smart Tags
In Excel 2003, Smart Tags
can be irritating if you

never use them. To hide Smart

Tags in a sheet, go to Tools >

AutoCorrect Options. Select

the ‘Smart Tags’ tab, and from

the ‘Show Smart Tags As’
dropdown list, select None.

Generate Random
Numbers In Excel
Sometimes you may
need to populate a sheet
with random numbers.
There’s an easy function you
can use to do this

saocorrect | AutoFormat As You Typs Smart Tags |

Excol can recognice certan types of data in your workbocks,
FFor aach recognized typa, thene are actions you can perform
with that data.

[ Labol data with smart tags

Regognizers:
]
E

Creck Workbaok... | ore Smart Tags... |

Show smart tags a6 Ilnm_..u: and Button =

Remove All Smart Tags!

®
Random Numbers
Sometimes you may need to
populate a sheet with random
numbers. There’s an easy
function you can use to do this
automatically. Type =RAND() in
a cell to generate a number
between 0 and 1. You can type
=RAND()*100 to generate a
number between 1 and 100.
After entering a function, you
can use the fill handle to
quickly populate as many cells
as you’d like with random
numbers. To use the fill
handle, click the cell, move
your pointer over the lower-
right corner of the cell until it
turns into a black plus sign,
and drag it horizontally or
vertically across the cells you
wish to populate.

automatically. Type =RAND)
in a cell to generate a number
between 0 and 1. You can type
=RAND()*100 to generate a
number between 1 and 100.
After entering a function, you
can use the fill handle to
quickly populate as many
cells as you’d like with
random numbers. To use the —_
fill handle, click the cell,
move your pointer over the
lower-right corner of the cell
until it turns into a black plus
sign, and drag it horizontally
or vertically across the cells
you wish to populate.

Results Without Formulas
In Excel 2002 and above,
using the Smart Tags,

it’s very easy to copy and

paste a result without the
formula. First select the cell
that contains the data you

want to copy. Press [Ctrl] + [C]

to copy the cell data, and

then press [Ctrl] + [V] to paste

the data in a new location. o,\{

Click the arrow next to the

‘Paste Options’ smart tag, and

then click ‘Values Only’.

Use Your Spreadsheet
Like A Database

You can use AutoFilter to

analyse the data in your
Excel spreadsheet based on
specific criteria. For example,
if you are a salesman with a
spreadsheet listing all the
clients you have in each region
you cover, you can use
AutoFilter to sort by a specific
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Varun Dubey

have mentioned Bayesian
W:pam filters before in Digit.
Here, we give you a 30-

minute brief on the most popular
Bayesian spam-guard called, very
innovatively, SpamBayes. The way it
works is, the program, using Bayes’
theorem, assumes that each message
has evidence for being spam as well
as ham, or ‘not spam’. Every time you
see a message, you ask yourself about
it: “Is it spam or ham?” Then, what
you do with the message answers the
program’s question one way or the
other, and the system learns. The
program thus learns according to
how you deal with messages. So, if
over time, your preferences change,
so will your spam settings—and that
too, automatically!

Get it
STEP To set up SpamBayes, you will
need to download the
installation file from http://snipurl.
comj/cupc.

This is a complete installation file
and will work on Outlook
2000/2002(XP)/2003. It will not work
with Outlook Express.

Hold it! Once you have this
downloaded, don’t just install it.
There are some preparations you
need to do in order to make
SpamBayes function.

Pre-Installation Preparation
STEP SpamBayes learns by example,

so you need to show it a set of
good mails (ham) and a set of bad
mails (spam). There are probably good
mails residing in your Inbox right
now. And there is probably some spam
in your Junk Mail folder. Just keep
these two sets of examples ready. If for
some reason you can’t set up these
two folders, then you will just have to
let SpamBayes learn as you classify
and delete mails as and when you
check them.

Installation
P When you install SpamBayes it
will ask you to choose from
two options: Microsoft Outlook Addin
or Server/Proxy application, which is

Select applications to install
A s of acpkeations are inchuded wih this package

Sielect the companenis you wish lo natal

2] Miceosch ook Addin [Dullock, appsars to be msaled)

5] Serves/Prowy sppication, lor o other POP based i chients, inchuing Dutiook
= Evpress

You can choose either or both at this screen

for all other (non-Outlook) POP3-based
mail clients.

SpamBayes will appear as a toolbar
when you start Outlook.

The Training
STEP After the installation, the first

time you start Outlook, you
will get a pop-up asking you whether
or not you have the folders configured
as mentioned in step 2, or if you
would rather let SpamBayes learn. If
you do have the folders configured,
simply point SpamBayes to them and
it will analyse all your e-mails, and
create its own set of criteria that will
govern where future messages go.

If you do not have the folders
configured, then just check your mail
as you normally do, and when you
want to classify something as spam,
just select it and hit the button
marked ‘Delete as spam’. The message
will be moved to your Junk folder. If
you accidentally delete a message that
is ham, just select it and click
‘Recover from Spam’.

To edit SpamBayes settings, click
SpamBayes, and then SpamBayes
manager. Here you can see how many
messages it has on hand to learn from.
Obviously, the more the messages, the
better the filtering.

B

Hiew + & (-]

) Delete A Spam Spebaves = _

Mtachments: Trerrsco-on.0e 1 48)

The SpamBayes toolbar

Since the program just awards
points (probabilities) to messages to
classify them as spam or ham, you
can edit the points and the folders
associated with those points via the
Filtering tab.

The training tab allows you to
specify the folders from where the
program will learn.
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Keep Spam At Bay With SpamBayes

Configure Outlook to use one of the best Bayesian filters out there

Configuration For Non-Outlook
Users
If you are using a different e-mail
client such as Outlook Express or
Eudora, then
Install as option 2 (that is
Server/Proxy application), as
specified above.
Right-click on the icon in the
system tray and click configure. You
will come to a Web page-based
settings menu.

Here you need to enter your e-mail

o Spambayes Waeb Irterface: Home > Configure

FOPY Frary Optems

The Web-based manager for SpamBayes

server settings and the requisite ports.
Generally, use port 110 for the POP3
server and 25 for the SMTP server.
B] Once this is set up, you need to
go to the connection settings for
your e-mail client and set the POP
address to 127.127.0.0. If for some
reason this doesn’t work, then just
type in ‘localhost’.

Now every time your mail comes
in, SpamBayes will analyse it and

General  Servers | Connection  Secwity  Advanced
Server Information
My incoming mad serveris a |EILE| | server
p—
Incoming mad [POP3): | localhost |
Pttt

Outgoing mad (SMTP]: | smip.jdm.co.in

The settings page for Outlook Express

classify it a ham, spam or ‘unsure’.
You can configure it to add the
classification word in the subject
line of your message. Or you can
create filters to direct the mail into
the folders accordingly. You can
correct improper message
classifications via the Review
Messages page, the link to which is
found on the home page.

What remains to be seen is how
good the system will be at filtering
out spam of the future, and whether
spammers can come up with
something innovative enough to beat
SpamBayes. But for now, you are set!

varun_dubey@ thinkdigit.com
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region and get a snapshot of
just the clients in that region.
Here’s how you to use the
feature: first click a cell in the
list you want to filter. You
should choose a cell that
appears in a row that contains
a heading and related data,
such as a set of client names or
phone numbers. Now on the
‘Data’ menu, point to ‘Filter’,
and then click ‘AutoFilter’.
Arrows will appear at the
heading of each column. Click
an arrow, and choose your
filter criteria from the drop-
down menu. For example, you
could filter for a number
that’s greater or less than a
target figure. Now only rows
containing data that meet the
criteria will be displayed.

Switch Between Absolute
And Relative Cell
References

When you create a

formula in Excel, the
formula can use relative cell
references, which refer to cells
relative to the position of the
formula, or absolute
references, which refer to cells
in a specific location. Formulas
can also contain a mix of
relative and absolute
references. An absolute
reference is indicated by the
‘$’ symbol. For example, $A$1
is an absolute reference to
column A, row 1. When
working with formulas, you
can easily change column and
row references from relative to
absolute, and back again,
using this handy shortcut: first
select the cell that contains
the formula. In the formula
bar, select the reference you
want to change. Press [F4] to
toggle through the
combinations.

Quickly Calculate A
Person’s Age

This tip is a

demonstration of the
DATEDIF() function in Excel,
which calculates the number
of days, months, or years
between two dates. So, this
function makes it easy to
calculate a person’s age. To
try this tip, in a blank
worksheet, type the birth
date in cell A1, using slashes
to separate day, month, and
year. In cell A2, type
“=DATEDIF(A1,TODAY(),”y”)”
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(without the beginning and
ending quotes) and press
[Enter]. The age in years will
be displayed in cell A2.

Clear All Spreadsheet
Formatting

Here’s an easy way to

quickly clear all
formatting in your Excel 2002
spreadsheet. Click any cell in
the spreadsheet and then press
[Ctr]] + [A] to select all cells in
the worksheet. Then on the
‘Edit’ menu, point to ‘Clear’,
and then click ‘Formats’.

Combining Text From
Different Cells

The ‘&’ symbol

consolidates text
information in the same way
as the ‘+’ symbol adds
numbers. The space between
quotation marks adds a blank
character between the
separated texts. To combine
text using ‘&’: in cell A1,
enter the text “Digit”
(without quotes). In cell A2,
enter the text “is a great”. In
cell A3, enter “magazine”.
Now in cell A5, type the
formula: =A1&” “&A2&” “&A3

MS POWERPOINT

Create Bitmap Images of
Slides
If you want a quick way
to send a single
PowerPoint slide to someone,
you can try converting the

slide into a bitmap image.
You can then resize, crop,
and paste it into an e-mail
message or an Office
document. Here’s how: open
the slide you want use as an
image. On the ‘View’ menu,
click ‘Notes Page’. The slide
will appear on the notes page
as an image. Right-click the
slide image, and then click
‘Copy’ on the shortcut menu.
The image is now stored on
your clipboard, and you can
paste it as a resizable object
into any Office document.

Create A Photo Album
Presentation

Did you know you could

use PowerPoint version
2002 to create a photo album?
Here’s how. On the ‘Insert’
menu, point to ‘Picture’, and
then click ‘New Photo Album’.
In the ‘Photo Album’ dialog
box, you can choose to add
pictures from your hard disk
or a peripheral

device such as a [o# SieShow Window el

=4 - msy EEE:

scanner or
digital camera.
To add a picture
from a file or
disk, do the
following:
under ‘Insert
picture from’,

% Entrance »
¥ Emphasis  *

[# Exi v

want to add to your photo
album, click the picture file,
and then click ‘Insert’. Repeat
for as many pictures as you
want to add to your photo
album. Or to capture them all
at once, hold down [Ctr]],
click each picture file you
need, and then click ‘Insert’.
Next, specify the look of the
album under ‘Album Layout’.
Finally, click ‘Create’.

Cut Graphics Down To Size
Adding a few images
can make the size of

your PowerPoint presentation

huge. You could compress
images manually, but there’s

a simpler way. PowerPoint

2002 can do it for you. On the

‘Picture’ toolbar, click the

‘Compress Pictures’ button.

(If you don’t see the Picture

toolbar, point to ‘Toolbars’ on

the ‘View’ menu, and then
click ‘Picture’.) To compress
all pictures in the
presentation, click ‘All

Pictures in Document’. Under

‘Change Resolution’, select

how you intend to use your

presentation by clicking
either “Web/Screen’ or ‘Print’.

To further reduce file size,

check the ‘Delete Cropped

Areas of Pictures’ check box.

Click OK.

PowerPoint Animations
In PowerPoint 2002,
adding animation for

professional-looking

presentations is not only

easy, it’s fun. To apply a

custom animation, in

normal view, display the
slide that has the text or
objects you want to animate.

Select the object you want to

animate. On the ‘Slide Show’

menu, click ‘Custom

Animation’. In the ‘Custom

Animation’ task pane, click

A F Degign JIjew d
@ ¢ Custom Animation
[ity A Emect +

fikect arv et of o sk,
ik Aok Effct” 0 ackd s

Motion Paths *

click ‘File/Disk’.
Locate the
folder or disk

This is the g 7

Click to add subtitle

that contains

PowerPoint animations can spruce up your

the picture you presentations, and they are fun to make too




‘Add Effect’, and do one or
more of the following:

DI If you want to make the
text or object enter the slide
show presentation with an
effect, point to ‘Entrance’ and
then click an effect.

B If you want to add an effect
to text or an object that is on
the slide, point to ‘Emphasis’
and then click an effect.

DI If you want to add an effect
to text or an object that makes
it leave the slide, point to
‘Exit’ and then click an effect.

Nudging Objects

You can use the arrow

keys to move objects
very small distances. Select
the object, then use your
arrow keys. Each press of the
key will move the object one
‘Grid Unit’, which is 1/12th of
an inch. If you hold down
[Alt] while nudging, or if you
have the grid turned off, you
can move the objects one
pixel at a time.

Darken The Display
PowerPoint has a feature
that lets you darken

your display until you are

ready to begin your
presentation. With

PowerPoint in Show mode,

press [B] on your keyboard.

PowerPoint now displays a

black screen. When you are

ready to begin your
presentation, press the [B] key
again, and your display will
return. Remember to only
press [B] to return your
display - pressing any other
key may advance your slides.

Proportionate Resizing
Hold down the [Shift]
key while resizing

images. Doing so will allow

you to resize an image
without changing its
proportional dimensions.

®
Subliminal Messages
These can be very useful in the
right circumstances. Create a
text object. With the text
object selected, click on the
‘Animation Effects’ button on
the toolbar—the one that looks
like a yellow star—and then
click on the ‘flash once’ button.
You will see the message
quickly flash and disappear.

Digital Tools | Tips & Tricks
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Change The Calendar View
Did you know you can
use a keyboard shortcut

to modify the number of days

visible in your Outlook
calendar? Just press [Alt] and
any number between 1 and

10. The number determines

how many days will be

displayed. So, for instance, to
see an eight-day span, just
press [Alt] + [8]. (For this to
work, you must use the
number keys on the keyboard,
not the numeric keypad.)

Schedules At A Glance

The Calendar group

schedule in Outlook
makes it easy to see the
combined schedules of a
number of people or resources
at a glance. You can create and
save multiple group
schedules, each showing a
group of people or resources.
To create a group, first click
‘Calendar’ on the ‘Folder List’
(or in the Outlook Shortcuts
bar). Click Schedules in the
‘Advanced’ toolbar. In the
‘Group Schedules’ dialog box,
click ‘New’. Type a name for
the new group schedule, and
then click OK. In the dialog
box that appears, click the
‘Add Others’ button, and then
click either ‘Add from Address
Book’ or ‘Add Public Folder’.
Select the names or the public
folder, and then click ‘Save
and Close’.

To view the group
calendar, select the group
schedule you want to view,
and then click ‘Open’.

Unknown Sources

Want to keep e-mail

messages from people
that you don’t know out of
your Inbox? You can set rules
to move messages from
unknown sources to a
separate folder where you
can sort through them at
your leisure.

First, create a new folder in
your Inbox to hold any mail
sent by an unknown source: in
the Folder list, right-click
Inbox and click ‘New Folder’.
Now, type a name for the
folder, such as ‘Unknown
Senders’, and click ‘OK’.

Next, create a new rule
with the ‘Rules Wizard’: on
the Tools menu, click ‘Rules
Wizard’. Click ‘New’, and then

®
Browsing In Outlook?
With Outlook 2002, you can
view a recently-visited Web site
without minimising or closing
Outlook. When you select a
Web site address from the
‘Address Bar’, the Web page
appears within Outlook. To
open a Web page from within
Outlook, on the Address Bar
(located above and to the right
of the area where your e-mail
messages appear), click the
vertical line next to Address,
and then slide it to the left
until you see the Address box
and the Go, Stop, and Refresh
buttons. Then do one of the
following: either type the
address for the Web page you
want to display in the Address
Box, and then click ‘Go’. Or,
select an address from the list.

click ‘Start from a blank rule’.
Click ‘Check messages when
they arrive’, and click Next. In
the ‘Which condition(s) do you
want to check? box, select the
‘On This Machine Only’ check
box. Click ‘Next’. In the ‘What
do you want to do with the
Message’ box, click ‘Move it to
the Specified Folder’. In the
‘Rule Description’ box, click
‘specified’, click the folder you
created (such as ‘Unknown
Senders’), and then click ‘OK’.
Click ‘Next’. In the ‘Add any
Exceptions’ box, check the
‘Except if sender is in specified
Address Book’ checkbox. In the
‘Rule description’ box, click
‘Specified’. In the ‘Add Address
List’” dialog box, choose
‘Outlook Address Book’, click
‘Add’, and then click ‘Next’.
Type the name of your rule,
click ‘Finish’, and then ‘OK’. &
ram_mohan@thinkdigit.com
robert_smith@thinkdigit.com
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Bring It Home

on that trave
e. Subscribers ne

a and a set-top box (STE

ow it works

A DTH transmission is beamed directly to t
consumer via a small satellite dish. A DTH networ!
typically consists of a broadcasting centre,
satellites, encoders, multiplexers, modulators

and DTH receivers.

L

The DTH service provider will lease Ku-band
transponders from the satellite. The encoder
converts the audio, video and data signals into the
digital format, and the multiplexer mixes the signals.
. —
A small dish aqterfha and set-top box (STB) will let
the congume"r""decode and view numerous channels.

66 DIGIT MARCH 2005




Weighing The DTH Offering

1. DTH supports multiple connections in the same premises,
but each TV set needs an individual STB

2. As the broadcaster directly connects to the user,
middlemen (local cable operators) and wires (cables) are
avoided. DTH can also reach the remotest of areas—villages,
small towns and far-flung locations

3. High-end DTH boxes provide value-adds such as PSTN
connectivity, gaming, Personal Video Recording (PVR), Web
browsing, video conferencing and e-mail

4. DTH offers better picture quality than cable TV and also
digital stereo sound

5. Monthly payments are made directly to the satellite
company offering the service: thus, under-reporting of
subscribers by cable operators can be checked

Cable transmission can be of two kinds—unlimited
access and Conditional Access System (CAS). With
CAS, consumers have the option of choosi
channels they want toi only for
e whole bouquet that the

cable operator has to offer. Operators often price
channel offerings based on their popularity.

CAS requires a dedicated STB along with a

Q Conditional Access—pay
only for select channels.
| Hardware required: STB

Digital Tools | Visual Explanation

=

DTH Cons:

1. DTH wi
exists toda *
2. Installation of )
the STB) is likely to ce

STBs are priced at Rs 4,000). DTH
hovers around Rs 500 per month (ara
3. Though a Government directive has
free-to-air channels on cable to be deli
without a STB, DTH signals require a ¢
4. If consum 00S€e ition
connecti

espe!

Unlimited access via a cable|
connection to your TV.

ueJeypaals ysauig diydesSoyu|

weandpjue BI33N IX8L

cable wire connecting your television set to the

~local operator.
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Facing flak for PowerPoint presentations acting up?
Read on for some solutions to easily avoidable glitches

Ram Mohan Rao

1. PowerPoint does not display
fonts correctly

Reason: When used on a system other
than the one on which the presentation was
created, fonts may not display correctly.
This can happen when you transfer or open
a PowerPoint presentation file on another
PC that does not contain the fonts that are
installed on your system.

Solution: Embed TrueType fonts. When
you save your presentation, use the ‘Save
As’ command and in the ‘Save As’ dialog
box, choose ‘Embed TrueType Fonts’ from
the ‘Tools’ menu. In PowerPoint 2002
(also called PowerPoint XP), go to
Tools>Save Options and check ‘Embed
TrueType fonts’.

When you are saving a presentation, from the
Tools menu in ‘Save As’, choose to embed fonts

2. PowerPoint presentation file
sizes bloat

Reason: Bitmaps, if you use them, take
up a lot of space. And sometimes,
presentation file sizes bloat for no
apparent reason.

Solution: Try reducing the resolution of
your bitmap images. For viewing on
screen, bitmaps need not be more than
96 dpi. If the screen is the primary
viewing medium, it is pointless to

have higher-resolution bitmaps.

Also, sometimes, as you are working on
a presentation, the file might seem to
get bigger for no reason. To eliminate
this bloating, save the file using
File>Save As and give the file a new

name. This can reduce the file size up to
50 per cent.

3. An audio clip can stop playing
when you advance slides

Reason: This can happen due to the
default settings in PowerPoint.
Solution: If you are using PowerPoint
2000, insert your sound file and go to
Slide Show>Custom Animation. Check the

2%
Spelling and Style |
Edit Pt |

General options
[~ Provide feedback with sound to screen elaments

You can choose what sound file sizes to link
and what sizes to embed

‘Media’ box that represents the sound
file. Now click the ‘Multimedia Settings’
tab and tick the ‘Play using animation
order’ box. Tick ‘Continue Slide Show’.
Specify the number of slides for which
you want the sound to play. If your sound
clip is for a short duration and you want
it to play over and over again, click on
‘More Options’ and check the ‘Loop until
stopped’ box.

A related problem is that your sound
file does not play at all when you begin
your presentation since sound clips that
exceed a certain size do not get embedded
into the slideshow. The solution is to
change the default setting.

In PowerPoint 2002, go to
Tools>0Options, and in the ‘General’ tab,
change the settings in the ‘Link sounds
with file size greater than’. Set this to a
larger value.

4. The same background
appears on every slide

Reason: PowerPoint automatically takes
the background from the background
master slide.

Solution: PowerPoint 2002 supports
multiple background masters. Open the
first slide and go to Insert>Slides From
File. Browse to the second set of slides
and choose the ones you want. In the
lower left hand corner of the dialog box,
tick the checkbox that says ‘Keep Source
Formatting’. The slides you add will keep
their backgrounds.

For PowerPoint 2000 and earlier
versions, from the ‘Format’ menu, select
Background. Check the box that says ‘Omit
background items’ and this will make the
slide ignore the Slide Master’s design. You
can now apply whatever design you prefer
to the slides.

5. Text is not very readable in
front of a certain background
Reason: You may not notice it while
editing your presentation in front of a
screen, but dark text on a dark
background does not read very well. If you
want to keep your background, but would
like to lighten it a little to improve
readability, there is a way.

Solution: To create a light background
for your presentation, open the slide
master by going to View>Master>Slide
Master and choose Insert>Picture>From
File. Find and insert the image and resize
it to fit the slide. With the image

[z |

‘Washout’ the background from the Picture
toolbar to make text more readable

selected, choose ‘Draw’ on the Draw
toolbar, then select Order and then ‘Send
to Back’. From the Picture toolbar,
choose ‘Color’, then ‘Washout’. Dark text
will now show up clearly. m
ram_mohan@thinkdigit.com
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Seagate 2.5 GB USB 2.0 Pocket Hard Drive

This external hard drive from Seagate is
about as big as a Marie biscuit and 1.5
inches thick, but packs in a cool 2.5 GB of
space. It connects to a system via the USB 2.0
interface. You can write-protect
and password- protect
the drive.
SiSoft Sandra
reported read and
write speeds of 6
MBps and 5 MBps
respectively. The
average access time was
17 ms. The compact
drive does seem like a
handy tool for
photographers and anyone else
who needs to transport large amounts of data.
However, at Rs 10,000, it is fairly overpriced.

Company Fortune Marketing Pvt. Ltd.

Price Rs 10,000 for 2.5 GB; Rs 15,000 for 5 GB
Phone 26472491 Mobile 9810155208

Web site www.seagate.com

Ratingﬁ‘x‘l‘
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One PC EX

his device is a PC-sharing solution. Though a

little expensive, it can save you money if you
need another system for general office work.

It looks like a sleek blue wireless hub with a
blue backlit neon power button. There are con-
nectors for the keyboard, monitor, mouse, LAN
and speakers. The existing PC connects to this
device using a crossover LAN cable.

To test for performance, we used a Pentium
4 3.2 GHz processor with 1 GB of RAM, but still

couldn’t play two movies
simultaneously on the
host and virtual
PCs. However, it
does every-
thing else
commend-
ably well,
such as playing a
movie on one computer and music on
the other. The Rs 10,000 price tag is a
little steep though, as today, com-
puters for office use cost only about Rs
15,000. It’s up to you to decide whether the Rs
5,000 difference is worth it or not!

Company Adline Systems

Price Rs 10,000

Phone 011-25720911 / 25720441
E-mail adline@bol.net.in

Web site www.adlinesystems.com

ing I | |
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MSI Mega View 561 Portable Media Player

Way Too Expensive

This sleek device is MSI’s answer to the iPods and Gminis of today. It
packs in a respectable 20 GB of disk space and a 3.5-inch LCD screen
that has surprisingly good clarity.

The device supports viewing and playback of the DivX 3.11/4/5,
MPEG4, WMV, MP3, WAV, WMAQ9, JPEG, GIF, TIFF, and BMP formats. It
supports a maximum of 30 fps in video and 320 Kbps audio—really good
quality DivX. -

The device records voice as well,
and the mic is really sensitive. It even
has an inbuilt FM tuner,
programmable for eight stations.

Using the bundled AV cables, the
MSI Mega View can record to and play
back from a TV.

The device does not have the —
ability to create playlists. The s
bundled earphones are good, but since they are not padded, your ears
cannot take more than an hour of continuous listening. Overall, great
features, a few bugs, and way too expensive!

Company Cyberstar Infocom Limited
Price Rs 28,500

Phone 0-9323809599

E-mail info@cyberstarindia.com ——— | |
Web site www.msi.com.tw Rating 7T "
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A Great Looker, But...
This five-megapixel, 3x optical zoom

camera fits perfectly in your hand, and is

nice and light. It has tiny, interesting-looking
lights on the top, which display capture
modes such as Auto and Movie. The 2.5-inch
LCD screen crisply displays the images in
focus, along with the various options such as
white balance.

Strangely, the menu button is on the top,
and the ON/OFF button and the hard-to-handle
menu navigation joystick are placed beside the LCD
screen. Selecting and navigating through the menu is
difficult. The lack of an optical viewfinder means that
you are forced to drain your batteries by using the LCD all the
time. The Auto setting works fine, but others, such as Night Mode, end up
producing images with blue tinges.

Even in broad daylight, images appear dark, and the flash goes off.
Detail and textures in the captured images are superb, though.

Indoor shots come out better, especially close-ups in Macro Mode; but
outdoors, with an overcast sky, the images are very dark. In order to
connect this camera to a PC you need to carry around the USB connector-
cum-power docking station everywhere, as it doesn’t connect directly.
Also, there’s only 16 MB of internal memory. Overall, a great looking
camera, but with a lot of drawbacks.

Company Neoteric Informatique
Price Rs 23,900

Phone 022-39828600

E-mail sales@neoteric-info.com
Web site www.kodak.com

Rating W ‘ 1 ‘ 1 ‘
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iPod Shuffle 1GB

Very Desirable Indeed

he new iPod, christened ‘Shuffle’, is

extremely chic, and makes for a great neck
ornament. It features a circular button for Play
and Pause, which also doubles up as Hold when
pressed for three seconds. Press the same button
thrice in succession and you are taken to the start
of the playlist. The button is circled by a dial that
sports the volume controls and the Next/Previous or
FF/RW keys.

Three hidden LEDs lie just under the surface, and
are only visible when lit. The two above the dial, green
and amber, light up during various functions. Flipping
the device over reveals a sliding switch
that lets you switch it ON/OFF, and
toggle the shuffle mode.

There is a small, pinhole-sized LED
on the bottom that tells you the battery
status when the battery button is
pressed. Battery life is amazing—14 hours
on a single charge!

The Shuffle supports the MP3, MP3 VBR, WAV, AAC, and
AA 2, 3 and 4. The sound quality is as impeccable as that of
any of the larger iPods. It can be used as an external storage

Rating

device as well. However, transferring music using iTunes

was slow—it took us about 10 minutes to transfer 1 GB of
music. Also, transferring music to the device directly
without iTunes doesn’t work—the songs just don’t play.
The Shuffle lacks a screen. It doesn’t play FM,
doesn’t record voice, and does not support ID3 Tags.
Priced at just Rs 12,400, the Shuffle is a great buy.
Lower capacity players, such as the Creative MuVo

[ A TX 256MB and Samsung
W4

Y

. Yepp YP60 256 MB
_» cost Rs 8,000 and Rs
» 16,000 respectively,
and only offer the
additional feature of FM
and voice recording. If music
is all you want, nothing beats the Shuffle.

Company Apple India
Price Rs 12,400
Phone 080-25550575
Web site www.apple.com

iPod Photo 40 GB

Watch Playmates On This One!

he newest entrant in the hard disk-based MP3

players segment is the iPod Photo. It is essentially
the regular iPod, with added photo-viewing
functionality—hence the name.

The black-and-white screen makes way for a
spanking new 220 x 176 screen capable of displaying
65K colours. You can also view your photos on a TV
or a projector via the bundled AV cables.

The bundled iTunes 4.7 automatically converts
popular image formats to its own proprietary format,
and optimises them for viewing on a standard or
widescreen TV. To Apple’s credit, the images
appeared crystal-clear on a 25-inch TV screen. The
device displays 25 full-colour thumbnails of stored
images. It can also synchronise automatically with albums created with
iPhoto, Adobe Album 2.0 and Elements 3.0. However, once you have the
images in your iPod Photo, you cannot play around with them in any way—
rotating, panning, or even deleting directly from the device is not possible.

Considering the new colour display, we expected a significant drop in
battery life, and were stunned to see that the battery life had actually been
prolonged to a cool 15.5 hours on a single charge!

Though it is still a great music player, at the end of the day it all boils
down to price. And at Rs 35,000+, Apple really is asking for the moon,
considering that you can get full-fledged portable media players which do
all that the iPod photo does.

However, there’s one reason you might want to buy this piece of luxury:
Playboy has come out with seriously hot content for the iPod photo, and has
named the service iBod! Now we really wish the screen was a lot bigger!

Company Apple India
Price Rs 36,000

Phone 080-25550575
Web site www.apple.com

Rating | — | |
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Looking for more information on any of the products featured here?

Please write to products@thinkdigit.com. The Digit Test Centre will be delighted to
respond to your queries.

Mac Mini

t’s small, resembles a lunch box, and costs as

much as six years of school education. Take
the more than Rs 30,000 base price of the
mini, add the price of 256 MB of memory—$75
or Rs 3,300—and the official “most affordable
Mac ever” tag, while true, seems ludicrous.

The mini is obviously a “try me” for the
PC crowd, a fact underlined by the missing
monitor, keyboard,
speakers, and mouse. O
The question then, is,
should you pay a small
fortune for a dip in the
Mac OS X pool?
If your computer

usage is bracketed by the
tasks of word processing,
Internet surfing, e-
mailing, listening to
MP3s and watching a
movie occasionally—then yes, by
all means add the mini to your tech col-
lection. The hardware, once beefed up with
256 MB of additional RAM, is good enough to
drive these tasks and the odd OpenGL game or
two on a 23-inch LCD screen (we tested the
mini on one). Mac OS X is a wonderful, user-
friendly and mostly consistent OS to work
with. If you have the cash and the missing
hardware on hand, this Apple experience is
indeed worth the price of the ticket.

-,

Company Apple India
Price Rs 32,300

Phone 080-25550575
Web site www.apple.com

Rating | —
I 2 3

| ]
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1 Poor: Has serious drawbacks and needs improvement before it can be used for its target application. 2 Mediocre: Does not live up to expectations, needs improvment
in many areas. 3 Average: Reasonably competent but nothing spectacular about the product. 4 Goeod: A good buy, better than most products in its category.

5 Excellent: A brilliant combination of price, performance and features - far beyond expectations.
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Intel Motherboards

Gigabyte GA-81915G Duo

Excellent Performance at an
affordable price

Portable Hard Drives
WD-Media Centre 250GB
Very low cost per MB

=] Memory card reader slots

Contact Western Digital

Phone 022-25851085
E-mail ajay.kapure@wdc.com
Price Rs 17,000

Contact Digi Giga System Ltd.
Phone 022-26526696

E-mail sales@digigiga.co.in
Price Rs 6,000

Freecom FDH-2 Pro 80 GB
Extremely compact and bun-
dled carry case

Contact J S Equipments
Phone 022-23810713
E-mail jse@vsnl.com
Price Rs 19,500

Gigabyte GA-81915G-MF
Very affordable
=1 Average performer

Contact Digi Giga System Ltd
Phone 022-26526696

E-mail sales@digigiga.co.in
Price Rs 5,300

AMD Motherboards

ASUS KSN-E Deluxe

B Excellent performance and
great features

[= Lacks PCI-Express

PDA Phones

Nokia 9500 Communicator
Full QWERTY keyboard

=1 Slightly bulky

Contact Company: Nokia India Ltd

Contact ASUSTeK Computer Inc Phone 011-22677900
Phone 022-56290785 E-mail jay.bakshi@nokia.com
E-mail info_india@asus.com.tw Price 41,359

Price Rs 8,736

MSI K8N Neo Platinum (Gold)

Monitors (17-inch)
BenQ V773

Good screen geometry
[=I Not a flat-screen monitor

Contact BenQ India

Projectors

Acer PD11

High 1600 lumens bright-
ness support

Big 330-Inch diagonal

image size capability Phone 022-25705230
Picture in Picture mode E-mail SalesEnquiryin@
Contact Acer India Pvt Ltd BenQ.com
Phone 080 25219520
E-mail rajesh_aiyar@acer.co.in
Price www.acer.co.in

Price Rs 5,900

Philips 107E5

Acceptable performance for
its cost

= Not a flat-screen monitor

Contact Philips India

Phone 022-56912325

E-mail
PCP.India.Info@philips.com

Price Rs 8,500

Sony VPL-ES2
Easy to set up
Low running cost of lamp
[# Good performance
Contact Sony India Ltd
Phone 022-28313333
E-mail chiragk@sid.in.sony.
com.sg
Price Rs 79,990

The best products tested so far in different
hardware and software categories

Cell Phones

Sony-Ericsson K700i

[# Extensive feature set,
includes camera, MP3, FM
radio etc.

Fast processor
Contact Sony Ericsson
Phone 0124-2560808
E-mail dhiraj.soni@
sonyericsson.com
Price Rs 18,000

CRT Monitors (19-inch)

Philips 109P4

Aperture grille for more
accurate geometry

= Bad implementation of
the on-screen display for
changing a setting
Contact Philips India
Phone 022-56912325
E-mail PCP.India.Info@

philips.com

[# Excellent performance and
good features
[=] Lacks PCI-Express

02 XDA Il Mini
Small, thin and pocketable
[=1 One-handed operation not
possible
Contact Creative e-biz
Phone 022-23828100
E-mail creative@goldkist.net
Price Rs 34,888

Contact Cyberstar

Phone 0-9323809599

E-mail navin@cyberstarindia.com
Price Rs 8,000

Price Rs 16,000

Nokia 6600
@ Brilliant display screen, Philips 109E5

Bluetooth ) Maximum resolution of
= No FM radio, slow processor 1920 x 1440

Contact Nokia India

Phone 011-26779000

E-mail Nokia.ebag@nokia.com
Price Rs 15,500

Reasonably priced

Contact Philips India

Phone 022-56912325

E-mail PCP.India.Info@philips.com
Price Rs 17,500
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LCD Monitors (15-inch)

CMV CT-522A

High contrast ratio—500:1

= Average quality inbuilt
speakers

Contact Cee Vision Technologies
Phone 022-26733353

E-mail chemoplastmumbai@vsnl.net
Price Rs 17,500

LCD Monitors (17-inch)
Samsung SyncMaster 173P
Great design, superb contrast
[=] Quite Expensive

Contact Samsung India

Phone 011-51511234

E-mail marketing@

samsungindia.com
Price Rs 32,000

CMV-CT-722A

Inexpensive

Good pixel response time of
16 ms

Contact Cee Vision Technologies

Phone 022-26733353

E-mail chemoplastmumbai@
vsnl.net

Price Rs 25,600

Laser Multifunction Devices
Samsung SCX-4216F
Fast, feature-rich and priced
sensibly
[= Slightly expensive
Contact Samsung India
Phone 011-51511234
E-mail vikram.negi@
samsungindia.com
Price Rs 34,999

HP LJ-3380
Prints 20 pages per minute,
fastest in its class

Contact Hewlett Packard India
Phone 1600-444-9999

E-mail seema.dawar@hp.com
Price Rs 46,999

Printers

Canon Pixma iP4000

Good features, excellent
performance
Contact Canon India
Phone 011-26806572
E-mail rajeev.singh@canon.co.in
Price Rs 11,000

x

HP Deskjet 1100D

Rugged, can take heavy
loads

[ Relatively slow
Contact Hewlett Packard India
Phone 1600-444-999
E-mail seema.dawar@hp.com
Price Rs 13,499

Heavy-duty Multifunction
Devices
Samsung SCX-5315F
Offers good features and good
performance
= Expensive
Contact Samsung India Electronics
Phone 011-51511234
E-mail vikram.negi@
samsungindia.com
Price Rs 64,995

Laptops

Acer TravelMate 4002

Very good battery life

Very fast data transfer over
wireless LAN

= Poor readability in sun light

Contact Acer India (Pvt) Ltd
Phone 080-25219520
E-mail raghu_s@acer.co.in
Price Rs 51,999

Xerox SCX-M15i

Good performance at a
reasonable price

= Bundled software not
appealing

Contact Xerox Modicorp
Phone 012-42561930
E-mail kuldeep.malhotra@

ind.xerox.com
Price Rs 56,599

Colour Laser Printers
Lexmark C510
Blazing fast at 24 pages per
minute
[=] Colours print dark
Contact Lexmark International
(India) Pvt. Ltd
Phone 022-26057755/45/44
E-mail sandeepk@lexmark.com
Price Rs 34,499
Web site www.lexmark.com

Samsung CLP500

Good overall speeds

= Printing quality not to
the mark

Contact Samsung Electronics

Phone 011-515-11234

E-mail farrukh_quazi@
samsungindia.com

Price Rs 38,999

MSI MegaBook M510C

® Terrific performance, typical
feature set

High screen resolution

=1 Average wireless LAN
performance
Contact Maxtone Electronics
Phone 022-23011434
E-mail maxtone@vsnl.com
Price Rs 65,990

Fujitsu S2020
Hot swappable combo drive
Good graphic performance
[=l Average screen readability in
sunlight
Contact Fujisan Technologies Pvt Ltd
Phone 022-56368718
E-mail gathani.paresh@
fujisan.co.in
Price Rs 80,000

Zenith Presidio Vu

Good battery life

Built in web cam and SD/MMC
card reader support

=1 No recovery CD provided

Contact Zenith Computers Ltd

Phone 022-28377300

E-mail kalpak_bhatt@
zenith-india.com

Price Rs 70,000
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“Gizmodo is an online review dedicated to gadgets, gizmos, and cutting-edge consumer

electronics,” says its home page. They are lying! It’s so much more...

Robert Sovereign-Smith

f you are a gadget freak, you have
probably already set www.
gizmodo.com as your homepage.
For the rest of us—those with the
normal level of lust for all things
geeky—here’s a look at how one site
can keep you updated with the latest
in the personalised technology world!

After you enter the address into
your browser, be prepared for a little
wait. The home page is a little heavy
with images, but it’s worth the wait.
Everything from the latest gadgets to
an exclusive “never-before” Bill Gates
interview with a Weblog, it’s all here.

The beauty of the reviews is that
the authors all seem to have a
decent sense of humour. If you have
even the slightest interest in tech-
nology, you will never yawn even
once when at this site—something
that’s rare amongst the drab
cacophony of the Web.

On the right of the page, you will
see a navigation panel that has cate-
gories such as Cellphones, Digital
Cameras, Gadgets, and so on. This
will help you jump straight to the
category that sets you drooling.

Not only do you get to view
product reviews, which of course is
the sites main purpose, but you
also get to read news of the latest
happenings in the gadget world.
If there’s a sneak-peek to be had

Qoire the Nojse |COC.CA vis Sollzonl-

Mare Goed Frem Gawker

Click to search jobs now

Q monscer
Rraag’s e ey

Though it takes a while to load on a dial-up, Gizmodo.com is worth the wait!

of a gadget, this is where you’ll
hear about it.

One thing you have to check out is
the “Deals” link, http:/fwww.
gizmodo.com/gadgets/deals|. Here,
Gizmodo gives you news of the latest
offers being made on sites across the
world. Though this is mostly US-
centric, most of us will not have a
problem—everyone has an aunt,
uncle, cousin, aunt’s uncle’s cousin,
etc, in the US, who can bring it with
them when they come down. At last
visit, there were offers of a free N-
Gage QD, $100 (Rs 4,350) discount on

U2 iPods, a steal of a deal for Podwave
speakers for your iPod, and more.

Of course every gadget is only as
good as the software that powers it!
So, Gizmodo provides you with a soft-
ware section for the latest and great-
est software applications and
operating systems for your toys. Just
log on to the Software section
(http://www.gizmodo.com/gadgets/
software/) to find out why the experts
believe that Google is going to launch
VolIP services, or just to read about
the 10 most bizarre applications ever
developed for the Palm 0S.

All  in all,

Powerhouss

I WY, e

If there’s a sneak-peek or news about a new gadget, this is
the place to look!

—

Py Vet YOUo fake thissurveyt ]

Ehype Rusitey

Googe Launching VoIP service (Mayt- )

The latest news and reviews of the software that
power your gadgets

Gizmodo offers you
great in-depth
knowledge of the
latest hardware and
software—you will
not feel clueless the
next time your
buddies have a three
hour conversation
on the pros and cons
of the specifications
of the upcoming HP

o EEER L wes00 iPag

Mobile Messenger.
Of course, you
could just sign up for
a newsletter, cour-
tesy Wired maga-
zine’s GadgetLab,
but the site is a
better experience.®
robert_smith@
thinkdigit.com
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Having a prepaid
cell phone card
has its
advantages but
recharging it by
buying a
voucher
periodically is
not one of them.
For people like
me who often
forget, it can be
a nightmare to
suddenly be
unable to ‘stay
connected’.
With this
determination, I
set out to figure
out a better way
to recharge my
cell phone

Topping Up Your Prepaid Card

Aditya Kuber (aditya_kuber@thinkdigit.com)

3
; ode # and press &k
14 digit recharge ¢ te.
*123 tnl!m'ﬂ"i‘l E:guuleﬁzs‘“ at 555 on your mobi
2 yont misuse.
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A =100#
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00016
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>Topping up the Old Way

Topping up the E-Way!

Dialling the ‘Balance Inquiry’ number informed
me that there was just about Rs 3 left in my card
and that would hardly allow me to make one call.
Time to head for the corner store

Time taken 5 minutes

Thankfully, the service I use gives me a balance
report after every call I make. So I know when I
need to top up my card. This was one such time!

Time taken O minutes

There's a lot of choice available in the amount to
choose to recharge and the higher the value of the
voucher, the more talktime you get. After a quick
look at my options, I chose for the Rs 400 voucher
gave me about Rs 225 worth of talktime.

Time taken 10 minutes

I realised I would need at least Rs 300 to get any
value for the recharge and my choice, for long,
has been the Rs 400 recharge voucher that offers
nearly Rs 225 in talktime. So I headed to the near-
est ATM to recharge my wallet and my phone!

Time taken 10 minutes

Handing over the cash, I pulled out the voucher
and scratched the code hidden behind the strip on
the card and punched it into my phone. Then, I
sent it as an SMS to the service provider and my
account was topped up.

Time taken 15 minutes

Once at the ATM, I had to wait my turn. Soon
enough, I slid in my card, put in the details and
chose the prepaid recharge option. I entered the
recharge value I wanted and that’s that! I'm done!

Time taken 15 minutes

A quick check on the balance inquiry and I knew
the account had been topped up. Who should I
call?

I received an SMS confirming the recharge and a
subsequent check rid me of any further doubts!

DIGIT MARCH 2005

Total Time Taken: 30 minutes
Total Cost: Rs 400

)

Total Time Taken: 25 minutes
Total Cost: Rs 400

=)

he tech way wins but only narrowly. While costs
incurred are the same, shorter queues at the
ATM or the shop could change the equation. One
thing that tilts the equation in favour of the tech
way, is the fact that you know where your ATM is

while you might have to look around a while for a
shop and pray he has the voucher in the
denomination of your choice. No such hassles with
the ATM. In the end, it's about convenience and
using either mode could be just as easy or difficult!
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Your Questions, Our Answers

Multiple Modems?

I have a PC with Windows 98 and XP
installed, and I am using an Intel Pentium 4
1.7 GHz. I want to increase the speed of my

install Norton AntiVirus to correct the problem.
Press any key to continue.”
R C Behera

This is a keyboard driver problem. There
are two ways to solve this. You can either
update the drivers for the DriTek multimedia
Hotkeys from http://snipurl.com/cuk4
Or, you can completely remove the Hotkeys
from your Startup. To do this, go to Start>Run.
Type in “msconfig” and click OK. In the window
that opens up, click on the ‘Startup’ tab. Clear
the checkbox next to ‘cpatrl0’. Click OK. Now
restart your machine—it should work fine.

Duplicate DLLs

1 often get the following error message:
“Error Number: 0x8007025

Internet connection. Can | use two modem
cards for increasing the bandwidth with a
single phone line?

Manu

You cannot increase bandwidth with

a single phone line using two
modems. You need to get a second phone
line, or migrate to broadband—'broad-
band’ prices are falling by the day. If you

Got a Hard Disc
Drive Emergency

*

Call 160033 11 04

get another phone line, then you can
download a software called MidPoint
Teamer from http://snipurl. com/cujv

HOT keys!

Seagate @

Incompatible version of the RPC stub

How can | correct this? Also, your
December 2004 Digit CD works at first and
after some time, when I click a link to install
something, it does not work properly. It
opens IE6 and nothing happens after that.
My system details are: Intel 845g chipset, a
Pentium 1.6 step2 processor, Windows 98,
128 MB of RAM, and a 40 GB HDD.

G Gurumoorthi

ﬁ Setup will now terminate.”

This happens when, while installing
a program, you get duplicate copies

of the Oleaut32.dll, Olepro32.dll,

We have Windows 98 SE and Windows XP Pro

in the Cand D drives respectively on a Pentium
4 1.7 GHz. First, XP only works in the ‘Last known
good configuration’ mode, and not in Safe or
Normal modes, after repeated reboots and normal
boots. When it boots in Normal or Safe mode, after
some time, the screen goes black showing some
junk characters on the screen, and a countdown
timer at the end of the screen which counts up to
100, after which the computer reboots.

In ‘Last known good configuration’ mode, the
computer starts and works fine, but initially
shows a message in an alert box:
“\\.\DRI_KBFilter
The system cannot find the file specified.”
Second, when we run setup again to correct the
problem with Win98 SE, setup proceeds just
beyond ‘Detecting hardware’ and reboots. After
that, Win98 SE does not boot and shows the
following message—

“Error: NAV AutoProtect is unable to start!
SYMEVNT.386 is not loaded. You may need to re-

= System Configuration Utility
General  SYSTEM.INI  WIM.INI  BOOT.IMI EWCES_ Stertup L

Comenand Location

RUNDLLI2.EXE C:...

] ATI CATALYST Sys... C\PROGRA~IVA...
] Adobe Gamma Loader CAPROGRA~1IC. .,
=

HKLM\SOF TWARE|Micresaft\Windows\Currenther, ..

[ | atiphacix CiProgram Fiesl,..  HELM|SOFTWARE Microsoftywindows|Current Ver, ..
O cpatrtn | C\Program Files),..  HKLMSOF TWAREWMicrosoftywindows|Current ver. .
Cai “CiProgram Filesl...  HELMYSOFTWAREIMicrosoftywindows| Current Yer ...
] MsgPhus *Ci\Program Fies)...  HKUM{SOFTWAREMicrosaftiWindaws|CurrentVer...
[ Werothedk CAWINDOWS1sys...  HKLMUSOFTWAREMicrosoftiWindowsiCurrent Yer...
] MsgPhss “CiiProgram Flesl...  HKCULSOFTWARE|Microsoft\windowsCurrantiisr, .,

[t

Remove Hotkeys From Startup

Fpa’(ﬂ U)
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Asycfilt.dll, and Stdole2.tlb files, which
creates an incompatible environment. If Office
2000 or an Office 2000 component is installed
on your computer, obtain and install the Office
2000 Service Release 1a (SR-1a) from
http://snipurl.com/cuké

If Office 2000 or any of its components are
not installed, then obtain and install the ‘mcre-
pair.exe’ tool from http://snipurl.com/loua

Restart your computer and everything
should work fine.

My PC Lies About RAM!

I am using a Pentium 4 2 GHz. When | start

the computer it shows “Main Processor:
Intel Pentium (R) 4 2.00 GHz (100 X 20.0)”.
However, when | go to the DirectX diagnostic
tool (Start>Programs>Accessories>System
Tools>System Information>Tools>DirectX diag-
nostic  tool), the following system
information is displayed:

“Operating System: Windows 98 (4.10, Build 2222) A
Language: English (Regional Setting: English)
Processor: Intel Pentium Il

Memory: 224MB RAM

Page File: 115MB used, 1708MB available

DirectX Version: DirectX 6.1a (4.06.03.0518)

DxDiag Version: 4.06.03.0518”

Why is this so, and why does the RAM show up as
224 MB instead of 256 MB ?
Prashant Chordiya




Q A

The version of DirectX you are using is

outdated. Upgrade to DirectX 8 or later,
and your problem should be solved. The RAM
is ‘missing’ because you have a 32 MB shared
memory graphics adapter onboard. This is
the memory that the system reserves to show
you the display on the screen and also during
playing games. If you do not play too many
games then you can reduce the size of this
from the BIOS.

PhotoStop!

My machine hangs when | use Photoshop

6.00 or 7.00 for a few minutes. My machine
configuration is: an Intel Pentium 4 2 GHz, 256
MB RAM, an 80 GB HDD with four partitions of
20 GB each, and Windows 98. In the virtual
memory settings, | have selected ‘Let

system cabinet? If so, can you please tell me about
a cabinet—a good and economical one—suitable
for this motherboard?

Vishwanath

It need not be just the cabinet. It is possible

that your CPU fan is not up to the mark. Get
that checked and if required, change it to an
Intel certified fan. Make sure your cabinet is
properly ventilated. You could add an additional
fan for more ventilation. Make sure the cables
inside are neatly tied up, as that increases air
flow and leads to more efficient cooling. If your
cabinet is too small and the components are
getting cluttered inside, then you could look at
upgrading your cabinet to one from brands such
as Antec or Odyssey. Antec cabinets could be
slightly expensive, but getting one would rid
you of your overheating blues!

Windows manage my virtual memory
settings’. 1 have changed the ‘Memory
and Image cache’ setting in Photoshop
this way:

Cache levels: 4

RAM maximum used by Photoshop: 55%
Plug-ins and Scratch Disks:

First: Startup

Second: C:\

Third: D:\

Need
Hard Disc Drives

info on

=

Call 1600 33 11 04

'ﬂ Sasser Strikes Back!

I have dual-booted my PC with
Windows 98 and XP. Whenever |
connect to the Internet in XP, I get the
message ‘LSA encountered problem’, and
my PC restarts. There is no such problem

with Windows 98. What do I do?
Via e-mail

Fourth: None
History states: 20

When using Photoshop | always keep
WinAmp and all other software closed,
and also try to keep a maximum of two or

Seagate @

You have the Sasser worm or one of
its variants. Simply download the
following files from another computer

and run them on your system. Stinger,

three files opened at a time in Photoshop.
In spite of that, when | use Photoshop for 10 to
15 minutes, my machine hangs. | also used
Windows 2000, but the problem persisted.
Please help!

Prashant

This is most likely an overheating problem.
It is possible that your CPU fan or heat sink
is malfunctioning. To keep a check on the
temperatures, you can download a free utility
called Motherboard Monitor, which will moni-
tor your CPU temperature, fan speed and so on.
You can set up alarms if the temperature
exceeds the desired levels. You can download
this from http://snipurl.com/cujz
We also recommend that you get your
system checked for the heating problem by a
qualified technician, and if required, replace
the CPU fan with an Intel certified fan.

It’s Hot In Here

| have a D915GAV motherboard with an Intel

Pentium 3.0C GHz processor, 512 MB of DDR
RAM and an 80 GB SATA HDD. | use a KOB-115 cabi-
net with a 250 W power supply. My system heats
up quickly—within an hour from the time it starts,
and the Intel Active monitor pops up windows
alerting me of the temperature. Normally when |
start the system | check the temperature using the
Intel Active monitor, and it shows the processor
temperature as 58 degrees Celsius and system
zone 1 and 2 as 42 degrees Celsius. After an hour,
these temperatures rise. Should I change the

which can be found at the McAfee Web
site, will find and repair this problem.
Download it from here:
http://snipurl.com/1syv
Now, at the following page:
http://snipurl.com/cuk0

Scroll down to where it says ‘Download the
841720 package now’. Download and run it.
This should fix your problem. If, however, you

Remote Shutdown Dialog

Add...

Remove

Browse... |

Warm users of the action
Display waming for

[20) Second:

Shutdown Event Tracker

Select the option that best describes why you want to
shutdown the computers
Option: ¥ Planned

[Other Planned) =

A shutdown or restart for an unknown reason

Comment

The Remote Shutdown Dialog Box
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Create A VCD Out Of Your Digital Photos

You always wanted to view a slideshow of your images on your big screen TV, but didn’t
know how to do it. Here’s the lowdown

t some time, we have all been
Astranded because the people we
wanted to share our digital photos
with don’t have a PC and making prints from
digital photos is just too expensive. But with
changes in technology, it is actually quite
simple to create a VCD of your favourite
photos and view them on a VCD player.
Before you start sending invites for the
premiere, though, here are few things to do...

You will need software called
photo2VCD. The trial version of this
software can be downloaded from

www.photo2vcd.com. You will also need a
CD Writer to burn your final product on and a
blank CD. And most importantly, you will
need lots of digital photos! These obviously
need to be on your PC.

Getting Started
STEP Download and install the trial version
of the latest Photo2VCD Studio 3.0.
On start, you will have the ubiquitous
pop-up wizard which will pretty much beg you
to help it create the VCD for you. Follow the
simple steps and you should do fine. If you are
a little more adventurous, click ‘Cancel’ and
let’s get our hands dirty!
The interface is really slick, albeit a little
slow. It is divided into two panes like the

ST ——
¢ mCTwen and mel Dfser cofines. OBk e

The Photo2vcd wizard

Windows Explorer. In the left pane, you can
select your slideshows; each of these will be
played as a single movie.

Once you have added photos to your

album, (you can also add multiple slideshows
by clicking the button on the bottom left,
labelled ‘Add Slideshow’), you will need to
arrange the photographs in the order you
would like to show them. For this purpose,
basic buttons such as Renaming, Removing and
Rearranging a slideshow have been provided.

Adding Effects
STEP Now that you are done adding

photos, let us add some effects to

your transitions! To do this, click
on the ‘Options’ button on top and you get a
window, next to the ‘Basic’ tab that lets you
choose between VCD, SVCD and DVD tabs
for TV format (NTSC/PAL). If you are
confused about this, just select your country
and it will choose the right format. Effects,
audio options and some other options are
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The configuration window

found under the ‘Options’ tab.

The default ‘Effect’ tab will let you
apply two kinds of effects: one to the photo
itself and the other to the transition of one
photo to another. It will also let you set the
duration the photo is displayed for, the
duration of the effect and has, of course, a
huge list of effects to choose from.

The default ‘Effect’ tab also has a neat
feature that lets you preview the various
effects before you actually apply them. It
uses a preset image which morphs into
another image using the effect settings
which you choose.

Add Background Music
STEP On the right, there are two more

tabs. One that lets you add the

photos or videos, while the second
tab lets you can add custom background
music. In order to do this, simply select the
button with the musical note icon and select
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You can use MP3 and WAV files here

all the files you want. You also have the
option of fading in/out and normalising the
volume of your music files.

Burn It!

STEP Once you have configured the back-
ground music and photos and the
various effects to your satisfaction,

just hit the ‘Burn’ button on the top right and
go make yourself some coffee and sand-
wiches and start sending the invites, for the
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The main window

Preview your effects

Burn your photos!

software takes some time to encode it to the
VCD format and then of course, it needs to
actually burn the CD.

Once it says ‘Done’, take your VCD
out and pop it into any—old or new, cheap
or expensive—VCD player and get nostalgic
with those memories!

The trial version will add a stamp
across your photos displaying the website
name. If you do not want this, you could just
buy the software for about $39.95 or
approximately Rs 1,800.

DIGIT MARCH 2005




82

Q A

MS DOS Error In XP

My machine’s configuration is: a Pentium 4 2.4 GHz, an

Intel 865GBF original motherboard, 256 MB of DDR 400
Zion RAM, a 40 GB Samsung HDD (7,200 rpm). | am using
Windows XP professional with FAT32. Other software
on my machine include Office 2000, Norton AntiVirus
2005, AutoCAD 2000 and AutoCAD 2004.

Everything was fine, and one fine morning |
received a peculiar error, in the screen alongside. |
cannot find any solution for it and it is not possible for
me to format and reload XP because there is a huge
amount of data in there.

Bishwajit Laha

First try re-installing the MS-DOS based application

that causes this error: Go to Start>Run. In the Open
box, type in “cmd”, and click OK. At the command prompt,
type in the following commands, pressing [ENTER] after

expand CD-ROM Drive Letter:\i386\config.nt_
c:\windows\system32\config.nt
expand CD-ROM Drive Letter:\i386\autoexec.nt_
c:\windows\system32\autoexec.nt
expand CD-ROM Drive Letter:\i386\command.co_
c:\windows\system32\command.com
exit
Now try re-installing the program.
If that does not fix it then start Notepad. In Notepad,
type in:
dos=high, umb
device=%SYSTEMROOT%\system32\himem.sys
files = 40
Save the file with the name ‘Config.nt’.
Now again open a blank document in Notepad and
type in the following entries:
@echo off
1h %SYSTEMROOT%\system32\mscdexnt.exe
1h %SYSTEMROOT%\system32\redir

each command:

CWWENDCAW S SYSTEMEZ|AUTOENECNT. The sysbemm fils & rot suibable foe running M5-D0S and Miorosoft Windows
appications. Chaose ‘Jose’ bo terminate the application,

]

16 bit Windows Subsystem ) |
‘Config.nt’ file, and copy it to the %SYSTEMROOT%\
System32 folder.

and restart your computer. This should fix your problem.

1h %SYSTEMROOT%\system32\dosx
SET BLASTER=A220 I5 D1 P330 T3
Save the file as ‘Autoexec.nt’. Now locate the

Do the same with Autoexec.nt and command.com,

do not have access to another computer, follow
these steps: Go to Start>Run, and in the box type
in “cmd”. In the DOS prompt that appears, type
in “shutdown —i”. Make sure to enter a space
between ‘shutdown’ and the hyphen. Press
[ENTER|. The Shutdown Settings window

Upgrade, Upgrade, Upgrade!

| have a Compaq Presario 3600m machine
with a Pentium 4, 1.5 GHz processor, 128 MB

of SDRAM, and an nVidia Vanta graphics card with
16 MB of memory. My problem is, of late, no

will appear. In the first box, click Add, and

games seem to work on my PC. The error

type in your computer’s name (To find out
your computer’s name, right click on My
Computer and click on the tab that says
‘Computer Name’). Beneath, in the box
that says ‘20’ (seconds), type in ‘9999’. In
the box beneath that, which says
‘Comment’, type in anything and click
OK. This will increase your time on the
Internet to 2.45 hours. You can then

Getting started with
your Hard Disc Drive

Call 1600 33 11 04

r.y messages mainly show that my hardware
n does not support my games. Max Payne 2
was the last game that worked fine. After
that, whether it is NFS Underground, Doom
or FIFA 2005, it does not work. Will I have to
buy a new computer, a new processor, or a
new graphics card?
Anjan Jyoti Bora

connect to the sites listed above and
download the tools to clean your system.

“pixel Shader”?

Seagate |

The problem lies mainly with your

RAM and your graphics card. You
have not mentioned what motherboard
you are using, but we think it will not
support DDR RAM. The best solution

I have an Intel 2.4 GHz P4 CPU with 256
MB of RAM and a GeForce4 128 MB. While play-
ing Splinter Cell: Pandora Tomorrow, my machine
gives an error: “Inadequate pixel shader support.”
Also, in 3D Mark Pro, it gives a Direct3D error with a
‘pixel shader’ problem. How can I play the game?

Your graphics cgrd does.not support pixel

shader—a graphics function that calculates
effects on a per-pixel basis, giving ambience
and a look of realism to the displayed image.
You would need to upgrade it to at least a
GeForce4 Ti card. If you are upgrading, go for a
higher-end card, say the GeForce FX5950. If you
are looking for a slightly cheaper card, try the
GeForce FX 5200 or the FX 5700, or the 9600
Series from ATi.

Avik sos@jasubhai.com

E-mail us your
computing problems
along with your contact
details, and we may
answer them here! Since
we get more mails per
day than we can handle,
it may take some time
for your query to be
answered. Rest assured,
we are listening!

would be to go for a complete overhaul
of your system, wherein you upgrade to a P4
2.4 or 2.8 with at least 256 MB of DDR 400 RAM,
and a decent 64 MB graphics card, say a
GeForce 5700 Ultra. That should let you play all
the latest games at fairly decent settings. For a
full comparison and specification, check out
the graphics cards shootout in the January
2005 issue of Digit.

If you do not want to go in for a complete
overhaul, you could go in for a GeForce4 Ti
card, which should let you play quite a few of
these games at the minimum settings. Make
sure to check what AGP slot your mother-
board supports—8x or 4x. 8x is backward
compatible with 4x, but there is no point in
buying an 8x card if you cannot use it to its
full potential. ®
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Agent 001

Back to the Basics:

Back To The Basics

You use a keyboard and a mouse all the time—it makes sense to get your hands on a good set

y next-door neighbour just bought a Lok at as it is to believe, IBM and Dell keyboards are
Mspanking new multimedia PC and ergonomic key- also available, and are sold in the Rs 600 to Rs
thinks he has the perfect reason to look boards if vou do 700 range. I tried my hands on one IBM key-
down upon me. Well, actually it’s just the cord- y board and it was quite good.

less keyboard and mouse that are better than a |0t of typing

what I have. However, his scorn was exactly and value your MULTIMEDIA Basics
what got me looking out for a new \rjst; after all, If the new multimedia range of keyboards with
keyboard and mouse. keyboards can be plenty of keys thrown around is something

Unlike components such as monitors, | d but you're looking forward to, don’t worry, there
which are installed once and are seldom !€Placedbu , are plenty of them. They start from as low as Rs
touched except during cleaning sessions, key- YOUr hands can’t! 900 and go up to Rs 2,500. iBest has some real

boards are subjected to harsh treatment day in snazzy models to choose from, but remember
and day out. They therefore simply have to be that multimedia keyboards require the proper
sturdy. Mechanical keyboards of yesteryear drivers to work correctly.
were a different breed; today, almost all key- On the mouse front, you can settle for a
boards use a membrane with a rated life of a decent optical mouse for Rs 500; entry-level mice
maximum of five years. But remember that from Logitech and Microsoft fit the bill. If you
your usage should determine what device you are always on the Internet, I say you should go
buy, not the technology the device uses. for a five-button mouse; the Back and Forward
So, as usual, off I set to Lamington Road in buttons are great, and will get you hooked. Mice
Mumbai. Enquiring in a few small shops, I was with five buttons are available in the range of Rs
greeted with just one question—corded or cord- 1,200 to 1,500, with Logitech’s and Microsoft’s
less? It does seem that cordless desktops have devices standing out from the crowd.
gripped the imagination of most people, and Touch-typists demanding firm key feedback
are moving quickly off the shelves. Personally, I should look for the TVSE Gold keyboard, proba-

am not in favour of cordless devices: first, due
to their high running cost—they require batter-
ies to run—and secondly, I can’t imagine peo-
ple sitting a mile away from a PC and
working.

However, if you want a clutter-free
desktop, cordless is what you should
go for. Alternatively, you can go in for
a combination of a cordless mouse
and a corded keyboard, since key-
boards are hardly moved around. With
a mouse, though, the cord can be a

~ bly the only mechanical keyboard on the
market. Gamers could also look forward
to this keyboard for the ruggedness over
membrane-based keyboards, which give
away early when stressed. Gamers who
need that extra precision when it
comes to mice should look no further
than the MX series of mice from
Logitech. You can go in for the MX-510
corded mouse, which will set you back by
Rs 3,750. If you want a mouse with loads
of features—such as horizontal scroll

limiting factor. - and pin point accuracy—look to
( Logitech’s laser mouse, the Mx-1000.
Basics For ALL % ! This one costs Rs 5,500!
The cheapest keyboard \ [

and mouse that you \ Do You TypE A Lot?
can probably buy cost \ \ If your job involves a lot of typing—like
around Rs 150 each; how- "1 ) in the case of writers, editors, and
ever, don’t expect them to \_4 data entry personnel—I would recom-
last too long. More often then mend a look at ergonomic keyboards. I
not, you will be lured into buying have used Microsoft’s Natural multimedia
such low-cost devices, but my advice is, steer keyboard and can say it offers good comfort,
clear of them. However, if you own a cyber- but at a price: it retails for Rs 2,350. Buy it if you
café, you might want to look at these. If they value your wrist; after all, keyboards can be
don’t suit your taste, you can hunt for devices replaced but your hands can’t!
in the Rs 250-300 bracket. Logitech, Samsung, I finally settled for Microsoft’s Internet key-
iBest, Adcom and others have some decent board and a Logitech five-button optical mouse,
products in this range. all for under Rs 2,500—the best of both worlds!
For our general users who get their PCs
assembled, I would recommend the new
Logitech Easy keyboard Deluxe, which retails at
Rs 500, or Microsoft’s Internet keyboard. Hard

Want more of Agent 001? Turn over to read his
answers to your buying questions

Illustration Shyam Shriram

DIGIT MARCH 2005

85



86

Digital Tools | Ask Agent 001

Style Computing

I want to buy a stylish, sturdy and thin laptop
weighing no more than 2.5 Kg, preferably from a
reputed brand. The configuration should be as fol-
lows: an Intel Pentium M processor (top end), 512 MB
of RAM, a 40 GB hard disk, a combo drive, 15-inch
widescreen, and the necessary ports. Connectivity
options should include Bluetooth. Software inclusion

does not matter.
Peeyush Paani

%@y My personal favourite is the IBM

“—= Thinkpad T-series of laptops; they are
light, extremely sturdy and conservatively styled.
You may want to look at the T42 model; it comes
with everything you want. However, mind that
IBM charges quite a premium for these products,
and they are usually in the Rs 85,000+ range. IBM
allows you to tailor the hardware configuration
and hence, depending on the hardware, the ver-
sion and price increases or decreases. For models
from other vendors, refer to the laptop compari-
son test in this issue.

I Can’t Find It

| wanted to purchase an Archos Gmini or

Samsung Media Centre portable video player,

but was unable to find a retailer in India. Could

you guide me to where | can get it from? Also, |

would like to get a GeForce 6800 Ultra Extreme
graphics card.

Satyajit Patnaik

C"ﬁ, We're sorry to say this, but the Archos

= Gmini is not sold in India through autho-
rised channels. However, you might find it in
shopping centres selling foreign goods, but after-
sales service might be a problem. MSI has appar-
ently introduced a similar product in the Indian
market—the MSI MegaView 561. This little device
plays MPEG4 video and MP3s; you can store data
on it too. It retails for around Rs 27,000.

You could contact Cyberstar India on 0-
9323809599, or Tirupati Enterprises: O-
98310022600. For a GeForce 6800 Ultra card, you
could call the same companies and for the MSI
MegaView 561, or you can try Rashi Peripherals
at 022-56290785 for Asus or XFX cards.

Flipping On Colour

I want to buy a mobile phone that looks

great, has good features, is durable and does

not cost more than Rs 5,000. Also, if possible, I

would like a flip-style mobile phone. Can you sug-

gest somewhere to look for second-hand mobile
phones, possibly a Web site?

Arnav

C"ﬁ",, There are two models I would recom-

“~=mend you look at: the Sony Ericsson
72200 and the Nokia 2650. They are equally
good; I would go for the smart looking Z200,
though. Of course, if you are a Nokia fan, you
would want to look at the 2650. It is pretty
much like the other lower-end colour phones
from Nokia.

Ask Agent 001

You can procure
a digicam from
either the official
channels or the
grey market—the
latter offers the
same cameras for
much less, but
without a
warranty

Ask Away

Want a tech product, but
don’t know how to go
about buying it? Send an
e-mail to
agent001@thinkdigit.com
to get your queries
answered

The Right Mix

| want to upgrade my PC and am thinking of
buying an AMD-based system. | want you to
help me choose the right motherboard and proces-
sor combo. The motherboard should have on-board
sound and no graphics. Also, it should support a

PCle graphics card.
Shravet

1 "3 Please refer to the February 2005 issue
=== of Digit for a complete solution regard-
ing AMD processors and motherboards. For a
mid-range solution, there are just two
chipsets—one from ATi and the other from
nVidia—that support PCle on the AMD plat-
form. Motherboards based on nVidia’s nForce4
chipset are yet to make it to the Indian market.
MSI has launched a motherboard based on
ATi’s Express 200 chipset, and is available as
RS480. These motherboards take 939-pin AMD
processors, which are slightly more expensive
than their 754-pin counterparts. You can con-
tact Cyberstar India at 0-9323809599 or
Tirupati Enterprises at 0-98310022600.

Swearing By Sony Ericsson

I am interested in the Sony Ericsson P910i and
S700i cell phones. Can you please tell me how
much these phones cost and which one will be best

suited to me?
A Reader

C “g5) Since you have not provided details
=== about your usage patterns, saying which
one is bestsuited to you is a difficult job.
However, I will highlight the general usage pro-
files of both these phones. The P910i is a PDA-
phone—you can use it as a PDA and as a phone
as well. The target audience for the P910i is
executives who have to juggle between a phone
and PDA. The S700i is a media-centric phone
where the digital camera, video recording,
music playing capabilities, etc. are stressed
upon. As you can see, there is a clear demarca-
tion when it comes to the usability of both
these phones.
The Sony Ericsson P910 would set you back
by around Rs 40,000, whereas the S700i should
cost around Rs 30,000.

A Basic Digicam

I want to buy a digital camera with decent fea-
tures priced not more than Rs 10,000.
Rajagopalan M R

I %ay You can procure a digicam from either

=== the official channels or the grey market—
the latter offers the same cameras for much less,
but without a warranty. Look for Nikon’s 3100 or
4300 models. Both are good, and should be avail-
able in the grey market at a comfortable price.
However, if you value warranties and support,
then at Rs 10,000, there are few good digicams I
can recommend. Even so, have a look at Kodak’s
CX4XXX series: they are priced at around Rs
10,000 and deliver fairly good results. &
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Case Study

No-Strings-Attached
Hospitality

Hotel Golconda in Hyderabad has deployed wireless LAN across five floors. Find out why Wi-Fi is the new
buzzword in the hospitality industry

Meera Vankipuram

ith information technology changing
W the face of corporate India, it was only
a matter of time before this had an
impact on other businesses. Cities in IT hubs

of the country are
facing a new chal-
lenge—catering to the
tech savvy clients. Even
hotels are not spared
of the ever-changing
needs of this fraternity.
Perhaps, they could
take a leaf out of Hotel
Golconda’s book and
create a haven for the
tech-enabled traveller.

“Thanks to IT, the
face of Hyderabad has
changed in the past
decade. Today, the hospi-
tality industry in partic-
ular, is catering to a new
segment—IT and Biotech
professionals—who
demand certain services
and use those facilities
actively,” says Suresh
Reddy, executive director,
Hotel Golconda.

Located in the heart
of Hyderabad, Hotel
Golconda, which falls
into the three-star cate-
gory, recently installed
a Wireless LAN on their
premises. This wireless
“hotspot” has been

Location Courtesy CenterOne, Vashi
Photographs Jiten Gandhi
Imaging Binesh Sreedharan

deployed across five floors (and two more
would be networked soon with six additional
access points). Guests can now access the
Internet from anywhere in the hotel at an addi-
tional charge of Rs 200 per day.

Internet access being a
prerequisite for almost all
business travellers, Wi-Fi
enabled hotels have
become more the norm
than the exception. In
India, deployment of
Wireless LANs has largely
been restricted to four-
and five-star hotels (about
200 such hotels in India
are Wi-Fi enabled).

Wi-Fi Central
Golconda, which derives
its name from the majestic
fort located on the out-
skirts of Hyderabad, is
nearly 15-years-old, and
has a capacity of 150
rooms. Says Reddy: “The
hotel was inaugurated in
August 1989 and has been
renovated since. About a
year-and-half ago, we were
one of the first hotels in
Hyderabad to offer Wi-Fi
connectivity to our cus-
tomers. The response has
been excellent.”

To set up the Wireless
LAN, Cisco Aironet 1100-
series Access Points were
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Location Courtesy A K Hafizka Institute of Hotel

Management & Catering Technology

deployed across five floors. The

hotel also invested in five 350-series Access
Cards (to be rented out to guests) which, when
fitted into the laptop, would enable Internet
access. Apart from the rooms, Wi-Fi connec-
tivity is also available at the business and con-
vention centres and at the restaurants. “At our
business centre, we provide computers and
broadband access to clients who don’t carry lap-
tops,” says Reddy.

Reddy says that the LAN has been optimised to
ensure high speeds and seamless connectivity
within the premises and to minimise channel
interference. Interactive TV, video-on-demand and
video streaming services are on the cards.

‘Broadband Is The Key’
Wireless networking enables sharing an
Internet connection across a Local Area Net-

M Test your Wi-Q!

(a) Wi-Fi is an acronym for ____ ,a @M-Fiﬁu[ﬁpu[l_is[,cum_

widely accepted set of standards for T st
Wireless Local Area Networks (WLAN).

The standards pertaining to range of
Internet access and transfer speeds. eleelyriy b
(b) According to Jiwire.com, there are more

than Wi-Fi hotspots around the
globe.
(c) Q3, 2004, saw lead wireless

LAN sales worldwide, with nearly 43 per
cent market share, according to Synergy
Research. Symbol Technologies (15.9 per
cent) and Airespace (bought over by Cisco recently) with 5.7 per cent, grabbed
second and third places respectively.

(d) Wi-Fi access points or ‘Hot Spots’ usually have a range of __ to __ feet.
Laptop owners require a wireless network interface card (PCMCIA Card) to
connect to the Internet.

(e) Business travellers can find wireless access points across the globe using the
online services dubbed

51038207 30dS10H (3) 0OE ‘00T (P) ‘SWIISAS 03s1D (3) ‘000 ‘0§ (4) ‘AMapI4 SSB[RIIM ()
SJomsuy
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work (LAN), without using
cables or drilling holes to
insert network cables.

Wireless LANs (WLANSs) are
popular in office environ-
ments, where laptop/notebook
users can stay connected all the
time, even while on the move
within the premises—
especially in places where a net-
work cord may not be available.

While WLAN deployment

was an expensive option a few
years ago, today WLANs are
being viewed as viable alterna-
tives to cable-based LANs. WLANs
are being installed in homes and
SoHo environments as well.

In India and abroad, WLANSs
are extremely popular in offices
(Enterprise and SMB), ware-
houses, hospitals, educational
and professional training insti-
tutes, airports, and of course, the
hospitality industry.

“Enabling connectivity is an
integral part of customer service, especially in
the hospitality industry. It’s no longer a perk,
but a necessity,” says Varghese M Thomas,
Senior Manager, Corporate Communication,
Cisco Systems (India and SAARC).

Cisco’s offerings in the Indian Wireless
market include Linksys systems for the SoHo
segment and the Cisco Aironet solutions for the
Enterprise segment.

“Not just hotels, but in cities such as
Bangalore, Wi-Fi access is available even in
studio-houses which are being rented out to
business travellers or IT professionals on the
move,” says Thomas.

There is great potential in India for wireless
connectivity, but increased broadband prolifer-
ation is the key to its success. Hardware is still
expensive here in India, and people need to
know that broadband can be used for a lot more
than faster data transfer.

“Most business transactions take place
online now, and if we have to keep pace with
international deals, Small and Medium compa-
nies must consider investing heavily in broad-
band,” adds Thomas.

Early last year, the city of Philadelphia in
the US, launched a massive initiative to set up
the world’s largest wireless hot spot spread
over 135 square miles of city-space. Placing
small transmitters around the city, which
could communicate with wireless networking
cards, the network would enable citizens to
access broadband Internet connection from
practically anywhere in the city, free or for a
minimum charge.

While Wi-Fi-enabled cities are a distant
dream in India, wireless LANs are helping
the Indian hospitality industry match its
counterparts abroad.

The race to capture the business travellers
mindshare has gone high-tech... will WiMAX be
the next trump card? ®
meera _vankipuram@thinkdigit.com
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~Anywhere

You Roam

A tale of laptops and PDA-phones: we tell you the best means to take your data and walk!

Aliasgar Pardawala, Jayesh
Limaye and Sanket Naik

here is something to

be said about a world

that expects you to

carry your work with

you, wherever you may
be, whenever. As a digitally
connected society, we are
programmed to take blurred
timelines, back-breaking roads,
jetlag and virtual meetings in our
stride, and sally forth to bring
back that winning deal. While it
is tempting to take a philosophi-
cal look at this state wherein “no
time to stand and stare” is an
accepted reality, such meander-
ings are best left to others.

DIGIT MARCH 2005

So while the Deepak Chopras
of the world address those issues
through easily available paper-
backs (perhaps as e-books read-
able on your PDA), we shall accept
the status quo and make the best
of it. We will, therefore, take a
look at the best means of staying
mobile with your precious data.

With mobility on our mind,
our focus will be on two
consumer devices—laptops and
PDA-phones.

Did Someone Say

Status Quo?

An interesting and recent devel-
opment has been the prolifera-
tion of laptops in business houses,
and to a lesser degree, within
homes. These portable PCs are

currently powerful enough to
carry out the most common
tasks—writing and  staying
connected with peers and loved
ones, while offering the necessary
digital entertainment via movies
and songs. The most important
criterion here is, of course, porta-
bility, quickly followed by quick,
convenient and safe retrieval of
that portable data. Right now,
laptops offer all this in an afford-
able package, and are quickly
replacing desktop computers.
Going hand-in-hand with
laptops are handhelds. Indeed,
the competition on this turf for
both size and features is so fierce
that it has become quite a
mental exercise to differentiate
a phone from a ‘smartphone’,
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and a smartphone from a PDA. If
you are looking at a communi-
cation device that offers rudi-

mentary contact management
and call management, then
almost any cell phone in the
market would be it. But we went
a little further here.

With an eye on data manipu-
lation and data portability, we
argued that an ideal device would
be a ‘PDA phone’: more PDA than
phone, with a good, viewable
screen, data input via either a
keyboard or handwriting recogni-
tion software, and finally, with the
ability to make phone calls. Such a
device is ideal when called for
noting down someone’s contact
(or for exchanging contact infor-
mation wirelessly after a meeting
or presentation); to create to-do
lists; or for synching your calendar

with the rest of your team over a
shared Web calendar—instead of
booting your sizeable laptop.

It is always easier to update
your PDA-phone while on the go
and then sync it later with your
PC later at night. Similarly,
reminders about meetings or
birthdates, and checking e-mail
while travelling, are tasks for
which PDA-phones are more
practical than laptops.

On-theroad practicality is
what prompted Santosh Savant to
opt for a PDA-phone over a laptop.
As the brand manager of Cosmos
Brands International Pvt Ltd,
Savant relies on his Nokia
Communicator 9210i for “sched-
uling meetings and anniversary
reminders.” As he puts it, “While
travelling, the size and weight of
the device really matters; a laptop
weighs over a kilogram, and the
250 grams of a PDA-phone is a
significant reduction... the PDA-
phone notifies me about events
instantly. The same can’t be said
about laptops for the simple
reason that they won’t be
switched on all the time.”

We are, of course, not suggest-
ing that the laptop is replaceable
by the phone—not yet at least. The
two complement each other
well—a phone to gather and
check upon data quickly, a laptop
to work upon collated data at a
less hectic time and locale. As
Santosh Savant, brand manager,
Cosmos International Brands Pvt
Ltd, agrees, “...a laptop is a better
bet if you do lot of presentations,
work with sheets, etc, but for e-
mail on the go, a PDA is as good
as a laptop.”

Mobile e-mail has
become very impor-
tant in the business
world. A 2004 survey by
research firm InStat/
MDR highlighted that
the biggest concern to
mobile business users is
staying connected to
customers, co-workers, and
critical data. The survey went
on to note that for their cell
phones, users want basic func-
tionalities such as speaker-
phones and e-mail capabilities.
This fact has been underlined by
the industry itself—Blackberry
devices are finding favour with
users for their e-mail capabilities
and their ability to tie seamlessly
with Microsoft Exchange servers.
Indeed, their success has
prompted PalmSource to carve

out a deal with Microsoft to be

We are, of able to communicate with
course, !‘IOt Exchange servers... Microsoft, in
suggesting  turn, is looking to add support
that the Sor .so-calledh ‘auxiliary display
i evices’ to their upcoming—any
Irirl;tlgcpelgbl e time now—Longhorn OS.
Microsoft wants PC makers to
by the mount cell phone-like displays on
phone—not the lids of laptop computers so
yet at that users can check the time,
least. The battery status and appointments,
two com- or see if new e-mail has arrived
without having to start up their
plement portable PCs. Such functionality
each other is already planned for ‘handtops’
well such as the upcoming FlipStart

(www.flipstartpc.com).

Will the future bring in the
so-called ‘road warriors’—men
and women connected digitally
to offices yet not tethered physi-
cally to a geographical location?

A look at present devices
certainly points to such a
scenario. When we tested devices
for this article, convergence and
portability featured prominently
across laptops and PDA-phones.
So let’s take a look at what the
market is offering. As mentioned,
we have divided this article into
laptops and PDA-phones. We
begin with the laptops.

LAPTOPS

Based on its form, a laptop can
either be an ‘ultra-portable’—
small and light—or a workhorse—
big and feature-rich. One of the
common elements threading
through these disparate devices is
battery life. Although it is an
important element in the usabil-
ity of portable electronics, battery
life, at present, doesn’t satisfy.
Hovering around the three-hour
mark, you would be remiss not to
carry an extra battery pack along.
Perhaps with the introduction of
less hungry processors, better
batteries, and someday, of OLED
screens, this facet will improve.
As of today, large screens,

optical drives,
fast hard
disks, wire-

less connectiv-
ity, all conspire
to hold battery life
down—the best a
laptop could do under
. our admittedly gruelling

Fujitsu LifeBook 57010  pattery test was make it
past four hours (it was

an Acer TravelMate, in case you
are wondering). Our recommen-
dation is that you seriously
consider investing in an extra
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battery pack when purchasing
a laptop.

Barring the odd one here and
there, most of the LCD screens on
laptops are usable. Some are
exceptional, such as the specially-
coated screens offered by Sony or
Sharp (with exceptional price tags
too); some are not very usable
under certain lighting condi-
tions, such as the ‘mirrored’
Toshiba Satellite. But, on the
whole, they are all usable for the
task at hand, which is mostly
reading, writing and some
portable cinema, if you are
lucky with time and if your
battery allows.

Before purchasing a laptop,
ensure that you are comfortable
with the viewing angle—place it
in a position you will most
frequently use: on your lap, on a
table, in a cramped airplane seat,
or seated in a local train. If the
screen is readable at the angles
you try out, you are good to go.

Another noteworthy aspect is
that of the hard disk speed, but
all the laptops we tested had
4,200 rpm disks, which is good

he laptops were assessed on four

main parameters—features,
performance, usability and price. The
weightages applied to these parameters
varied from one category to another
depending on the relevance of a
particular parameter to that category.

We used a fresh copy of Windows XP
Professional SP1 as the 0S. After the
installation, all the latest drivers were
loaded for optimum performance.

Features

We noted features such as the type of
RAM, hard disk capacity, type of optical
drive, types of ports, connectivity
options, and so on.

Usability

A laptop’s usability is evaluated on the
basis of how simple or difficult it is to
handle in day-to-day life—primary
importance was given to weight,
dimensions, and other ergonomically-
inclined issues such as keyboard feel,
touchpad sensitivity, etc.

Package contents

We noted whether the vendor provided
an 0S, a recovery CD, a user’s manual
and driver CDs with the laptop. We also
noted the extra software provided, and
the accessories—power adapter, carry
case, etc—bundled along.

enough. Just remember that
faster, though better, would also
drain batteries quicker.

Lastly, on build quality—IBM
laptops are the best in this regard,
bar none. The quality of their
keyboards is on par with, if not
above, that of desktop keyboards,
their ~machines are build
extremely well, and to last. Time
will tell whether the IBM-Lenovo
deal will affect this; notably,
Thinkpads will still be made
under the aegis of IBM for at least
one more year.

We will now move on to
the crux of this
section—the perform-
ance of the laptops we
received, starting with
the Workhorses.

THE WORK-
HORSES

Workhorses are built to
take care of demanding
computing needs. They,
therefore, include good
I/O, graphics and multi-
media sub-systems to
enable you to tackle tasks we

Performance

To gauge the performance of each
laptop, we ran a battery of tests to
evaluate each sub-system. The following
benchmarking suites were used to test
the laptops.

PCMark 2004: This is a system-wide
benchmark that tests individual
components such as the processor,
memory, hard drive and the graphics
sub-system. It returns aggregated
scores as well as individual scores by
running different applications used in
day-to-day work, such as file
encryption, virus scanning and so on.
SiSoft Sandra 2005 Professional SR1:
This was used to evaluate CPU, memory
and hard disk performance.

Ziff Davis Business Winstone 2004: ZD
Bench’s Business Winstone—a benchmark
that tests the system with applications
that are used on daily basis—evaluates
complete system performance, and
returns a unified score.

Video Encoding: A 100 MB VOB file was
encoded using Dr. Divx 1.0.6 to the AVI
format, and the time taken to encode
the file was noted.

Gaming benchmarks: Call of Duty was
used because it doesn’t work on
graphics chipsets that don’t support
Hardware T&L (Transformation and
Lighting), and tests the OpenGL

ACI Emerald C2

usually perform on our desktop
PCs. We rounded 12 models from
nine brands under this category.
HP and Dell could not send in
their models in time for our test,

despite aggressive follow-ups
from our end.
A workhorse is generally

employed both at home (where
you will likely use it for work)
and at work (if the boss is look-
ing, for work). These machines,
therefore, are powerful enough
to pull the requisite load. Let’s
look at their features, starting
with what makes them tick.
Power: The Acer TravelMate
4002WNLCi comes with a fast 1.6
GHz Pentium M processor and 512
MB of DDR333 RAM. The Wipro
LifeGenius 1000D, on the other
hand, came equipped with a
paltry 128 MB of RAM, which
was shamelessly shared with
the graphics chip—its
performance did
suffer on account of
this. The Acer, Zenith
Strategist and Toshiba
Satellite all had wide
screens, which are a plus

Tr-f How We Tested

graphics subsystem. HalfLife 2 supports
different versions of the DirectX API.
The games were run at 800 x 600 and
1024 x 768, and the average frame-rate
was noted.

Screen display tests: DisplayMate Video
Edition was used to evaluate the quality
of the LCD display. We used the test to
gauge the sharpness and level shift of
the LCD screens. Pixel Persistence was
tested using the PassMark Monitor Test
suite, in which white moving blocks
were observed for the tearing effect,
and the screens were rated accordingly.
The laptops were then taken outdoors
to see how viewable the text and video
on the screen was in sunlight. The
laptops were placed such that the sun
fell on the screen at a slant, rather than
perpendicular to the screen.

Digit Battery Meter: In order to stress
the battery to the utmost, we ran a VOB
file until the battery ran out,

to gauge whether the notebook

battery would last a full movie—pretty
real-world.

Wi-Fi Test: To evaluate data throughput
over Wi-Fi, we used the NetCPS
program-—a utility that pumps in data to
check the TCP/IP connection. We also
copied 52 MB of assorted data, and
streamed a movie file, to further check
Wi-Fi performance.

92 DIGIT MARCH 2005




Digital Business | Test Centre

while working on worksheets or
while watching a movie.

Oddly enough, the Toshiba
Satellite had a ‘mirror finish’ to
its monitor, which

took away much of
the detail while
viewing anything
in a properly lit
room. The MSI
MegaBook
sported the

IBM Thinkpad T42

highest native resolution of 1,400
x 1,050. When it comes to connec-
tivity, serial and parallel ports,
while still important, are side-
lined by the now-ubiquitous USB
ports. A few models, from vendors
such as MSI, came with a parallel
and a serial port. The Zenith
Director had four USB ports,
which was the highest, three or
two being the norm.

FireWire is also gaining in
presence, and all laptops except
for the IBM Thinkpad T42 came
with a FireWire port. This
provides a fast interface for
connecting digital imaging equip-
ment such as DV cams to a laptop.

An infra-red (IrDA) port,
though old, was still present on
almost every laptop except for the
Zenith and the Toshiba. IR ports,
slow as they may be, are a very
useful feature for exchanging
data with handhelds such as cell
phones and PDAs. IrDA allows for
synching of your Outlook address
book, notes, to-dos, images and so
on. The models from Acer and
BenQ also supported the faster
and more convenient Bluetooth.

As wireless networks
increase in popularity
within offices, and as
Wi-Fi hotspots trickle
into our country, Wi-Fi-
enabled laptops make
for a worthwhile invest-
ment. Most of these are
based on Intel’s Centrino
platform. Wi-Fi connectiv-
ity was indeed part of
every laptop, save for the
Zenith Director.

Faster Gigabit Ethernet
ports were provided with the
Fujitsu, the IBM and the MSI
laptops, and this number will

only grow, as the popularity of
Gigabit is fast increasing. Gigabit
allows ten times faster data trans-
fers over a LAN.

To be able to make presenta-
tions while on the road, D-Sub
and S-video connectors are
important. These can also be
used to output video onto bigger
televisions at home in order to
watch movies, play a game or
run a slideshow of your personal
photographs.

When it comes to data stor-

age, anything above 20 GB is
decent for a laptop, and all the
laptops we tested had at least this
much to offer. The MSI MegaBook
M510C came with an 80 GB drive.

The integrated graphics chip
present in most of the laptops is
good enough for common usage.
However, some laptops do offer
the option of a dedicated card. If
you are looking to do design work
on your workhorse, such as
CAD|CAM, consider such a solu-
tion. Some Thinkpads, for exam-
ple, offer the option of
workstation-class graphics cards
with 128 MB of onboard memory.

The IBM T42 had an ATi
Radeon 7500 with 32 MB of dedi-
cated DDR RAM; the Acer and the
MSI came with an ATi Radeon
9700 with 64 MB of dedicated
DDR RAM, whereas the Toshiba
came with an nVidia GeForce Go
5200 with 64 MB of dedicated
DDR RAM.

All the laptops in this cate-
gory came equipped with an opti-
cal combo drive capable of
burning CD-ROMs. This is a handy
feature, suited for taking backups
on either archival CDs or on
rewritable CD-RWs. The Fujitsu
and the IBM T42 also featured
biometric fingerprint scanners
for added security. These allow
biometric access to password-
protected data within
e-mail boxes, instant

messengers and VPNs.

Usability: The
Fujitsu LifeBook
S$7010 had the small-

est dimensions and
was the lightest.
In fact, it

Zenith Director
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Jehangir Wadia, Trustee of the A
H Wadia Trust, has been an avid
laptop user for at least 10 years
now; he currently uses a Fujitsu
7010 for everyday work.
Flexibility is the primary rea-
son he cited for opting for a laptop
over a desktop PC. According to

R4 ‘Why | Use A Laptop’

Wadia, you can take your entire
office with you if you have a lap-
top—whether you’re on the move,
visiting your branch offices, or
working at home. “Such mobility
and flexibility ensures that you
deliver on both—professional as
well as personal demands.”

weighed in at just 1.98 kg—much
lighter than the next-lightest, the
IBM T42, at 2.28 kgs.

The Fujitsu is an ideal travel
companion—it’s so light that you
can easily carry around that
necessary extra battery pack, or
even a spare mouse.

The usability of a laptop is
enhanced by accessible expansion
ports—it is better to have USB
ports on either side of a unit than
at the back; ditto for the D-Sub
ports. Ports on the Acer, BenQ and
Fujitsu units were nicely spread
out and very easy to access.

Some laptops such as the MSI
and the Zenith Strategist had
touchpads with tacky keys. The
Toshiba had the Windows key in
the top row, and the IBMs simply
did not feature a Windows key.

When the sole method of
analogue input to a laptop is a
touchpad, the touchpad needs to
be sensitive and responsive
enough to your fingers. Strug-
gling with this will soon lead to
tired fingers and a drop in
productivity.

Here, the IBM Thinkpad
offered the best tactile feel on both
the touchpad and the keyboard.
Moreover, its signature red point-
ing stick is a great replacement for
a mouse in terms of ease of use.

The Fujitsu and the Toshiba
Satellite fared equally well here.
We found the IBM laptops and the
Acer unit very ergonomic. IBM is
to be commended for its rock-

solid build quality. When we
tested onscreen readability in
daylight, except for the Zenith
Strategist, the remainder were
nothing but eye strainers. The
Fujitsu S7010 had the most diffi-
cult screen to read. As far as view-
ing angle goes, the Fujitsu, the
Toshiba and the MSI offered good
angles of 170 degrees. ACI offered
the lowest at 145 degrees.

For movies, the best viewing
angle of 160 degrees was offered by
the Zenith Strategist. The Wipro
CP had a pretty bad screen, which
didn’t allow for any lateral move-
ment; we had to sit right in front
of it to get a viewable image.

Although all the laptops came
equipped with speakers, none
came close to the Harmon Kardon
speakers that shipped with the
Toshiba Satellite M30.

All laptops came with either
Microsoft Windows XP Profes-
sional or Home, with Wipro and
Zenith being the exceptions. They
didn’t come preloaded with an OS
at all; you are expected to either
install an OS yourself or pay extra
for this barest of necessities.

Performance

Laptops falling in this category
are flexible enough for home and
office use. This means a good
workhorse should run office
applications as well as a desktop
PC would. To test this, we
employed the Business Winstone
benchmark, under which

Wipro LittleGenius CP

common applications such as
Microsoft Word, Excel, Outlook
and Internet Explorer are runin a
scripted sequence.

Here, the IBM T42 logged the
highest score of 21.2, followed by
the 20.7 that the Fujitsu S7010
scored. The IBM T42 also was the
fastest in video encoding, and in
the SiSoft Sandra 2005 synthetic
benchmark suite. The T42 thus
comes across as a machine that
will not only perform well in
most workrelated applications,
but one that also lends itself to
minor workstation-class jobs such
as rendering and image resizing
and conversion.

Under PCMark 2004, the Acer
TravelMate 4002 scored the best,
and should suffice for all comput-
ing needs—office, home or while
travelling. The IBM T42 and MSI
also showcased good performance.

WiFi, though not very
common, is finding a foothold in
India. Wireless connectivity
provides flexibility and lets the
user work and access data and the
Internet while away from the

desk. Speed, however, still
remains an issue, especially with
the 802.11b standard, where the
peak data throughput is
just 11 Mbps.
Thank-
fully,802.11g,
with 54 Mbps,
is gaining in
popularity.
The Acer Travel-
Mate 4002, with an

802.11g-based Intel

card returned scores compa-
rable to those of a wired LAN. It
took just 34 seconds to copy 50 MB
of data using Wi-Fi on this laptop!
We also ran a few games to
test the DirectX and OpenGL
performance of these machines.
Since most had an integrated
Intel graphics chipset, they
returned very low scores, while

i@l Score Board Workhorse Laptops Category
Score (out of 100)
E Acer TravelMate 4002WNLCi Pentium M 1.6 GHz, 512 MB, Mobility RADEON 9700, 15.4-inch, 60 GB, Combo Drive, 802.11g, 10/100 Mbps, 2.98 Kg 67.64 51,999
; ACI Emerald C2 Pentium M 1.7 GHz, 256 MB, Intel 855, 14.1-inch, 40 GB, Combo Drive, 802.11b, 10/100 Mbps, 2.40 Kg 65.58 44,999
BenQ Joybook 5100U Pentium M 1.5 GHz, 256 MB, Intel 855, 15-inch, 40 GB, Combo Drive, 802.11b, 10/100 Mbps, 2.40 Kg 57.70 79,000
Fujitsu  LifeBook S7010 Pentium M 1.6 GHz, 256 MB, Intel 855, 14.1-inch, 60 GB, Combo Drive, 802.11g, Gigabit, 1.95 Kg 63.99 130,000
IBM T42 Pentium M 1.7 GHz, 512 MB, ATI Mobility RADEON 7500, 14.1-inch, 40 GB, Combo Drive, 802.11g, Gigabit, 2.28 Kg ~ 60.51 124,000
IBM R51 Pentium M 1.7 GHz, 256 MB, Intel 855, 15-inch, 40 GB, Combo Drive, 802.11g, Gigabit, 2.86 Kg 61.85 85,000 —ng
MSI MegaBook M510C Pentium M 1.5 GHz, 256 MB, ATI Mobility RADEON 9700, 15.4-inch, 80 GB, Combo Drive, 802.11g, Gigabit, 2.84 Kg  66.88 65,990 %
Toshiba Satellite M30 Pentium M 1.6 GHz, 256 MB, GeForce FX Go5200, 15.4-inch, 40 GB, Combo Drive, 802.11h, 10/100 Mbps, 2.76 Kg 56.44 105,000
Wipro LittleGenius 1000D Celeron 2.4 GHz, 128 MB, SiS 315, 14.1-inch, 20 GB, CD-ROM, NA, 10/100 Mbps, 3.06 Kg 54.30 43,990
Wipro LittleGenius CP Pentium M 1.4 GHz, 256 MB, Intel 855, 14.1-inch, 30 GB, CD-ROM, 802.11b, 10/100 Mbps, 2.76 Kg 56.39 51,990
Zenith Director Pentium M 1.6 GHz, 256 MB, Intel 855, 14.1-inch, 40 GB, Combo Drive, 802.11g, 10/100 Mbps, 2.58 Kg 54.03 51,000
Zenith  Strategist Pentium M 1.6 GHz, 256 MB, Intel 855, 15.4-inch, 40 GB, Combo Drive, 802.11g, 10/100 Mbps, 2.82 Kg 58.31 57,500

For the complete scoreboard, log on to www.thinkdigit.com
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the IBM T42 simply failed to run
Half-Life 2. The Toshiba Satellite
M30 running on a GeForce Go
5200 and the MSI MegaBook
M510C with an ATi Mobility 9700
chip were the exceptions, and
fared well in both games.

Finally, it was time to test the
battery life. Most of the laptops we
tested supported some form of
speed throttling—wherein the
CPU runs faster or slower depend-
ing on the load—and they also
switch off the screen and park the
drive after a while in order to
extract the most from the battery.
We wanted to test them under
extreme conditions, however, and
therefore disabled these features.
Keep in mind, therefore, that real-
world battery life will be better
than what our tests reflect.

The Acer TravelMate 4002 was
indeed a traveller’s friend—it ran
for a whole 230 minutes. On the
other extreme were the models
from Wipro, which drained out in
just 66 minutes, which is poor by
any standards.

\ BEsTeuv
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Acer TravelMate 4002WNLC

Conclusion

While both the IBM T42 and the
Toshiba M30 put up a solid
performance in most tests, the

NBESTBUY
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MSI MegaBook M510C

Acer TravelMate 4002 came out
on top as the best performer.

This wide-screen wonder
with a 1.6 GHz Pentium M
processor and 512 MB of DDR333
RAM sported a 60 GB hard drive
and an 802.11g wireless card. The
screen supported a native reso-
lution 0f 1280 x 800, a resolution
ideal for both work and leisure.
Being powered by the ATi Mobil-
ity Radeon 9700 did not hurt its
performance either. Although it
weighs in at 2.98 kg, the
performance is well worth the
extra kilogram!

The MSI MegaBook M510C
came in second, closely following
the Acer. With a 1.5 GHz Intel
processor and 256 MB of DDR333
RAM, the Acer also sports Gigabit
Ethernet and an SD/MMC| Memo-
ryStick card reader. This laptop
had an 80 GB hard disk, which
was the highest capacity in the
comparison test.

THE ULTRA-PORTABLES
While the Workhorses are meant
to replace your desktop PCs, ultra-
portables are designed to be as
small and as light as possible.
Their screen size is therefore
small—less than 14 inches—and
they weigh less than two kgs.

A small form factor calls for
some compromises though, includ-
ing the screen size, which may lead
to eye strain after prolonged use—
and a smaller keyboard, which can
be cumbersome to work with. We
tested five such models from five
different vendors.

Features

All the wultra-portables were
based on Intel’s Centrino plat-
form: with an Intel Pentium M
processor, the Intel 855 chipset
and an Intel Pro Wi-Fi chipset.

The Fujitsu S2020, with an
AMD Athlon XP-M 2100+, was the
exception. The Acer TravelMate
381TCi had a whopping 512 MB
of RAM, a lot for its size!

All these laptops had a 4:3
screen, except for the Zenith VU,
which featured a 16:9 wide
screen. The Zenith Presidio VU
also had the highest resolution of
1280 x 768 pixels; the other
laptops featured 1024 x 768. The
Zenith’s only drawback was a
‘mirror finish’ screen, which was
very distracting—it reflected too
much light. The Fyjitsu LifeBook
S2020 had the largest screen size
of 13.3 inches, and was a lot easier
on the eyes.

M ‘Lighter Laptops Make Sense’

r Lajmi has equipped himself

with an ultra-portable laptop.
Why an ultra-portable one?
“Weight and size were the two
things I was looking at, and it’s
only an ultra-portable that fits the
bill. I often have to lug the laptop

Dr Uday Lajmi around for presentations, so a
Dean, D Y Patil lighter laptop makes more sense.
Institute of Moreover, the small size ensures
Management you can take it almost anywhere.”
Studies
. The Zenith Presidio VU had
The T(.)Shlba three USB 2.0 ports, while the
Satellite others only had two. The almost-
M30 obsolete serial port was only avail-
running on able on the Fujitsu LifeBook
a GeForce §2020, which also sported a
parallel port—along with the ACI
Go 5200 Ethos Li
. os Lite.
chip fared All these laptops had a
well in both  Firewire port. They also all had a
games PCMCIA slot that supported Type

I and II PC Cards. Due to their
small size, the support for the
thicker PCMCIA Type III was
absent. The Zenith Presidio VU
supported SD/MemoryStick/MMC
cards, whereas the ACI Ethos Lite
supported SD/MMC—and the
Toshiba Portégé M100 supported
only SD cards. The rest had no
memory card reading capability
at all.

IrDA ports were present on all
laptops except the Toshiba
Portégé M100. It doesn’t hurt to
have an IrDA port onboard, espe-
cially if you wish to transfer
files between a cell phone and
the laptop.

All the Centrino-certified
laptops, as well as the Fujitsu
LifeBook S2020, had Wi-Fi connec-
tivity, which is fast getting popular
in offices, airport lounges, hotels,
and even a few retail outlets.

The Acer TravelMate 381TCi,
Fujitsu LifeBook S2020 and the
Zenith Presidio VU supported the
802.11b/g standard, while the rest
supported the 802.11b standard. It
should be noted that the faster
802.11g (54 Mbps) should be
preferred over the older and slower
802.11b (11 Mbps). None of the
ultra-portables supported Blue-
tooth. However, all were equipped
with a 10/100 Mbps LAN port as
well as an internal 56 Kbps modem.

All the laptops came with a 40
GB hard drive, except for the Acer
TravelMate 381TCi, which had 60
GB. Only the Toshiba Portégé
M100 had a 5,400 rpm hard
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{"‘“’x Score Board Ultra-Portable Laptops Category
Model Score (out of 100)

Acer TravelMate 381TCi

Pentium M 1.5 GHz, 512 MB, Intel 855, 12.1-inch, 60 GB, External Firewire Combo Drive, 802.11g, 10/100 Mbps, 2.08 Kg 58.31

ACl Ethos Lite

Pentium M 1.7 GHz, 256 MB, Intel 855, 12.1-inch, 40 GB, External USB Combo Drive, 802.11b, 10/100 Mbps, 2.14 Kg ~ 60.34

For the complete scoreboard, log on to www.thinkdigit.com

drive—all the others had 4,200
rpm drives. On the graphics front,
only the Fujitsu LifeBook S2020
came with the ATi IGP 320M
graphics chipset: the others had
the vanilla Intel Extreme Graph-
ics 2, which is a decent solution
when you limit usage to presen-
tations, movies and office appli-
cations.

The Acer and ACI
models came with @
external  optical
combo drives—the |
Acer had a FireWire
drive, the ACI a USB
one; the other laptops
came with inbuilt §
combo drives. e

It is important to
note that in this cate-
gory, an external
drive grants _~
greater flexi-
bility. By not
integrating an
external drive
into the device, the
laptop can be smaller; g
you are granted the free-

Acer TravelMate 381TCi

build quality of the Toshiba to be
the best. The Acer had an uncon-
ventional, round touchpad and a
small keyboard. The Zenith
featured a touchpad whose feel
was worse than the feel of the
surrounding surface, and the
touchpad keys were tacky to boot.
The Toshiba did not feature a
touchpad at all, going for a point-
ing stick instead.

All these laptops came
bundled with Windows XP
Professional, with the excep-

tion of the Zenith Presidio VU,
which came without an OS.
Only the Fujitsu came
with a complete
software pack-

/ age, which

y > _ 7 included a
- recovery disk,
RecordNow—which

is CD-burning soft-

/ ware, Norman Virus
Control and Cyberlink
PowerDVD 4. It skipped the
driver CD, though. The
Toshiba Portégé
M100 made

dom to only use it when
needed. Thus, the Acer
was the lightest laptop tested at
1.66 kilograms, followed closely
by the ACI at 1.72 kgs.

Notably, the Zenith Presidio
VU had an inbuilt swivel Web
camera, ideal for ad-hoc video-
conferences. Also worth noting
was that the Toshiba lacked a
touchpad, which made naviga-
tion a torture.

Usability

As pointed out earlier, the Acer
and ACI models were the smallest
and the lightest, thanks to their
external optical drives. For those
who will always require an opti-
cal drive, the Fujitsu offered the
best portability. One negative
about external drives is that they
occupy a port while in use.
Speaking of ports, the Fujitsu’s
ports are not placed all that well,
but the device made amends with
its touchpad and keyboard, which
we found to be the best to work
with in this class. We found the

system restora-
tion easier by
providing a restore DVD instead of
multiple CDs.

Performance

When we put these laptops
through the Winstone suite of
tests, the Toshiba Protégé M100
scored the highest at 19.4.

Surprisingly, the ACI Ethos
Lite with a 1.7 GHz Intel Pentium
M processor could only manage
9.5, which is a very low score.

We encoded a video file to
determine the muscle of the
processors. Here, the Zenith
Presidio VU took just 217 seconds
to encode our VOB file to AVI. The
ACI'was once again the slowest, at
287 seconds.

The Zenith will offer you the
best frame rates if you plan on
watching movies while in transit.
The ACI did do well in the
synthetic SiSoft Sandra 2005 CPU
test, which tests the CPU in
isolation, a scenario that is
hardly practical.

The Zenith As we noted before, a fast hard
Presidio vU  drive goes a long way in improv-
has an ing your computing experience.

The Toshiba M100 with its 5,400
rpm drive was certainly the
fastest, logging an impressive 32

inbuilt swivel
Web camera,

ideal for MBps as the drive index and offer-
ad-hoc video ing an access time of just eight
conferences ™S which is usually in the range

of 10-12 ms. Applications will
launch faster, and data will be
saved and backed up faster on

this laptop.
While you might not play
games on these machines,

gaming scores reflect the capabil-
ities of the video card, and are
important if you are a CAD/CAM
designer or an architect.

In Call of Duty, an OpenGL
game, the Acer 381TCi gave the
highest frame rates of 25.3 fps at
800 x 600. In Half-Life 2, a DirectX
game, the Fujitsu S2020 with
its Athlon XP-M processor and
an ATi IGP320 chipset returned
the highest scores of 15 fps and
12.22 fps at 800 x 600 and 1024 x
768 respectively.

While testing viewing angles,
all the screens offered readable
text from angles as high as 160
degrees, with the Toshiba going
as high as 170 degrees. For
movies, however, the Toshiba
was visible within a range of 130
degrees, whereas the Fujitsu
offered 150 degrees. When tested
in daylight, except for the
Toshiba M100, the others were
too dark to be readable.

When it came to battery life,
the Zenith Presidio and the Acer
381TCi went 170 minutes on a full
charge, which is as
good as it gets for an
ultra-portable. The

Fujitsu, with a 100-
minute Dbattery

Toshiba Portégé M100
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life, demands that an extra battery
pack be carried alongside.

For wireless data transfer, the
Fujitsu S2020 with a transfer rate
of 2.37 MBps one-upped the Acer
381TCi at 2.03 MBps. This will
let you stream music from
colleagues without a hitch.

Conclusion
The ACI Ethos Lite and the Acer
TravelMate 381TCi, both of which
featured an external combo drive,
earned almost equal points in the
final scorecard, with just a point
separating them, and were the
second and third runners-up
respectively. At the end of the
day, the Fujitsu
LifeBook  S2020
was adjudged the

didit

MARCH 2005

Fujitsu LifeBook 52020

winner, followed by the
Zenith Presidio VU.
Even though

\BESTBUY

The mixed
marriage
between
the PDA
and the cell
phone is
promising
the ideal
breed

-
the‘b
Fujitsu cost Rs 10,000 ESTBUF'

more than the
Zenith, what it
lost in price, it
made up in
features. With
a 13.3-inch
screen driven
by an ATi IGP
320M chipset,
the Fujitsu

Zenith Presidio VU

offered a great viewing
experience. It also sported a vari-
ety of ports, save for a memory
card reader—which wasn’t pres-
ent on any of the laptops in
this category.

In terms of ergonomics, the
Fujitsu excelled. Also worth
noting is that it carried along the
best software bundle.

PDA-PHONES

We have talked about and tested
laptops to this point; that device
class in its current avatar is not
ideally suited for instant, one-
minute tasks. Making a quick
phone call, perhaps even a
conference call, sending an
emergency SMS across, schedul-
ing or rescheduling meetings,
taking small notes, recording
voice memos, exchanging elec-
tronic contact information—
such tasks as these require a
different beast to drive them.

While a PDA was ideally suited
for all these tasks a few years ago,
the mixed marriage between that
strain of product and the cell
phone is promising the ideal
breed. What we have termed the
PDA-phone is a device that strad-
dles the boundaries, offering the
best of both worlds. The key is the
means of data entry, then screen
size, and then the other features.
So why not smartphones? Smart-
phones typically have much
smaller keypads—this is essentially
what differentiates them from the
PDA-phones we are discussing
here, which have a fullfledged
data entry system.

In the scenario we’ve painted,
laptops are your primary device,
while a device that provides the
functionality of a PDA and the
connectivity of a cell phone plays
the sidekick. Thus, Nokia’s
Communicator 9500 is more of a
phone with slapped-on PDA
features, whereas 02’s XDA-II
mini is essentially a PDA with cell
phone features.

We received two devices from
Nokia—the 9500 Communicator

and the 7710; the Treo 600 from
PalmOne; the 02 XDA II mini; the
Blackberry 7730 from Airtel; and
the A768i from Motorola. Sony-
Ericsson failed to send us the
P910i in time.

We tested each of these
devices on the various parameters
that would be of importance to a
mobile professional.

Portability

These devices need to be pock-
etable. Dimensions, though
important, should not affect
important elements such as
screen size too much; an ideal
device will therefore have the
correct balance of dimensions
and screen size.

Motorola’s A768i is most pock-
etable; the clamshell design aids
it further, serving as a screen
protector, and you can safely
throw it along with loose change
and house keys. However, as you
will soon find out, the A768i isn’t
very feature-rich.

The O2 XDA II mini on the
other hand, has a perfect balance
of dimensions and screen size.
Despite its large screen, the O2
mini maintains a small profile,
thanks to minimal face buttons,
and can be easily slipped into
your pocket.

The Blackberry 7730 has a suffi-
ciently large screen, but is some-
what too large to be easily
carried—this one is definitely a coat
pocket or a trouser pocket device.

The PalmOne Treo 600 is
surprisingly small and pock-
etable; it does have an external
antenna, though.

While Nokia’s 7710 might be

ia How We Tested PDA-Phones

devices’ ease of use into account.

arameters such as portability, usability and productivity formed

the backbone of this PDA comparison.

In ‘Portability’, we noted the dimensions and the weight of the device.
We also looked at whether the device fits easily in a pocket. ‘Usability’
included general ergonomics, where we assigned scores by typing
messages using the QWERTY keyboard/pad or using the stylus.

We also used the device for browsing the Internet, and logged its
ability to render Web pages well. As for contact management and
schedules, we added some entries and then synchronised the device
with a desktop PC to check compatibility with MS Outlook. We also
used the provided data backup tool to back up the data, and assigned
scores based on how simple this task turned out. We also took the

In ‘Productivity’, we assessed how easy to use the bundled software
was—such as the word processor, the spreadsheet application, the PDF
reader, the presentation tool, the e-mail client, etc.

To obtain realistic values in the battery test, we had the device
simulate optimal usage, and noted the time it took for the device to
drain the battery from a full charge.
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s a brand manager for up-

market luxury brands, Savant
often has to shuttle between his
office in India and headquarters
in Europe. He relies on his Nokia
Communicator 9210i for daily
communication. Here’s what
Savant had to say to us about his
preference for a PDA-phone over
a laptop.

“When you’re travelling, the
weight and size of the device
really matters. Any laptop
weighs over a kilogram, and the
250 grams of a PDA-phone is a
significant reduction. Secondly, |

\

Santosh Savant
Brand Manager,
Cosmos Brands
International Pvt Ltd.

R4 ‘For e-mail on the go, a PDA is as good as a laptop’

use the 9210i for scheduling my
meetings, anniversary reminders,
etc. when travelling; the PDA-
phone notifies me about such
events instantly—it’s not this way
with laptops for the simple
reason that they aren’t switched
on all the time.

Practically speaking, a laptop
is a better bet if you do lot of
presentations, work with sheets,
etc. But for e-mail on the go, a PDA
is as good as a laptop. The added
phone features make it even
better—you can stay in touch with
your loved ones.”

considered pocket material,
its large display is
prone to scratches,
and should not
leave home without
protection. Finally,
the Communicator
series from Nokia
was not meant for the
pocket, and the 9500
is no exception.

Next, we tested the
usability of each device.
Here’s where the data
input method, display
properties, Ul speed,
applications
connectivity come to
the fore, and make all
the difference between a good
product and a bad one.

Display Properties
We looked at and evaluated the
screen size, screen resolution,
screen orientation, legibility of
text, and colour depth of the
display used in these devices.
The Nokia 9500 is graced with
a 65K colour display—long, crisp,
and perfectly legible even with
outdoor lighting. The screen is
horizontally placed and is perfect
for reading documents and brows-
ing the Net. These same qualities
can be attributed to the 7710’s
screen; however, the 7710 has the
upper hand when it comes to the
size and resolution of the screen.
The 02 XDA Il mini comes with
a 320 x 240, 65K colour screen,
which is almost the same as the
Nokia screens in terms of quality.
With its ability to switch between
the landscape and portrait modes,
it has its own benefits to offer. The
Blackberry’s screen has sufficient
resolution for messaging—its
screen, though low on brightness,

and Blackberry 7730

offers excellent contrast, The
and is very legible under .
all lighting conditions. Communjlc-
The Motorola A768i ator SEI‘Ie_S
comes with a crisp 65K from Nokia
colour screen, but the Wwas not
screen is useless in meant for
daylight—it turns dark
an§(]1 1% unreadable. the DOCket’
and the
Y, Datalnput 9500 is no
YA/ Nokia’s 9500 exception
: Communicator
comes with a suffi-
ciently spacious
QWERTY keyboard that

makes data entry a
breeze. In general, the
keyboard is fairly
ergonomic, but people with short
fingers might have problems
with key navigation—stretching
for a key is a common scenario,
which in time leads to fatigue.

Both the PalmOne Treo 600
and the Blackberry 7730 employ a
small QWERTY keypad. The keys
on the Blackberry are well-spaced
and slightly slanted to avoid acci-
dental presses, and data input is
fuss-free. The keys on the Treo 600
are tiny, but are raised like a
dome; these take some time to get
used to. A point to remember
with the Treo 600 is that although
it is based on the Palm OS, it does
not support data input via the
stylus; you can only use the stylus
for navigation.

The 7710 is the first produc-
tion device from Nokia with a
touch screen, employing a stylus
for data input. Data input is
where, however, the 7710 could
have done better. While its letter
recognition is highly accurate, the
7710 can only take one character
at a time. Furthermore, the scrib-
ble area is too small for comfort. It

2l Iﬂ[,-g

does come with an onscreen
keyboard though.

Motorola’s A768i also makes
use of a stylus; however, its char-
acter recognition and speed is
nowhere near the likes of the 02
XDA mini or the Nokia 7710.

Thanks largely to Microsoft’s
Pocket PC OS, data input via a
stylus on the O2 XDA II mini is
fantastic. Character recognition is
excellent—so much so that you
can input data much faster than
you can with the keyboard-based
9500 Communicator!

For any handheld device, one-
handed operation is a must; the
PalmOne Treo 600 and the Black-
berry 7730 were the only devices
to offer complete one-handed
operation. The Nokia 7710, the O2
XDA II mini, and the Motorola
A768i meet you halfway on this
facet, while the Nokia Communi-
cator 9500 requires you to use
both your hands for data input or
for accessing information.

User Interface Speed

The answer to how fast appli-
cations open largely determines
the usability of a device. This
apparent speed depends on the
processor performance as well as
the OS.

The 02 XDA II mini was the
zippiest of all, thanks to its 416
MHz XScale processor and
Microsoft’s Pocket PC OS. The
PalmOne Treo 600 took second
place, while the Blackberry was
sufficiently responsive. Tasks
involving larger files, though,
slowed down the device. Both the
Nokia 7710 and the 9500 were the
least responsive of the lot. The
snail’s pace at which they launch
your applications wrecks your
nerves. Having noted that, it has
to be said that these devices

exhibit sluggishness only
during the launching

of applications;
once the applica-
tion is launched,
the devices resume
acceptable speeds.

Messaging
If your life revolves
around e-mail, the
Blackberry should be
your first stop. It
makes your e-mail
system as fast as an SMS
service—immediately
following the receipt of a
mail, you get a system noti-

Palmone Treo 600 fication, thus eliminating the
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need to download mails from the
server as in the O2 or Treo. The
mails are delivered to your hand-
held. As of now, the only device
available and compliant with this
service is the Blackberry 7730.
Consider buying this one only if,
like we said, your life revolves
around e-mail.

The Nokia 9500 Communica-
tor makes a great messaging
device due to its full keyboard
and easy-to-use applications. The
PalmOne Treo 600 comes in at
second place, offering
the advantage of
one-handed opera-
tion alongside its
mini keyboard. The
02 XDA II mini and
Nokia’s 7710 are
pretty much in the
same league when it
comes to messaging,
with their stylus-
driven interface.

Motorola’s  A768i
does no better than a
cell phone on the
messaging front. All
these devices support
POP, and hence make it
possible to receive your
corporate e-mail via GPRS.

Contact
Management And
Scheduling

Both the Nokia devices, the O2
XDA II mini and the PalmOne
Treo 600, offer easy contact
management with multiple
fields for numbers, addresses, e-
mail IDs, etc. Notably, the Nokia
7710 automatically links a
contact’s birthday to your calen-
dar. Synchronisation of contact
information with MS Outlook
works perfectly on these devices.
The Motorola A768i and Black-
berry 7730, though not in the
league of the Nokias and the
PalmOne, also have a decent
contact manager.

Nearly all the devices have
good scheduling features. The
Nokia 9500 and 7710 made good
use of their large screen by show-
ing the current month on one

Motorola A768i

half of the screen and the event
on the other half. The 9500 The 02
offers you a yearly view of meet- comes
ings and anniversaries as well. bundled
The 02 XDA II mini has the With Pocket
familiar Outlook feel, and is Excel and
simple to use. Word,
Data Manipulation making it
When it comes to reading and Simple to
editing documents, the 02 XDAII  work with
mini and the Nokia 9500 take the documents
top spot. 02’s OS comes bundled and
with Pocket Excel and Word,

worksheets

making it simple to work with
documents and worksheets.
The ClearVue application
allows you to work with
presentations and PDF
documents. Nokia devices
are bundled with their
own versions of word
processor and spread-

sheet; the 9500 comes

with a PowerPoint
presenter too.
PalmOne’s  Treo

600 features ‘Docu-
ments To Go’, which
provides support for
MS Word and Excel.
The Picsel browser
on the Motorola
A768i allows for
viewing of common
documents and brows-
ing the Internet.

Web Browsing
Thanks to its excellent
widescreen, Nokia’s 7710 is the
best device for surfing the Inter-
net. The Web browser, however,
lacks features, and sadly, Opera is
not yet available for this model.
The Communicator 9500 comes in
second, followed by the 02 XDA II
mini; the browser on these
devices is decent and their screens
are reasonably large. The brows-
ing experience on the Treo 600
and Blackberry 7730 is limited
largely due to their small display;
ditto with the Motorola A768i.

Connectivity

Nokia’s 9500 Communicator
lives up to its moniker, sporting
the maximum number of

Score Board (PDA-Phones)

connectivity options. The 9500
supports Wi-Fi, Bluetooth, IR and
a proprietary Pop port for a USB
connection with a PC. All this
makes the Communicator an
ideal device on a business trip.

The 02 XDA II mini and the
Motorola support Bluetooth and
USB for connecting to a PC. The
PalmOne Treo 600 and the
Blackberry 7730 lack Bluetooth,
and use USB for PC connectivity.

GPRS is available on all these
devices, so connecting to the
Internet via a GPRS-enabled SIM
is simple. However, you might
need to carry some of these
devices to your service provider’s
outlet, as over-the-air activation
is not yet supported.

When it comes to good, old-
fashioned telephony, the Nokia
9500 offers the best interface,
followed by the PalmOne Treo
600. The Blackberry 7730 with its
keypad is also usable. For all the
other devices, you need to use
either the touch screen or a five-
way d-pad to scroll through your
contacts, and then dial.

Conclusion
In this section, we were looking
for a compact PDA-phone ideally
suited for the mobile profes-
sional. Two devices stood apart
from the rest: the Nokia Commu-
nicator 9500 and the O2 XDA II
mini. The highlights of the
Communicator were Wi-Fi,
the full QWERTY keyboard,
and the intuitive applica-
tions. For a globe-trotter,
these features are a boon,
more so the wireless capa-

Nokia 9500 Communicator

Camera (Res/Video capture)

Practical Battery life (Approx)

Blackberry 7730 240x240 16 MB No/No No/No No/No 4 days 58.92 30,995
Motorola A768i 240x320 58 MB Yes/No NA No/Yes 3 days 53.25 19,020
Nokia 9500 640x200 75 MB+ Yes/No VGA/Yes Yes/Yes 3 days 77.39 41,359
Nokia 7710 640x320 &5 MB+128MB  Yes/Yes 1 Megapixel/Yes No/Yes 3 days 69.85 29,400 =
02 XDA-Il mini  240x320 64MB+256MB  Yes/No 1.3 Megapixel/Yes No/Yes 3 days 76.56 34,888
Treo 600 160x160 32MB Yes/No VGA/Yes No/No 3 days 61.23 26,500

For the complete scoreboard, log on to www.thinkdigit.com
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bility, which grants the 9500
unparalleled flexibility.

Some might be put off by the
bulky form factor of the 9500; if
you are, you might want to look
at the 02 XDA II mini—this little
device, though devoid of a
keyboard, allows for fuss-free and
unrestrained operation. Overall,
it is a great everyday device due
to its ultra-compact size and the
features it offers.

The Nokia 7710 is a great
device, packing in a lot of

02 XDA Il mini

features, but its means of data
input isn’t exactly ideal - and is
its biggest negative. While the
Blackberry 7730, as a general
device, can’t match up with the
rest, we give it a thumbs-up for
its e-mail service; it is exclusively
offered with Airtel’s service.

The Verdict

If you are looking for a device
that fares well on contact
management, calendaring, and
offers easy e-mail management
features, the Nokia Communica-
tor 9500 fits the bill perfectly. If
you are into sales and marketing

Contact Sheet

and often have to give presenta-
tions, and at times travel a lot,
the ideal solution would be the
Acer TravelMate 4002 as your
primary device and the O2 Xda Il
Mini as your secondary device.

If you think a PDA-phone is too
small and a laptop too big for
comfort, we recommend Fujitsu’s
$2020 ultra-portable laptop. Even
then, we advise you to add on a
small, basic PDA-phone such as the
02 Xda Il mini.

aliasgar_pardawala@thinkdigit.com
jayesh_limaye@thinkdigit.com
sanket_naik@thinkdigit.com

Company
Laptops
Acer Acer India (Pvt) Ltd 080-25219520 raghu_s@acer.co.in WWwWw.acer.com
ACI Allied Computer International 022-56943260 hirji@aci-asia.com Www.aci-asia.com
BenQ BenQ India Pvt Ltd 022-25705230 SalesEnquiryln@BenQ.com www.beng.com
Fujitsu Fujisan Technologies Pvt Ltd 022-56368718/25 gathani.paresh@fujisan.co.in www.fujitsu.com
IBM IBM India Ltd 080-22063199 sanmenon@in.ibm.com www.ibm.com/in
MSI Maxtone Electronics 022-23011434/37 maxtone@vsnl.com Www.msi.com.tw
Toshiba HCL Infosystems Ltd 0120-22520977  notebook@hclinsys.com www.toshiba.com
Wipro Wipro Limited 1600 333312 littlegenius@wipro.com WWW.Wipro.com
Zenith Zenith Computers Ltd 022-28377300 kalpak_bhatt@zenith-india.com www.zenith-india.com
PDA-phones
Blackberry Bharti Cellular Ltd 9892754000 mumbai_blackberry@airtelindia.com www.airtelworld.com
Motorola Motorola India Pvt Itd 0124-5191760 W4440C@motorola.com www.motorola.com/in
Nokia Nokia India Ltd 011-22677900 jay.bakshi@nokia.com www.nokia.co.in
02 Creative e-biz 011-51619800 creative@goldkist.net www.myxda.com
Palm Esource Global 9820822205 sales@esourceglobal.com www.palmone.com
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Never underplay the need for
a backup solution. Find one suited
to your needs

Robert Sovereign-Smith

computer is the single most complicated
piece of equipment we use. It has moving

parts, magnetic storage, heat dissipation,
and has to contend with fallible operating
systems and software. Today, critical data stored
on a computer connected to the Internet has a
lower probability of survival than a kitten cross-
ing a busy highway. All this we are well aware of.
We have all been inducted into the religion of
backups—either through articles like this one, or
due to prior, horrendous data loss encounters.
What we don’t realise, however, is that every
office has different needs. What’s good for the
goose is not necessarily good for the gander.

Subjective Selections

Every office has its own requirements—you may
be spending too little or too much on your data
backups. So what are your requirements?

The first step towards identifying a solution
is to identify your needs. The first thing you
need to do is analyse the amount of critical data
that needs to be backed up. Once you have a
clearer picture of your data, you can segregate
the data into three broad categories.

The first is data that is used on an everyday
basis, and needs to be backed up more than a
couple of times a day, such as databases. The
second is data that might be needed about once
a week, and will be modified. The third is data
that no one needs more than once a month (or
even a year), and might or might not be modi-
fied, such as invoice archives for tax purposes.

You have to put your business, and the data it
generates and uses, under the microscope and
figure out what data fits into which category.

Illustration Shyam Shriram

Depending
on the volume of
data to be backed up
in each case, you can
come to a solution.

Most businesses already
have file servers or network
servers that act as a critical
data repository. Because
of the large amount of
reading and writing—and
the resulting heat—that
servers’ disks are subject to,
they are prone to failure. What you
need to do is get a backup option for these
servers. We look at some of the backup technolo-
gies available, and what needs they might fulfil.

DAT: Digital Audio Tape; has a maximum capacity of 40 GB and offers data
transfer speeds of 19 GB per hour

DLT / SDLT: Digital Linear Tape/Super DLT; has a maximum capacity of
320 GB and offers data transfer speeds of 115 GB per hour

AIT: Advanced Intelligent Tape; has a maximum capacity of 260 GB and
offers data transfer speeds of 112 GB per hour

LTO (Ultrium): Linear Tape Open; has a maximum capacity of 400 GB and
offers data transfer speeds of 216 GB per hour
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*g Backup Software

ackup software have just as important a role to play as does the

hardware. All the best and fastest hardware in the world will not help
much if you choose a software that does its job inadequately. Though
companies with really big backup requirements could have existing software
customised to their setup, there are a few good software that will do the job
straight out of the box.

Most hardware vendors will provide you with their own software when you
purchase their hardware, and these are often good enough. You should look for
distributed backup software as a total backup software solution for your company.

Distributed backup software will give you, at the head office, total control
over backup policies at your branch offices. This is done via the Internet, and lets
the head office engineers dictate a uniform backup policy for all offices. System
engineers at branch offices have only the task of managing the servers and
media (tape, optical media, external drives, etc.), and other routine local tasks.

Computer Associates (www.cai.com), Veritas (www.veritas.com), Legato
(www.legato.com) and HP (http://welcome.hp.com/country/in/en/
welcome.html) are just a few of the biggest names that offer easy-to-set up
and robust enterprise-level backup software solutions.

NAS (Network Attached Storage)
Basically, a NAS is nothing more than a very
simple computer with many hard disks and a
simple OS, used mainly to increase the capac-
ity of existing servers, or to supplement the
storage capacity for users over a LAN. The
hardware and OS are made specifically to
enable fast file transfers and handle many
simultaneous requests. A NAS device can also
be used as a backup device that can be
plugged in when backups are needed, and
stored away for safety after the backups are
done. The beauty of a NAS is that it costs less
than a backup server, while still providing all
the desired functions.

NAS devices are available from all the top
vendors in the country, such as HP and
Iomega. A typical NAS generally offers
anywhere from 250 GB to 2 TB of storage space.
The advantage of a NAS is that it uses drive-
based storage, which offers data transfer
speeds that are much higher than traditional
tape-based storage. Also, NAS devices are very
easy to add to an existing LAN, as they are
more or less plug-and-play.

Tape Drive Servers

These servers use magnetic tapes to store large
volumes of data. They are great for high
volumes of data storage, but have slower read
and write speeds. Tape media is also a high-risk

Hard Drive Servers

Hard drive servers have fast read and write
speeds, and require less maintenance than tape
drives. However, the drawback here is cost, lack
of portability, and the maximum capacities.
Most companies use them as file servers for data
that requires constant access, due to the higher
speeds they offer. They aren’t as cost-effective as
tape drives, but are a lot more reliable. As far as
portability goes, even with a Hot Swap drive
server, the safest place to store the hard disks is
probably inside the server cabinet itself!

For a company that needs to have a short
turnaround time after a disaster, disk drives are
often the only alternative. As businesses turn
global, data is required 24/7, and not all compa-
nies can afford the time spent on backing up to
or recovering from tape servers. For such scenar-
ios, though more expensive, disk servers offer the
required data access speed, both while backing
up and while recovering lost data.

What Do | Need?

Now comes the hardest part—choosing a solu-
tion, or a combination of solutions, for your
company. There are three broad categories that
any business would fit into, based upon the
amount of data that needs to be backed up, and
the frequency at which backups are performed.
Let’s take a look at the three hypothetical
companies and their backup solution setups.

Small Business

Company A has two or three network servers,
and has less than 80 GB of critical data. Their
daily backup is less than 40 GB, and they require
archiving of data at least once a month. The
company has a per-user backup policy—each
user is solely responsible for backing up his or
her own data on the servers. The solution they
use is an additional network server with dual
hard drives running with RAID 1 configuration.
Backups are taken at the end of every working
day. At the end of the month, data for archiving
is manually burnt onto DVD media.

Company A runs personal software on every
user’s computer to back up data onto their
network file servers. Then, software on the
backup server copies the data from the network
servers—it is scheduled to do so about an hour

storage medium, as the media is frail, and
needs to be stored carefully.

Systems engineers also need to constantly
monitor the media and avoid overuse of a tape,
as this could lead to wearing away of the
magnetic layer and thus, loss of data. Also,
tape drives need to have regular maintenance
done, especially the heads that read the tape—
these need frequent replacement or cleaning.

The biggest advantage of tape servers has
always been cost. For volumes of data backup in
terms of terabytes, nothing beats tape on per-GB
cost. Also, the portability of tape cartridges
means that off-site storage of archived data is
easier, faster and cheaper.

looking more attractive, especially for offices. The advantage of this solution is

that your data is accessible from anywhere in the world—only to you. It is also the
most convenient in terms of ease of use and infrastructure. All you need to do is run
the provided software, select which folders you want backed up, and then back up
the data. There is no hassle about maintaining hardware. The drawbacks are that
you are dependant solely on your Internet connection, and you might not trust the
Internet for critical company data that may contain trade secrets, proposals, etc.

The costs are falling here too, but are still a lot more than using tape or hard
drives as backup solutions. If you do opt for this backup technique, make sure to
check for hidden costs, data redundancy at the provider’s end, encryption and
security, and, of course, company reviews and experiences.

Fifty GB of backup space can cost anywhere between Rs 80,000 and
Rs 3,80,000, depending on whether you need a single-user or workgroup backup
solution. Some online backup providers are: www.ibackup.com or www.xdrive.com.

Online Storage

ith broadband penetration in India increasing, online backup solutions are
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after the day’s work is completed. In the final
step, every month, backups are done manually
by a systems engineer onto DVD media.
Hardware

File server, dual RAID 1120 GB hard drives

One system with DVD writer and DVD media
Software

Personal backup managers

Professional backup application for servers
Humanware

One systems engineer

Medium-Sized Business

Company B has five network servers and needs
to regularly back up between 80 and 250 GB of
data. They generate or use over 80 GB of data a
day, and need it all backed up and stored safely
in case of a crash. This company relies solely on
its data to function.

Individual employees use the various
network servers to access work data. These
SCSI network servers have a capacity of about
120 GB each, and have external hard drives
connected to each server, taking hourly back-
ups of each server’s data. In addition, there is
a NAS for redundancy and failure protection,
which takes backups from the network servers
at the end of each day. All this data is then
backed up or archived on tape drive about
once a week. The tapes are stored in a separate
location, in order to enhance data security.
This entire cycle of weekly full backups
requires about five backup system engineers
to monitor and maintain systems.

Hardware

Three file servers with dual RAID 1 SCSI hard drives
Tape drive with tape cassettes

NAS device

Software

Personal backup managers

Professional backup application for the servers
Humanware

Five systems engineers

Corporate

Company C is a corporate company with offices
widely distributed across the globe. Let’s say
they have 10 worldwide offices, and all 10 need
access to about 80 GB of core company data,
apart from the backups of each office. The total
amount of data that needs to be backed up here
could be in the terabyte range. The company also
needs the backups done every hour, and effec-
tively works 24/7 due to the different time zones

I¥ Rough Estimates
Here’s what you are looking at in terms of costs, for implementation of the
backup solutions mentioned here.
Product Type Capacity Rupees Brands
Tape Servers DAT 40 GB 21,750 Dell, Seagate
DLT / Super DLT 80 GB 65,250 Quantum
LTO 400 GB 174,000 HP
Tape Libraries Super DLT, 8 slots 2.5TB 174,000 Dell
DLT, 100 slots 8TB 282,750 Quantum
LTO, 72 slots 28.8TB 391,500 Dell
Tape Media  DAT (19 GB per hr) 40 GB 522 TDK / Maxell / Fuji
DLT/SDLT (115 GB per hr) 320 GB 2,393 TDK / Maxell / Fuji
AIT (112 GB per hr) 260 GB 2,393 TDK / Maxell / Fuji
LTO (216 GB per hr) 400GB 1,740 TDK / Maxell / Fuji
RAID Servers Ultra ATA 1.2TB 165,300 lomega, Dell, HP
NAS SATA-150, Hot Swap 1TB 282,750 lomega, Dell, HP

of its branch offices. The central backup with
core company data is located in the head office.

Here, each individual office will have
backup systems akin to medium-sized busi-
nesses, with the only difference being that
specific data will be uploaded at pre-defined
intervals to the head office servers. Each office
will also have a NAS device as additional
backup security.

If the core data is less than 20 GB, and daily
uploads from each branch office are less than
300 MB, the company could opt for online stor-
age or online backup. This would make it easier
for the company to manage and share core data
securely and easily. It also reduces the required
infrastructure and manpower needed to moni-
tor and maintain an online server.

The alternative is to locate the online server
at the head office, under 24/7 monitoring by
systems engineers. Here, each branch office
needs about five engineers, and the head office
needs to have systems maintenance engineers,
security professionals, Web developers, etc.

Multiply the hardware and software require-
ments below by the number of branch offices
you have.

Hardware

Five file servers

A NAS

Two Automated Tape drives

ATlline

Online Storage

Software

Professional Distributed Backup Software
Humanware

@ Backup or Archival? A full-fledged IT department

People often do not understand the difference between backup and archival. Many Conclusion

small offices have a DVD-Writer as a backup solution for working data, and over- These three models broadly categorise all
spend on media. Due to these costs, backups are infrequent and loss of data may medium to large-sized businesses across the
mean an unacceptable setback of days. On the other hand, some offices may have a globe. Your business may be exactly like one of
server or external hard disk solution for archival purposes. This results in running these, or be somewhere between any two.
out of hard disk space and in deletion of archives. If you choose carefully, and wisely, you can

You need to identify whether your requirements are backup- or archival- use various combinations of the hardware and
based. A simple rule of thumb here is to use the previous self-assessment you software mentioned here to find a perfect
did: if your backup requirements are infrequent and less than 5 GB, you are backup solution for your requirements.

better off using DVD-R or DVD-RW media.

robert_smith@thinkdigit.com
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Vishal Maheshwari
Head, Yahoo! India Mobile

ahoo! India does not believe in

unsolicited, spamming on behalf of

advertisers. All communication is
pull-based—initiated by the subscriber.

Y! India Mobile currently has tie-ups with
all leading Indian cellular operators in India
including Airtel, Hutch, RPG, Escotel, Oasis
and Spice Telecom.

Yahoo! India uses its short code 8243, to
power advertiser’s SMS responses. Pull-based
marketing invites the customer to participate,
and it is non-intrusive.

Yahoo! aids a variety of marketers (ESPN,
Pepsi, and Motorola to name a few) to
establish an SMS-based communication link
with subscribers. And these clients have
reported 50 to 60 per cent conversions on sales
leads using the SMS medium.

Indian corporates wanting to exploit new media to reach out to customers, are increasingly
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relying on SMS to market products. How do they keep the line that divides marketing from spam?

Jayant Khosla
CEO, Bharti Cellular Ltd.
Mumbai Circle

Bhagirath

irtel uses SMS marketing to promote

its own services and products—

informing the customers of new
offers and value added services. SMS targets
audiences who are difficult to reach through
traditional media channels. The conversion
rates are as high as 80 to 90 per cent.

Over 1 million text messages are sent
every month, and SMS messages are always
read, making SMS a highly personal
communication tool. They can also be timed,
to achieve maximum impact.

Proper profiling is a must. For example, if
we want to communicate to young women
about attractive schemes, we use our database
to customise our message to suit her needs.

Mobile marketing is at a nascent stage in
India. Though there are no official figures
regarding SMS, according to industry
estimates, approximately 2 billion SMSs were
exchanged among Indian consumers in 2003.
This is much below the international average.

At Airtel, we don’t intend to exploit
our services as a medium to generate
additional revenue, but we are open to the
idea of providing our customers with value-
added services.

We are conscious of the difference between
spamming and providing information.
Messages that we pass on have information
that our subscribers can make use of.




Jiten Gandhi

Alok Kejriwal
CEO, Contests2Win.com

would not say that we do SMS marketing, but yes we are involved
in mobile marketing. We mainly do pull marketing. Here we
advertise using the conventional methods of print, TV, etc, and
give a number for interested customers to respond to.
This method of marketing is very effective. In fact, one of our
success stories is the Manhattan cards project which we did for
Standard Chartered bank. The entire campaign ran on 8558, and was

very successful.

As far as conversions are concerned, I cite the example of Aviva Life
Insurance. Because of mobile marketing, they have been able to get 200
leads a day, which would be quite impossible otherwise.

More recent examples are the figures available for Indian Idol—
American Idol got 30,000 fewer responses than Indian Idol! This proves
that Indians are more than willing to participate.

The mobile phone enables one to one communication with the
customer—certainly an advantage to businessmen. This form of
marketing is certainly more cost-effective than the conventional
advertising mediums. Responding to an SMS short code is much less of
a hassle than writing a letter, for example.

Viren Popli
Senior Vice President,
Wireless, STAR India

sing the mobile phone as a medium of marketing means

providing some benefits to the end consumer. This could

mean the ability to respond (votes, polls), interact,
participate (Contests), download (ringtones, games), etc, based on our
shows. STAR also provides its many clients with interactivity. We do
this by enabling their advertising through 7827.

Many of our customers only use SMS as a return path for generating
leads. Organisations that are so driven in this direction would confirm
that well-designed and integrated interactivity works, and works well.

As this is a personal medium, we try and individualise the
responses, keeping in view the activity, the potential customer
profile and similar factors. The advantages are that it is personal,
direct, confidential, immediate and digital!

This service is cost-effective and efficient, as it allows you to target the
potential customer without the attendant wastage. Also, it makes your
other media work harder to allow you to deliver specific results.

Most marketers use it for spam, which is wrong. They miss out on the
interactivity of the medium and all the attendant benefits. Since we do
not spam on the mobile platform, we do not have mailing lists. Our
whole service runs based on delivery of solicited information only. We do
not give mailing lists nor support such ideas even from our clients.

Harit Nagpal

Chief Marketing Officer,

Hutch

e believe that unsolicited communication, including

SMSes, invade the privacy of our users and is

tantamount to spamming. We do not have tie-ups with
any corporate or political bodies to sending bulk messages to our
subscribers, and do not intend to do so for any consideration.

E-mail: preethi_chamikutty@thinkdigit.com
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Are MFDs Better Than Standalones?

What works better in an organisational set-up? MFDs or standalone devices? The fight is on...

It is a little early to say that MFDs
are better than standalones

ediff.com is an online provider of news, information,

Rgommunication, entertainment and shopping servic-

s. By and large, Rediff.com wuses standalone
machines and prefer those over MFDs.

“Our standalone devices provide good scanning and
printing speeds, good colour reproduction and so on.
Scanning and printing is slower with MFDs. Moreover,
there is virtually no queuing with standalone devices as
the various machines print, scan and fax independently.

“With standalones, there is proper distribution of
equipment area, since one can divide and deploy work.
Moreover, downtime is considerably less with single-use
devices. For instance, if a printer develops problems, that
alone can be sent for servicing, and hence the functions of

With standalones, there is
proper distribution of
work area, since one can

divide and deploy work.
Moreover, downtime is
considerably less with sin-
gle-use devices.

Rajesh Kathuria,
Information Technology
Manager, Rediff.com

the entire department need not come to a grinding halt—
which is bound to happen in case an MFD malfunctions. As
a media organisation, our functions never come to a stand-
still, since all is not dependant on one piece of equipment.
We must have alternatives to resort to.

“Products that are properly maintained have delivered
value for money till date. Maintenance is 10 per cent
cheaper with a standalone machine.

“I feel that MFDs are appropriate for secretarial cadres
and extremely convenient for home users who need a print-
ing and faxing solution with a small footprint. It is a little
early to say that MEDs are better than standalone machines.
Improvements in technology and an increase in efficiency,
coupled with a drop in prices, will make MFDs more attrac-
tive to buyers—and single-use devices may one day become
a thing of the past.

“At the same time, one cannot deny the possibility of
standalone machines getting outdated due to consumers
demanding multi-functioning products. Nowadays, don’t
people prefer to buy a CD and DVD combo over a separate
CD-Reader and DVD-Writer?

“Having said that, I would still advise other businesses
to use standalone machines and not MFDs, since the
combo features have not worked well so far. By and large,
MEDs are not yet equipped to meet the rigorous demands
of professional work.”

MFDs work out cheaper, and are
easier to operate

stablished in 1995, Spanco Telesystems and Solutions
ELimited is a networking and systems integration

solutions company, with offices in Mumbai, Pune,
Gurgaon, Kolkata, Bangalore, Lucknow and Guwahati.
Spanco prefers MFDs over standalone devices.

“We use MFDs because they offer an all-in-one solution,
centralised technology, ease of maintenance and a
smaller footprint that saves space. Moreover, MFDs work
out cheaper than single-use solutions. An MFD combines
all the essential features otherwise provided by separate
devices into a single, convenient desktop unit. Indeed, an
MED offers all the benefits that standalone machines offer
such as copying, printing, faxing, scanning and
telephone—plus optimal utilisation of relevant features.

For general applications, scan-
ning, printing and faxing
through MFDs is as good as
that offered by standalone
machines. However, for spe-
cialised usage, standalones
serve the purpose better. =

Deepak Bhagchandaney

1ypuen uayr ydeigoloyd

Director, Sales and Mktg, Spanco

Telesystems and Solutions Ltd

“Shifting from single-use machines to MFDs was a
drastic change. We took some time to adjust, and also had
to train the operations staff. The major benefit we have
seen after shifting to MFDs was ease of operation. It is a
really a big boon—there is no more running to and fro as
all the work is done at one place. This obviously saves time
and has led to higher productivity.

“The main advantage of MFDs is multi-location usage;
they can be conveniently used in the office or at home. For
general applications, scanning, printing and faxing is as
good with standalone machines. However, for specialised
usage, standalones serve the purpose better. For instance,
the quality of the zoom and sorter feature in our MFD’s
scanner is almost same as that of a regular office-use
scanner. The image quality and resolution in printing is as
good as that of a regular office-use printer. However, the
memory capacity of an MFD is lower.

“I feel that MFDs and standalone devices have their
own target markets and complement each other—there is
no question of competition. MFDs are reliable and never
completely break down; any issues with specific functions
are taken care of by the service network of the vendor.

“Since we have deployed MFDs very recently, there have
been no maintenance, upgradation or downtime issues so
far. Of course, it is advisable to have multiple MFDs if the
user base is large.”

As told to Renuka Rane (renuka_rane@thinkdigit.com)
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Touched By Tech

And Then, There Was Light

Computer education at Mumbai’s Helen Keller Institute for Deaf and Deafblind helps
students become economically independent and helps them communicate effectively

“A person who is severely handi- bet on your palm and tap your “HiZamir.”
capped never knows his own hidden wrist to signal the end of each  “Hello.”
source of strength until he is treated word. After this novel exercise in  “How are you?”

like a normal human being and palm printing follows an interac- “I am doing fine.”

allowed and supported to shape his tive session on the computer. “Tell me more about yourself.”

own life—for life is either a challenge “I first came to the Helen Keller

and an adventure or nothing at all.” Institute for the Deaf and Deaf-
- Dr Helen Keller blind when I was 12...”

Does this resemble a chat tran-
script? Actually, it is a written
dialogue in MS Word, with Zamir
Dhale, who is deaf-blind. Dhale
cannot use the mouse, can’t see
the monitor and neither can he

Renuka Rane

hey gently feel your hands,

I your watch, the shape of
your fingernails and the
texture of your skin. Their hands

talk and are, in effect, their eyes.
_ They write the letters of the alpha-

Imaging Jayan Narayanan

Photographs Jiten Gandi
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Bl Twelve different types of greeting
cards for special occasions such as
festivals, birthdays, and so on.

DI A unique all-time desktop calendar
of inspirational thoughts.

B1101 amazing science experiments and
brain tickling activities for students.
DIHuman anatomy Atlas.

DIAn India Atlas titled ‘India at your
Fingertips’.

DIBooks in Braille and large print so
that deaf-blind and low-vision students
can read them. These include Who
Moved My Cheese, the Chicken Soup
series, Indian Cookery and Light From
Many Lamps.

R7d Productions of HKIDB’s Computerised Mini Braille Press

Attractive educational material in Braille with tactile graphics

D1 Braille labelling, another upcoming income-generating line.

112

hear any instructions. Yet, he does
not falter or hesitate while work-
ing on the computer.

Dhale is an assistant computer
trainer at the Helen Keller Insti-
tute for Deaf and Deafblind
(HKIDB), Mumbai, a pioneering
institute in India and Asia in the
education of the deafblind. In
1977, founder Beroz Vacha and
two  other teachers—Diana
Fernandes and Brinda Nanavati,
started with just three students
and a meagre Rs 150. At the time,
services existed for the deaf and
blind separately, but none were
available for the deaf-blind.

In 1979, they moved to the
present municipal school at
Byculla. HKIDB provides early
education services for deaf-blind
children, a school for older
students, vocational training for
rehabilitation and a teacher-train-
ing course. Most of the students
come from the lower strata of
society, but from families with a
vision of their children having
access to adequate educational
facilities and happy futures.

The Legacy Of Helen Keller
Dr Helen Keller (1880-1968) who
paved the way for educating the
deaf and deaf-blind, was herself
deaf-blind. Says Vacha, “I believe
that there is no dearth of good-
ness in this world. Our strength
comes from Helen Keller’s legacy.
Our belief that ‘No one is inca-
pable of being educated, loved
and accepted with dignity; it is
the fundamental birthright of
every child to be educated, loved
and accepted with dignity’ has
served us over the years. Our
students think, ‘we can because

Y

we think we can’.

The deaf and deafblind have
differing degrees of both vision
and hearing loss, that could be
accompanied by other debilitating
conditions such as mental retar-
dation, cerebral palsy and seizures.
A deafblind child, due to the
combination of hearing and visual
handicaps, needs a specialised,
individualised programme that
will help him or her function
better. By and large, HKIDB has a
1:1 teacher-student ratio.

HKIDB follows the philosophy
of total communication—oral,
aural, manual, print, mime and
dance that helps improve cogni-
tive levels, thus enabling free
modes of self-expression.

Why Teach Computing?
The educational curriculum at
HKIDB aims to develop a student’s
literary and academic skills
including reading and writing,
cognitive skills (reasoning, atten-
tion to tasks, memory, retention,
cause and effect), motor skills
(such as hand-eye coordination),
perceptual skills, orientation and
mobility. So far, these skills were
taught the old-fashioned way,
using books or charts in Braille.

Computers have become a vital
part of the modern education
process. Some children with deaf
blindness are disinclined to
explore their environment—
computers motivate such children
and improve concentration. Soft-
ware with attractive visual and
auditory features encourage low
vision or hearing impaired chil-
dren to use their residual vision
and hearing—larger fonts enable
children suffering from low vision
to read comfortably.

Vacha says, “How long will the

Computers
have become a
vital part of
the modern
education
process for
the deaf-blind
students

as well

deaf and deafblind earn a living
making flowers, candles and paper
bags? They are not lesser mortals!
They can be as competent as the
next person if given the right
chance. Don’t they have an equal
right to be computer-savvy? Deaf-
blind children are bright and have
tremendous potential for educa-
tion and work. Computer literacy
enables children with disabilities
to lead a normal life.”

Former students Zamir Dhale
and Pradip Sinha (both deaf-blind)
insisted on learning computers.
Both are now computer training
assistants at HKIDB.

The Cybernetic Approach
“Language is the channel through
which you become expressive.
Language acquisition takes place
almost automatically and in due
course for people with normal
vision and hearing. However, the
deaf and deafblind must first
learn to communicate using
language before they can move on
to using technology.

“But, how do you expect a deaf-
blind person to use the PC or even
the typewriter without knowing
the alphabet? For that, they must
first learn to communicate
through sign language, palm-
printing, writing and reading in
Braille,” adds Vacha.

She reflects, “Most suggestions
centred on imprinting the tactile
Braille script on the keyboard.
Again, that would mean under-
mining their intelligence. I
insisted that all the deafblind
learned touch-typing, a pre-requi-
site to operate the keyboard. While
our aim is to work effectively with
electronic technology, we cannot
afford to ignore manual technol-
ogy such as the portable ‘Brailler’
that teaches alphanumeric typing
in Braille. We essentially follow a
cybernetic approach.”

Teaching With Tender
Loving Care

Katy Gundevia has been teaching
English and other subjects at
HKIDB for three years. She says,
“My initial reaction when I
was faced with the prospect of
teaching them was—how can I do
it? I learnt palm printing and
sign language. On hearing that
we would soon use computers, I
was instantly relieved! The famil-
iar sight of the PC was encourag-
ing. It is now easier to
communicate with students
through computers.”

DIGIT MARCH 2005




114

Digital Leisure | Touched by Tech

The students are very enthusi-
astic about using computers and
often try to monopolise the
machine! They are taught the aids
and appliances necessary to oper-
ate the computer—starting with
the typewriter to learn touch-
typing, followed by the Perkins
Brailler (a special Braille type-
writer) and finally moving on to
the computer keyboard.

The deafblind and the blind
cannot see the monitor and the
mouse serves no purpose either.
This is where the electronic
Braille display board comes in.
This display board indicates each
and every change that takes place
on the monitor.

The deafblind and the blind-
can understand these changes by
moving their fingertips across the
cells on the display board, which
are in Braille.

The Braille cells move as data
is entered through the keyboard
enabling the deaf-blind to read
the text on the screen, manoeuvre
accordingly, make changes and
even e-mail, surf and download
content from the Internet.

The Computerised Mini
Braille Press

An integral part of HKIDB is the
pioneering Computerised Mini
Braille Press project, set up in
January 2002. Here, the deaf and
deaf-blind are trained to use
computers and  undertake
computer-related programming
and designing. This computer-
training unit-cum-mini braille
press produces a variety of mate-
rials to suit the needs of the deaf-
blind/blind/low  vision/sighted
and hearing individuals.

The deaf students are trained
in graphic design and produce
tactile graphic educational mate-
rial. While, the blind, those who
are proficient in Braille, help in
proofreading. The newsletter Deaf
blindness in Asia: A Communication
Link is composed and published by
the Braille Press and is circulated
among all centres for the deaf-
blind in Asia, Europe and other
parts of the world.

Vacha says, “The success of our
Computerised Mini Braille Press is
thanks to the contribution of the
Rangoonwala Foundation, UK. We
also owe a debt of gratitude to the
British ~ High Commission,
Christoffel Blindenmission and
other donors. We are equally
grateful to our trainers for their
efforts to teach the students.”

The Process

A software called JAWS (Jobs
Accessing With Speech) enables
the blind (who have normal hear-
ing) to use computers by listening
to the audio instructions.

JAWS is also essential for
synthesising text or commands
on screen into Braille, which then
appear on the electronic Braille
display board. The deaf who have
normal vision work on graphics
using CorelDraw, while the print-
ing and the packaging jobs are
looked after by the deaf-blind.

Computer trainer Devyani P
states, “We had nobody to emulate
and had to start from scratch. We
researched a lot to produce mate-
rial in Braille and normal print.
We started with greeting cards.”

Tools And Techniques
The Duxbury Braille Translator
(DBT) is a software that translates
text, say, from MS Word, into
Braille. Printouts in Braille can
then be taken through an
embosser. Even those who do not
know Braille, can type in regular
English and print in Braille, which
otherwise would be time-consum-
ing and tedious even for those who
can write in Braille.

Picture In A Flash (PIAF) is a
piece of hardware that produces
excellent tactile graphics.

However, the A3 paper required for

Don’t the
deafblind
have an equal
right to be
computer-
savvy?
Computer
literacy
enables them
to lead
normal lives
Beroz N Vacha
Director and
Consultant, HKIDB,
Mumbai

e — -

Picture In A Flash or PIAF is used to print tactile graphics

PIAF is costlier as compared to the
one used on the Tiger Advantage
machine, another output device
that prints tactile graphics. But
the printouts from the Tiger
Advantage machine are no match
for the PIAF ones that are more
distinguishable and attractive.
The equipment used at the
Braille press is expensive—a single
electronic Braille display board
costs an astronomical Rs 2.5 lakh!
Prices of other equipment range
from Rs 50,000 to Rs six lakh.

At The Workshop

Assistant computer trainer Pradip
Sinha (25) is a father of five. His
family is in Kolkata, while he stays
in Mumbai, as the facilities
provided by HKIDB are not avail-
able elsewhere.

A Devkumar (25) who is deaf,
is the DTP operator. The hearing-
impaired but extraordinarily
talented Mahesh Joshi (31) and
Dhirendra Dubey (27) are graph-
ics designers. A first-year B.Com
student, Aarti Shetty (20) is hear-
ing-impaired and works as the
data-entry operator. Naina (30)
was diagnosed with juvenile
diabetes and her vision and hear-
ing is on the decline. She says, “In
seven months I have learnt
Braille, computers, candle and
perfume making and other crafts.
I am glad to be independent.”

Incidentally, Dhale (27) is one
of the people responsible for teach-
ing Amitabh Bachchan manual
communication for the deafblind
for the film Black, where the Big B
plays the teacher of a deaf-blind
girl. Sanjay Leela Bhansali and his
team visited HKIDB to study the
characteristics of the deafblind.

Income Generation

Balaji ], administrator at the
Braille Press, says, “Our assign-
ments range from printing
stationery, brochures to educa-
tional material. These assignments
help us disburse stipends and
salaries to the deaf and deaf-blind
who work in the Braille press.”

Their clientele reads Sunchem
Corp, Sauradip Chemical Indus-
tries, Fine Stitches, Tankaria Exim,
Shreepaul and Company and vari-
ous other firms. They recently
completed an assignment for the
Mumbai District AIDS Control Soci-
ety—a brochure in Hindi and
English with 5,000 copies in
normal print and 10,000 in Braille.
They received a work order for
2,500 copies from Dignity Founda-
tion. At present, they are working
on asafety introduction manual in
Braille for Jet Airways.

At exhibitions and displays of
the Braille Press products, visi-
tors are stunned to see the deaf
and deaf-blind expertly handle
computers. Through learning
and using computers, the physi-
cally handicapped can become
contributing members of the
society and lead successful lives.

For more information, visit
www.helenkelleridb-mumbai.org. &

renuka_rane@thinkdigit.com
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Too dumb for a smartphone?

Increasing device complexity is no laughing matter

Rashmi Bansal

There was once a man with a cell
He loved it wisely and well

Then he traded it in

For a shiny new thing

And now he is going thru hell!

of every second person who
decides to ‘upgrade’ to a new,
feature-packed cellphone.

One day you are perfectly
happy with your trusty two-year-
old handset—it does the two
things that a phone really needs
to do, call and SMS! The next, you
are seduced by a younger, slim-
mer model packed with a dozen
oh-so-cool features.

You feel vaguely guilty about
coughing up Rs 20,000 for a palm
sized contraption—an amount that
could buy you a full size fridge, two
21-inch colour TVs, or three
microwaves! But when was there
ever a sense of logic in lust?

Two months later, the passion
cools. Your new companion’s asli
roop is now evident—high on main-
tenance, low on efficiency. The
phone is too complicated to use!
And no, this conclusion isn’t a case
of sour grapes—I speak not from
envy, but from experience.

Take the simple task of text
messaging. On my ancient Nokia
3310 it took three lightning quick
finger flicks. On my new Nokia
6670, initially it took me six
keypresses, and not all the buttons
were close enough for comfort.
Eventually, I learnt to do it in four,
and then, hallelujah, I discovered
a one touch option.

OK, so I didn’t—a junior office
colleague who happens to be an
alpha geek figured it out for me.
He’s the kind of guy Wired maga-
zine would describe as ‘techno-
sexual’. The difference between
technosexuals and ordinary
mortals can be summed up in
three quick observations:

Dl Technosexuals are never ‘too
lazy’ to read user manuals—even
if they are the size of telephone
directories, which is what
smartphones will soon be
accompanied by!

D ‘Fiddling around’ is harmless
fun for technosexuals. Ordinary
mortals end up deleting their

Sounds familiar? It’s the story

B,
- ’% Illustration Shyam Sriram

I guess the first phonebooks, and no, we don’t

generation of
smartphone
users will be
the bakras who
will help
companies
figure out what
it is people
really want

have backups!
Bl Technosexuals love complexity.
The rest of humanity just gives up.

This is a species which will
skimp on everything else, but own
the latest, jazziest gizmo. One such
member of the geekerati, a student
I know, has a call centre job. He
sports a Rs 30,000 Sony Ericsson
S700i, but isn’t concerned about
the holes in his socks.

The engineers who design
smartphones probably share this
profile. And so, they end up design-
ing instruments that are compati-
ble with folks like themselves.

So why did I buy a smartphone?
Partly because of peer pressure. I
had the oldest and ugliest phone
amongst anyone I knew—partially
chipped after kissing the ground a
few hundred times. But mainly, I
picked up the Nokia 6670 for its
one-megapixel camera. The with-
you-at-all-times factor made the
camera phone a must have.

Although Imust say I am pretty
satisfied with its picture quality,
the same can’t be said about the
way the camera functions. It does
not respond as rapidly as a conven-
tional digital camera. What’s
more, downloading the pictures is
a pain. The data cable just refused
to connect the computer and

phone. A simple but maddening
case of loose connections.

To make matters worse, some
of the pictures got mysteriously
corrupted. Eventually, the entire
multimedia card (MMC) died. It
most likely needs to be formatted,
and of course, all the stuff on it I
tried to back up will be lost forever.

Connecting to GPRS was
another nightmare. Simply saving
the settings sent by my cellphone
provider was not enough. I had to
actually visit the provider’s store
where an executive explained that

| my phone required ‘advanced’
: settings. Hidden somewhere deep

inside the menu!

Is it any wonder that a recent
survey in Europe found that 85 per
cent of consumers admitted to
being ‘too dumb’ to access or use
mobile services—mainly due to
increasing device complexity?
Nearly three quarters feel that
handsets have become ‘too difficult
to navigate’. Another study found
30 per cent of participants rated
‘not knowing what features are
available’ as their top complaint.

Bottomline: There’s so much
packed into the average smart-
phone that basics often take a
backseat. On the Nokia 6670, the
green and red buttons generally
used for making and ending calls
are designed for a circus midget’s
fingers! And yet, overall, these
phones are generally bigger and
bulkier than average—you don’t get
that comfy palm-it feeling.

I guess the first generation of
smartphone users will be the
bakras who will help companies
figure out what is it that people
really want. In the interim, they
need to help users figure out what
the technology in their hands can
really do. I mean, if refrigerator
companies can send a guy home to
give a ‘demo’ (I kid you notl), surely
handset makers can do the same?

Until then, scream for help!
There are always alpha geeks lurk-
ing, dying to rescue the ‘damn cell
in distress’.

Rashmi Bansal is founder-editor of the
popular  youth magazine JAM
(www.jammag.com). She can be
reached at rashmi@jammag.com
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Tiger Woods PGA Tour 2004

TWPT2004 PROMISES A whole lot of family fun, and
is addictive and innovative. But even more
commendable is that the game is extremely
welcoming to rookies while also having enough
goodies to keep the fanatics coming for more.

So what does 04 have that '03 doesn’t? Tons!
TWPT offers the virtual golfer 19 different courses
that include some already-seen world-class ones. It
also offers five new PGA sites (15 in all), two fantasy
locations, and 12 characters. It carries the extra load
of several new game playing modes—Alternate Shot,
Stable Ford Scoring, Best Ball, Long Drive Shootout,
and Battle Golf.

On the great Game Face mode: this is where you
dabble with the image of your virtual golfer. There
are over 40 slide bars controlling numerous
features, such as bone density, body mass, chin and
jaws, eye/hair colour and shape, to name just a few.
Tons of accessories, from cowboy hats to tattoos, are
available to jazz up your golfer.

Another big addition is of course a real PGA
Tour. If °03 lacked anything, it was this. '04 offers
your golfer the chance to participate in a full PGA
tour, with over 30 four-day events.

Your golfer starts his career right down at the
bottom—you begin as a true rookie. Solace lies in the
fact that a challenge’s difficulty is proportional to
your golfer’s talent. It would be advisable to spend
time practising, just to see what your golfer can do.

Money is definitely important, providing you
with access to tons of goodies at the Pro Shop. From

animations to best represent your moods, to hats,
clothes, faces, hairstyles, clubs, sunglasses etc, you
can have a ball splurging the green.

The graphics are near-perfect. The tracks used in
TWPT2004 are better than before, but still rely on a
lot of rap, with the likes of DMX and Roscoe. The
best part though, has to be the sound of your club
smacking the ball in perfect synch with the
animation on the screen. It truly gives you the feel
of having hit one helluva shot.

This game definitely gets our ‘Highly
Recommended’ stamp on it.

TechCritique

Tiger Woods PGA Tour 2004

Publisher EA Sports

Developer Headgate Studios Inc

Web site www.easports.com/games/tigerwoods2004

System requirements 333 MHz CPU, 128 MB RAM, 16 MB video card,
1.3 GB free hard disk space

Distributor Gayatri Impex

Price Rs 1,299

The Great Escape

AS FAR AS raw material goes, the
premise for The Great Escape is right up
there with the best. You’ve got one of
the greatest escape flicks ever made,
populated with ultra-cool actors. You've
got a series of intricately planned
diversions, lots of stealth sequences,
and a frantic dash towards freedom
across hostile territory at the end.

\

1. Half Life 2
Rs 1,499
Milestone Interactive Software Pvt Ltd

The Great Escape is almost
completely a stealth-based third-person
game. If you have not seen the movie
(you should), it involves a group of
daredevil WW II POWs who attempt to
break out of a maximum security
camp in Germany. All-out action is
present only on the few occasions
when you get a weapon or vehicle to
use. Think of this game as Splinter Cell,
but without the weapons, neat-o
gadgets, graphics, gameplay, and fun.

The in-game sound effects and
music tracks are passable. All guns
sound the same—big guns make
bigger noises.

Coming to the missions
themselves, they don’t differ too
much. You hardly ever get weapons,
so most of the time, you have to
sneak around and avoid the guards.
Your objective is mostly to talk to
people, sneak around, get items, talk

to them again, get directed to some
more people, get more items, and
keep repeating until the game
decides it’s had enough of you. It’s
just like an adventure game, without
the adventure in it. It wouldn’t

have been so bad were it not for the
horrid controls.

There is always just one and only
one way to complete your objective.
The only choice you have to make is
whether you’ll strangle that patrolling
guard or simply sneak past him. In a
stroke of pure evil, the game’s
designers decided that to strangle a
guard, you’ll need to sneak up behind
him, then mash the mouse button as
fast as you possible can. Some guards
are harder to strangle than others,
which means that you’ll have to hit
that button even harder and faster.

There is no compelling reason
to play The Great Escape, unless

2. NFS Underground 2

Rs 1,299

Gayatri Impex Pvt Ltd
3. Doom 3

Rs 1,499

World Wide CD-ROMS
4. Tribes Vengeance

Rs 1,299

Milestone Interactive Software Pvt Ltd
5. FIFA 2005

Rs 1,299

Gayatri Impex Pvt Ltd

you are on the endless quest of
playing every game you can get your
hands on.

The Great Escape

Publisher SCi Games

Developer Pivotal Games

Web site www.thegreatescapegame.com

System requirements 933 MHz CPU, 128 MB RAM, 32

MB video card, 1.6 GB disk space, DirectX 8.0
Distributor e-XPRESS Interactive
Price Rs 499
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Got an
interesting
question?

Send it in with
the answer to
editor@thinkdigit.
com

Worms And Black Thumbs

Yahoo! Inc. PR FIOO!

started as a
Web link page compiled by two
graduate students at Stanford.
What was its original name?
a. Jerry’s Guide to the
World Wide Web
b. Yet Another Hierarchical
Officious Oracle
C. The Best Darn Link
List on the Web
d. FiloAndYang.com

Tech guru Bill Joy recently

joined venture capital firm
Kleiner Perkins Caufield & Byers
which had helped set up a
technology bellwether that Joy co-
founded. Name the company.
a. Oracle Corp. b. Sun Microsystems
¢. PalmSource Inc d. eBay Inc

China’s ministry of information

industry reported a 24 per
cent increase in mobile phone sub-
scribers since 2003. What was the
total number of reported mobile
phone subscribers in China in 2004?
a. 60 million b. 127 million
€. 198 million d. 334 million

Name Microsoft’s home-

grown search engine that has
indexed five billion Web pages,
gives direct answers to factual
questions and contains tools to
create detailed queries.
a. Microsoft Search b. MSN Search
€. MSN Online d. MSN Beta

The Internet Corporation for
Assigned Names and Numbers
(ICANN) plans to choose the next
registrar of Internet domains
ending in .net in March, subject to
approval by the Commerce
Department. How many .net
addresses currently exist?
a. 15 million b. 10 million
c. 5million  d.1million

Name the recent $30 (Rs
1,300) book by Jesse Torres
and Peter Sideris that offers
solutions to problems faced by PC
users.
a. Surviving PC Disasters, Mishaps
and Blunders
b. Surviving PC Disasters
and Mishaps
¢. PC Troubles
d. Surviving Your PC

Doctors in the US and UK
warn that repetitive use of
this device, mainly when typing e-
mail or text, can harm tendons or
cause osteoarthritis in the thumb.
a. PalmOne Tungsten T5
b. Nokia 9210 Communicator
c. Blackberry d. Nokia N-Gage

0_ is now an ICANN-
accredited registrar of domain
names. The organisation can now
sell names in seven top level
domains, or TLDs, including .com,
.net, .org, .biz, info, .name and .pro.
a. Go Daddy b. Yahoo!

c. AOL d. Google

Across

reed mat (3,4)

systems (4,3)
attention (6)
sets (6)

tan mine (7)

Environment
(abbr) )

dashes (5)

1.2002 computer virus (7)

5. Short for abnormal end (5)

7. Electronic Code Book (abbr) (3)
8. Ethical hacker destroys

9. Sony’s implementation of a
standard IEEE 1394 (1,4)

11. Windows NT server (abbr) (4)
12. ‘Dock’ in Apple operating

14. Audible warning seeks user’s
16. Japanese cellular telephone
19. Cartoon images upset

21. Computer savvy person (4)
24. Magnitudes of two quantities (5)
26. Xerox’s e-paper? (7)

27. Distributed Computing

28. Signaling code of dots and

29. Ward off a virus (7)

Down

1. Cause combustion to
write on a CD (4) .
2. Compatible text editor
for the GNOME

desktop environment (5)
3. One of the items in g
data array (7) “
4. Unlikely distant host
server (6)

5. Advanced Basic e
Input/Output System
(abbr) (5)

6. Emergency position-
indicating rescue
beacons (abbr) (5) »

B 3 B ©
10

10. A frog is a file

transfer and terminal
emulation

programme from Columbia
University, we hear (6)

13. Packet of address information

destroys ‘drag a mat’ (8)

(abbr) (3)

17. Internet relay chat programme

15. Enterprise Application Integration

for Linux users (7)

18. Accounting journal is a horizontal
gravestone (6)

20. Positive electrode in a circuit (5)
22. Microsoft’s spreadsheet
programme (5)

23. Jump if Not Less or Equal

(abbr) (4)

25. Short for Tape Archive (3)

Which newly inaugurated legal
firm provides free legal
support to Free and Open Source
Software (FOSS) projects?
a. Free Software Legal Cell
b. Software Freedom Law Centre
c. Software Freedom Legal Cell
d. Open Source Law Centre

Teenager Jeffrey Lee Parson
was sentenced to prison for
unleashing a variant of the
Internet worm that debilitated
nearly 48,000 computers in 2003.
a. Blaster
b. Santy
c. CabirT
d. MyDoom.AM

1. Jerry’s Guide to
the World wide

6. Surviving PC
Disasters, Mishaps

Web and Blunders
2. Sun Microsystems 7. Blackberry
3. 334 million 8. Google
4. MSN Search 9. Software Freedom
5. 5 million Law Centre
10. Blaster

A. ccording to Skype founder
iklass Zennstrom, Skype’s

VoIP application currently
has 13 million users
worldwide, in more than
200 countries with 80,000
new users signing up daily. ‘

Send in
your
answers
to the crossword to
TQ@thinkdigit.com.
If you get them all
right, one lucky partici-
pant will win a
Professional Java Programming By Brett
Spell, published by Shroff Publishers

Last Month’s Solution
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MediaWise

PC Mag, February 2005
Groping In The Shadows

FOR MOST TECH readers across the world, John C
Dvorak is the most respected columnist. Want proof?
Here is a column he wrote for pcmag.com in February.

Last Tuesday’s massacre, when Microsoft released a
whole slew of patches, begs more than a few questions.
First of all, why can’t the company consolidate multiple
patches that seemingly do the same thing? And second,
isn’t it about time that we all got a new free operating
system that incorporated all the dozens of patches that
have been released? The main reason I ask for this is
because when | visit my add/remove programs subsystem,
the Microsoft patches clog up the list-to an extreme.

Now before I go into exactly how Microsoft can get us
all one free clean 0S, | have to also mention last Tuesday’s

Put it all together with Outlook Live.

nd manag nal calendars, addresses,
place

mma > Columns > John sk > Microsofs Updatos: Out of Control

Microsoft's Updates: Out of Control
a2.07.05 * Continued
P Y

By Jobn €. Duorak
Last Tuesday's massacre, when Microsoft released a whele slew of patches, begs more than a few
questions. Firct of all, why cant the company consolidate multiple patches that seemingly do the same
thing? And second, isnY it about time thal we all got a new free operating System that incorporated all the
dozens of patches that have been released? The main reason | ask for this is because when | visit my

weird new patch called the “Malicious Software Removal
Tool.” This is the first “tool” that I recall showing up in the
Windows Update list. | could be wrong, since there have
been so many updates, but most of them seem to be
security patches rather than full-blown software tools. The
question is whether you should even install this new tool.

The Malicious Software Removal Tool is primarily an
antispyware product. People who have used the tool and
reported on its functionality, say that it never tells you what
spyware it is actually removing. The problem I have with it
is the concept that it only removes “malicious” spyware.
Does this mean that it leaves all those ad-tracking spyware
systems installed? Surely they are not meant to be
malicious. And since Microsoft sells advertising a la Google
on its search engine, it seems unlikely that they’d want to
kill that advertising “feature.” This seems to explain, to me
at least, why the tool doesn’t do any detailed reporting. Ill
pass, thank you, and stick with the various commercial
products that do give me the details.

Apparently, the tool is kind of spyware itself, since it
reports back to HQ with data on what it has done on your
machine. It’s not that I care that Microsoft has a huge
database of spyware infections and their relative
popularity. It’s just that I have yet to see what good any of
this has done me. They never release the data. So what’s
the point? The company’s argument that it collects this data
so it can do a better job doesn’t wash with me, given how
secretive Microsoft always tends to be. For all | know they
are going to push some spyware out there themselves and
market it as foolproof.

Want to read more? Visit snipurl.com/digit_dvorak
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Wired magazine, February 2005

The Fox Is Lurking

A MONTH AFTER
the Firefox browser
was released, it
already raked up 10
million downloads,
making it one of
the fastest growing
software in the
world. Wired
magazine profiles .
Firefox, which is a : S
culmination of a collaborative effort of thousands of
programmers the world over.
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The Firefox Explosion

For Rob Davis, the final straw came during a beautiful
weekend last summer, which he spent holed up in his
Minneapolis apartment killing a zombie. The week before, a
malicious software program had invaded Davis’ PC through
his browser, Internet Explorer, using a technique called the
DSO exploit. His computer had been repurposed as a “zombie
box”—its CPU and bandwidth co-opted to pump reams of
spam onto the Internet. Furious, Davis dropped out of a
planned Lake Superior camping trip to instead back up his
computer and reformat his crippled hard drive. Then he
vowed never to open IE again.

Lucky for Davis, a new browser had just appeared on the
scene—Firefox, a fast, simple, and secure piece of software that
was winning acclaim from others who also had grown
frustrated with Internet Explorer. A programmer friend told
Davis about Firefox. He didn’t know that the browser was an
open source project and a descendant of Netscape Navigator
now poised to avenge Netscape’s defeat at the hands of
Microsoft. He just knew that he didn’t want to waste another
weekend cursing at his machine. So Davis drove to the friend’s
house and copied Firefox onto his battered laptop. He hasn’t
had a problem since—and now he’s telling anybody who will
listen about Firefox’s virtues. “I'm no anti-Microsoft zealot, but
it’s unconscionable that they make 98 per cent of the operating
systems in the world and they let things like this happen to
people,” says Davis, a PR man by day who liked Firefox so
much that he initiated a fundraising campaign to help promote
the browser. “There’s a lot of pain out there.”

Firefox couldn’t have arrived at a better time for people
like Davis—or at a worse time for Microsoft. Ever since Internet
Explorer toppled Netscape in 1998, browser innovation has
been more or less limited to pop-up ads, spyware, and viruses.
Over the past six years, IE has become a third world bus depot,
the gathering point for a crush of hawkers, con artists, and
pickpockets. The recent outbreak of malware—from the
spyware on Davis’ machine to the .ject Trojan, which uses a bug
in IE to snatch sensitive data from an infected PC—has
prompted early adopters to look for an alternate Web browser.
Even in beta, Firefox’s clean, intuitive interface, quick page-
loading, and ability to elude intruders elicited a thunderous
response. In the month following its official November launch,
more than 10 million people downloaded Firefox, taking the
first noticeable bite out of IE’s market share since the browser
wars of the mid-"90s.

Excited about reading more on the Firefox revolution? Go to
snipurl.com/digit_firefox



New York Times, February, 2005

The Top Trends At CES 2005

CHARLES HEROLD OF New York Times says old arcade
favourites are making a comeback. And how!

Imagine that every few years, the technology to broadcast
television changed so radically that everything produced up until
that time could no longer be shown. No more reruns of The Mary
Tyler Moore Show, no more old Marx Brothers movies. You could
only watch entertainment produced in the last two or three years.
That is exactly what happens with computer games, where new
technology is often incompatible with old games, turning great
games into forgotten ones.

Happily, games are sometimes resurrected. Old arcade games
like Centipede and Pac-Man have been released both for play on
newer machines and in
inexpensive devices you
can plug into your
television. Occasionally,
something less ancient is
resurrected, as when the
original ‘Resident Evil’
was refurbished with
slicker graphics for the
GameCube. Recently, Sid
Meier’s 1987 game
Pirates!, a collection of
minigames representing
various aspects of pirate
life—battling ships,
treasure hunting, trading
goods, sword fighting—
was completely remade
for the modern PC.

Different gamers are
excited by different
rebirths, and for me, the
bhiggest thrill has been the restoration of one of the oddest and
most original adventure games ever made, Pulse Entertainment’s
1996 game Bad Mojo, newly dubbed Bad Mojo Redux.

Bad Mojo begins as a scientist about to skip the country
with his research money is inexplicably transformed into a
cockroach who must make a perilous journey through his
landlord’s squalid apartment.

Mojo has a high gross-out factor, as you crawl over dead
rats and half-eaten TV dinners trying to find a way around
deadly hot-water pipes and roach traps. As you travel, you
encounter slugs and water bugs that recite obscure passages of
prose that contain clues to the game’s puzzles.

As you wander through vast kitchens and under giant beds,
you crawl over letters and photographs, learning about the
landlord’s tragic past. The game becomes increasingly surreal:
photographs of eyes blink when you approach them, and
visions hint that you are on some sort of spiritual journey.

The game’s puzzles are generally straightforward,
involving your limited ability to affect small objects, moving a
cigarette butt or triggering an answering machine by walking
on the Play button. There are a couple of more elaborate
puzzles, but they tend to be based less on logic than on a
spacey sort of synchronicity.

Technology ‘
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Read the full piece at www.snipurl.com/digit_games

AdWise

A THOUSAND MORE WAYS TO

ORANGE

[«] Epson sees into the future?

A beautiful photograph, but all we could think of was how
Epson tested that the photograph remains “smudge-free
for more than 100 years!”

THE ANSWER IS X

A
ARE YOU JUST ONE STEP AWAY

FROM DISASTER?

INTRODUCING THE PX720. b
v
THE ANSWER IS X.

Data pratoction you can tst. - .

Quantum.

ot - The Answer = X

o v thennymer com.

(OLr: e 2

[l Nooo! Leave the poor fishy alone!

A great visual, an even better punchline, but all we want to
know is, “Did the poor fish survive the photo shoot?”. Quick,
someone call PETA!
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Taking Broadband To The Skies

Radio scientists in the UK have demonstrated the first
air-to-ground ‘mesh broadband’ connection. A
microlight plane established a broadband connection
with the South Witham mesh, at an altitude of 2,000

feet. Voice and data traffic was sent over the link.

FIVE FEET UNDER

Talk To The Dead

We don’t know what
exactly to call this—a
gadget? A service? An idea?
Whatever you call it, Jiirgen
Brother’s ‘invention’ allows
you to listen to the sound
of grave soil. Seriously, it is
supposed to enable a link to
the body of the deceased—
useful if one couldn’t
attend the funeral.

The German innovator’s
offering, the TelefonEngel
or ‘Phone Angel’, consists
of three items in a box—a
mobile phone, a high-
power battery, and a small
loudspeaker, all in a
waterproof container the
size of an average shoe box.
The loved ones of the
deceased are supposed to
bury this kit at the grave,
keeping it 12 inches above
the coffin.

Anyone can then phone
in, and here’s where the
Phone Angel kicks in. You
get to say whatever you

My Desktop

hink you have the most

beautiful, most innovative
desktop around? Send it to
mydesktop@thinkdigit.com, and
Digit will publish the most

eye-catching of them each month.

The winner "
receives a copy
of Unix for
Programmers
and Users, Third
Edition

By Graham Glass and
King Ables, published by
Pearson Education

This month’s winner is
Ranadeb Ray, Mumbai

_ il
Jiirgen Brother with his invention

want, and it will be
faithfully played back
through the speaker—and
what you get to listen to is,
well, nothing, since the
deceased is, well, dead.

One is tempted to say at
this point, “So this is
progress? Is this what
technology is getting us
to?” and so on... but we’ll
let that pass.

One also wonders what
would happen to someone
if he or she called and
actually got a response
from the other end...

Cell Phones As Bar-code Scanners!

New York inventor Bruce Hodge and his partner have created
technology that allows people to comparison-shop with their

cell phones. In early February in New York,

1

[3

sv1n?| E

he demonstrated | 280
it by waving his cell over a bar code: the phone listed the

closest places to buy the item, and the cost at each retailer.

Cyber-café
Crackdown In
China

hina has long had an

anti-cyber-café agenda,
and every now and then,
we see reports about what
the government has been
doing to implement its
stance. It has recently
emerged that Chinese
authorities closed down
12,575 cyber-cafés in the
last few months of 2004.

According to the
official Xinhua news
agency, most of these
close-downs happened
because the cafés were
“operating illegally.”

And what exactly was
illegal about the cafés’
operations? It turns out
that they were too close to
schools. Chinese Internet
cafés are supposed to
operate under a set of
strict guidelines, and many

Ranadeb Ray’s desktop has really been customised

beautifully; way to go Ranadeb
Sent in by Ranadeb Ray, Mumbai

UNUSABLE!

http://calcutta.city
news.com/

éé Calcutta, India Photo

Classifieds and

Bargain Province-
wide Ads”. A little cryptic?
The layout is deliciously terri-
ble, with overlapping text,
and links that seem to have
no business being there.
What are “free chats” doing
on a classifieds site? What is a
“Provincewide Ad”? And
most intriguing, what are
“Biggerads”?

The real fun begins when
you dig a little deeper. Click
on the ‘Employment & Help
Wanted’ link. There’s an ad
from Brooklyn, one from
Aberdeen, Scotland, one
from San Jose, and one from
Tokyo—“Come and work at
the top strip clubs in Tokyo.”

Click on ‘Baby sitters’,
and you get the same ad
from San Jose, and one say-
ing ‘Work At Home While
Nurturing  Your  Kids!
Clicking on ‘Education’ takes
you to the same San Jose ad
(which, incidentally, is about
boosting the power of your
cable connection), as well as
a link that says ‘Protect
Your Child From Abduction’!
The list goes on—clicking
on ‘Motorcycles’ takes
you to ads that purport to
help you track your car
24/7, and so on.

Hilarious  navigation.
with not a word about
Calcutta, Kolkata, or, for that
matter, even India.
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People Who
Changed
Computing

So, are the sneakers free
with the computers, or is it

WIN!
A Mini Keypad by Travel Pac just by sharing an amusing picture with
a tech angle to it. The picture should be shot by you, and should not
have been published earlier.
Send your picture to digipick@thinkdigit.com.

The prize-winning picture will be published each month.

This month’s winner is
Vikram Bothe from Pune. He
wins an

the other way around?

NBA LIVE 2004

worth Rs.1,299/-

from Gayatri Impex Pvt. Ltd.
Express your game with new
freesyle shooting, signature
moves, mid-air shot
adjustments, and more.

of those that were closed
most recently broke rules
that limit how close they
can be to schools: they
need to be at least 200
metres away.

China seems obsessed
with the so-called moral
issues related to Internet
usage, a culture breakdown
among the youth
stemming from the use of
the Internet and playing
violent video games, and so
on. For example, the recent
shutdowns are the latest in
a series of steps the
government has taken
to crack down on
“immoral Net use.”

All the one lakh or so
cyber-cafés in China are
required to use software
that controls what Web
sites users can view.

The government also
keeps logs of all the sites
that its people visit. The
‘Reporters Without
Borders’ group said in a
report that the
technologies that the
Chinese government uses
to intercept e-mail and to
censor the Internet usage
of its citizens, are amongst
the most highly developed
in the world. Big Brother
really does watch you
when you are in China!

ABSTRACT AND DYNAMIC

Modern Art
On Ancient
Machines

pple’s ancient, easy-to-

use programming tool,
HyperCard, has found an
afterlife—at the cutting
edge of European modern
art. British artist Richard
Bolam uses HyperCard to
create generative art using
ancient Mac classics. Bolam,
who lives and works in
Sheffield, England, is
gaining recognition as an
artist successfully working
with technology.

What’s interesting here
is that he doesn’t use the
latest technology; quite the
contrary, he uses the
relatively ancient
technology embodied in the
HyperCard software and
old Macintoshes.

“I enjoy embracing the
technology of old Macs,”
Bolam said.

A recent work,
Hyperscape 1, was shown at
Sweden’s Malmé Konsthall
as part of the Electrohype
festival. Hyperscape 1 is a
generative art installation

that runs on eight compact
Macs. One Mac runs a
program that Bolam wrote
in HyperCard.

The HyperCard program
determines the screen
output on the other seven
machines. All the screens
start out blank, and
steadily fill with semi-
random shapes and
images. The master Mac
running HyperCard
proposes certain image
manipulations—inverting
areas of the screen,
tracing edges or copying
parts of images—and the
other machines decide
whether or not to accept
the changes.

The result is abstract,
random and dynamic—an
ever-changing montage of
broken and distorted
shapes spread across the
eight screens.

Bolam said the idea is
to illustrate how humans
process information. “If
you put a series of objects
in a line, your brain looks
for similarities as they’ve
been queued,” said Bolam.

“It is obviously
organised. Hyperscape 1 is
just the opposite: because
the screens are all similar,
the brain looks for
differences,” added Bolam.

The Wizard
Behind
Windows

ne of the most

important people in
Microsoft’s history, David
Weise, was one of the
developers responsible for a
technical breakthrough
that brought about the
success of Windows.

After leaving Princeton
with a PhD in molecular
biophysics, Weise and a few
others
founded
Dynamical
Systems
Research
(DSR) to
create a
clone of
Topview,
IBM’s text-based multi-
tasking shell that was
supposed to revolutionise
the PC industry. It was an
utter flop.

Microsoft was looking
at integrating Topview
support into Windows. In
1986, Microsoft acquired
DSR and hired Weise. Just
two years later, Microsoft
was planning to abandon
Windows and move to
IBM’s OS/2. However, Weise
figured out how to get
Windows to run on the
80286 in ‘Protected Mode’.
Thanks to this
breakthrough, Microsoft
out-marketed IBM. Weise is
credited with almost single-
handedly making Windows
a viable product—Windows
3.0, soon after its release,
was the most successful
software project in history,
selling more than 10
million copies a month.

Weise was made a
‘Microsoft Distinguished
Engineer’ in 2002, a title
that marks the pinnacle of
a developer’s career at
Microsoft. He quit
Microsoft in February, and
now intends to pursue
molecular biology.

David Weise

DIGIT MARCH 2005

121



122

Escape

Web Designers

Every notable company has a
Web presence today, and they
all have “Web designers” as
employees. Here’s a small list of
words that will help you better
understand what these Web
designers are chattering about.

Cookie: Small text files that
your browser stores. They
contain data such as passwords
and login information.

Usage: Set the page cookie to
expire after an hour. People
have complained that our
session is too short!

Plug-in: A software that
attaches itself to your browser
in order to give the browser
additional functionality, such
as playing Macromedia Flash
or Apple Quicktime movies.
Usage: | wish I had a plug-in
for IE that would plug in my
coffee machine at work!

Flash: A Macromedia
standard for animations with
small file sizes. A plug-in for a
browser to allow such
animations to be displayed.
Usage: I'm looking for a job
again! The boss wasn’t pleased
with the Flash | embedded in
the presentation. Personally,

I thought the 83-year-old man
flashing was really funny!

Rollover: An action or text that
displays when you roll your
mouse pointer over a
hyperlink.

Usage: Making rollovers in
Dreamweaver is so easy! |
wish Macromedia would
make software to teach my
stupid dog how to roll over
just as easily!

Hyperlink: A link in a page
that points to a page or file.
Usage: The Web site was
perfect...except we forgot to
hyperlink the pages on the
home page!

Bot Friendly/Search Engine
Optimisation (SEQ): Search
engine bots read pages
without graphics. Web sites
need to be tweaked for these
bots to get a higher listing.
Usage: No sir, our site is most
definitely bot friendly. We
spent hours on search engine
optimisation. It’s just that with
the recent scandals, it’s
impossible to get your site
MissJammu.com to number
one right now.

Of PDA Phones And Mac Minis

I eep a skimpily clad Mallika Sherawat
in a room and a PalmOne Treo 600 on
the table adjacent to her, and you can bet
your last buck that our Test Centre guys
will pick the PDA phone. For them, the
feel of a PDA phone is like, well, actually

let’s skip the details.

It was no surprise, therefore, that not

DIGIT DIARY

temporary?) of PDA phones with the rest
of the crowd at Digit. Selfish pigs, we call
them. Plus there was the O2 XDA II Mini,
a smaller version of the original beauty.

We must admit that looks-wise, the Mini

a single person from the
Test Centre decided to
share their collection
(and so what if it was

MULTIPURPOSE MOBILES

Cell Phones
Turn Into
Golf Clubs

he local branch of

British mobile giant
Vodafone recently unveiled
the V603SH. It has been
billed as the first phone in
Japan to respond to
movements—and it will let
users perform basic mobile
functions via programmed
shakes and jerks. But the
appeal of the 142-gm
V603SH goes beyond that.

The phone can be used
as a golf club—users putt
with the phone, then look
back at the screen to see
how well they did. It can
also be moved like a gun
for the shooter game
‘House of the Dead’.

Both these novel uses
for the phone could mean
merrier times on the Tokyo
subway, where people often
sit glued to their phones.

TALK ABOUT WEIRD!

Top 10 Weird
Stuff On
eBay

Talk about inspired
selling! Flip through
eBay’s ‘Weird Stuff section

is not a patch on its big brother, but an
02 is an 02. Sanket Naik fell in love with
the Nokia 7710, a product he refused to
let go for quite some time, and when he
had to do the inevitable, you could see
quite a few unshed tears.

If it were one of those K serials,

Sanket could have got an automatic

casting as a harassed son-
in-law. Last heard, he was
still in mourning because
of the Nokia 7710. “Wait

until April,” he told his sympathisers,
“when I get my raise!” We will wait.
Then, there was the Apple Mac Mini,
which sent Senior Writer, Ahmed Shaikh
into raptures. But that’s another story!

g AR

for a taste of the wackiest
ways to make an extra buck.
The ThinkDigit Forum
recently received news of an
extremely unusual item up
for sale on eBay—a man was
auctioning his wife’s PMS,
which, he claimed, “is in
excellent condition. You
won’t find a more
authentic or volatile PMS
on the market. My wife’s
PMS is always right... wins
every argument... can fight
your wife’s or girlfriend’s
PMS with certain victory...”
Scouring eBay led to the
discovery of many more

such inspired sellers. Here’s
our selection of Top Ten
Wacky Items:

1. Soul For Sale: A 26-year
old artist from Newcastle-
upon-Tyne (UK) actually
sold his own soul on eBay
for $16.95 (Rs 737).

2. Kangaroo Scrotum
Pouches: Better known as
‘The Golden pouch’—
genuine Kangaroo Scrotum
Pouches from Australia.

3. Ad Space on Forehead: A
20-year-old from Omaha,
Nebraska (US) was selling
advertising space on

his forehead.
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were

Once more! Once more!”

WwWw.

googlefight.com

WATCH™!
As we do each month
in this space, we take
a look at some read-
worthy blogs. This
month, there’s one
about a Microsoft

thinking

www.googlefight.com

his is one of those this-is-cool-but-gets-boring-in-twenty-sec-

onds sites. The first time you do it, it seems like fun. “Hey, God
versus Satan! This is cool!” The second time you do it, it still
brings a smile to your face—“Hey, My Girlfriend versus Pamela
Anderson! Cool!” The third time—nah! You are bored already.

What this site does is simple. In fact, really simple. You
type in two search terms, such as ‘India’ and ‘Pakistan’, and
googlefight.com compares how many results turn up on
Google for each of those two terms. That, essentially, is the
fight. Then there’s a graphic representation of who ‘won’,
along with an animation—the same one every time—of one
stick-man bashing another stick-man.

Seriously, how long did they expect people to stick at this
site? Anyone who frequents this site needs to seek medical
attention! It’s perhaps only children who would go, “Again!

If you find yourself asking, “I wonder which term has more
results on Google, ‘me’ or ‘myself’,” just go to Google, type

in the search terms consecu-
tively and look at the number of
results thrown up. Not only will it
save you time, it will also save
you from having to see that stu-
pid stick-man animation and the
simple bar graph over and over.

And oh, by the way, ‘God’
hammers ‘Satan’, ‘India’ beats
the pants off ‘Pakistan’, and ‘My
wife’ (Google) fights way better
than ‘My girlfriend’...

4. Original Bullet Holes:
The original “Hardley-
Dangerous” bullet holes
along with display stand.
“The sizes of bullet holes
range from small
(miniature impacts) to
medium (high impact) to
large (rapid fire). They are
all brand new and sealed.
Great for a store front resale
or just gag gifts.”

5. The Meaning of Life: The
seller, who claimed to have
gained enlightenment from
a fisherman, put up the
meaning of life for sale for
78 cents (Rs 34).

6. Beatles’ Toilet Paper: A
roll of (unused!) toilet paper
formerly owned by the
Beatles had a $76,000 (Rs 33
lakh) bid on eBay.

7. Real Shrunken Heads:
Handmade goatskin and
hair shrunken heads approx.
4”-5” tall; direct from the
jungles of the Ecuadorian
Amazon, where the original
tsantsa ritual of head
shrinking was performed.

8. Crisp Clean Canadian
Air: “Every living human
needs air, and who wouldn’t
want some clean fresh air

with all the pollution now-a-
days,” claims the seller,
who’d ensure that the air
will be delivered in a
tightly-sealed vial.

9. A Ghost: In an attempt to
placate his five-year old son
who was afraid of his
deceased grandfather’s
ghost, a distraught dad did
what he thought was best—
put up the ghost for sale.
10. Acre of land on Mars: A
whole acre of land on the
Red Planet! More or less.
Until humans actually step
foot on Mars, a certificate of
ownership “presented on
luxurious parchment, fully
personalised, ready

for framing...”

Other items on sale
ranged from Britney Spears’
chewed gum to hurricane
debris, to entire towns, the
US of A, Osama bin Laden’s
toilet, mining barrels of
unsearched rubies and
diamonds, unsearched bags
of uncut sapphires... ®

Compiled by Aditya Kuber,
Meera Vankipuram,
Renuka Rane and

Ram Mohan Rao

MeyerWeb
http://snipurl.com/co6l

Password Production

It occurred to me that | ought to pass along a
password-generation technique I've used for years
now. Maybe it’s a well known technique, and maybe
not. In any case, my best recollection is that I learned
it from either John Sully or Jim Nauer back in my
CWRLU days. The general idea is to pick a two-word
combination you can easily remember. For example,
suppose you’re a big fan of pizza and Pepsi, and
would have no trouble remembering those words.

employee’s reaction
to the continuing
news reports about
Firefox’s growing
popularity; one about
how to make up your
passwords;
something about the
organisation of our
digital information,
and then, there’s

Geeked
http://snipurl.com/co6n

Thoughts on the Digital Lifestyle Aggregator

I am still hooked on Marc Canter’s concept of the
Digital Lifestyle Aggregator. Think of it as a local
node that lets us have the best of both worlds: the
awesome informative and communicative power of
the distributed Internet, and the centralisation/
aggregation of those bits of information created by,
or most relevant to, an individual person...

something called the
Digital Lifestyle
Aggregator

Neopoleon.com
http://snipurl.com/co60

Firefox Pomposity
As always, I've been watching Slashdot lately. To
recap for those of you who may have missed what’s

going on, here are a few recent post titles:

“Firefox use up .00032%”

“Firefox use up .0078% in Tennessee”

“Microsoft employee admits to using Firefox”

Etc.

Outside Slashdot, something else happens that |
find interesting: Often, when someone learns that |
work for Microsoft, one of the first things I’'m told is,
“l use Firefox,” and it’s accompanied by a defiant
look, as though I’'m supposed lose control over my
bowels and ruin a perfectly good pair of shorts upon
hearing the news that Morton B. Pumpernickel isn’t
using my company’s browser anymore.

I’'m not sure what it is that drives people to want
to tell me that, but | wanted to state, for anyone of
this mindset who might be reading, that | don’t care.

Always-On Network
http://snipurl.com/co6m

The Growing Market for Organising
We thought Google’s eight billion crawled Web pages
was a lot. We haven’t seen anything yet.

Our own content will likely dwarf what’s currently
being created by large media and the traditional
providers of information.

As everything becomes digital, the need to
organise the information becomes even more urgent.
That’s why I believe that organizing our digital world
is not a minor feature, as some have said about
desktop searching. In fact, these features will be far
more useful and addicting than we think.
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Digit Forum

Are We alone in this Universe ?

rajesh

Warmed-Up Nerd
Location: Bangalore
I always wondered: are we alone in this
universe?

| don’t believe we are alone though.
What are your thoughts guys?

swatkat

Digitized!

Location: Shimoga, Karnataka

In my opinion, we are not alone!!! But, an
even more interesting question is why UFOs
visit only USA??!!!

babumuchhala

Resident Techie

Location: Vashi, Navi Mumbai

I think we are the only ones in this whole
Universe. Guys just think over these
Questions seriously for a minute or so:

1. They say the Universe is always
expanding and there is nothing outside the
Universe (not even a vacuum). So where is
the Universe Expanding into?

2. They say the Universe began with a
Big Bang. What created such an explosion?
What was there before the Big Bang?

3. If we assume God Created
everything, then who created God? Where
did God come from?

borg

In-House Geek

Location: Delta Quadrantl

If someone asks who created God, then the
question doesn’t conform to the very
meaning of God. The moment you say that
God was created, it means that the entity
you assumed was God, was not God at all.

FastCoder

Analogue Novice

What if the aliens have already landed, and
are keeping us in a matrix. All the UFO
sightings may be glitches in the matrix...
neerajvohra

In-House Geek

I don’t know about the Universe, but | am
alone in my room now!!! Lol

sreevirus
Digitized!
Location: The 3rd rock from the sun
Life on earth was the result of coincidental
chemical reactions which took place at the
right place at the right time... the conditions
on earth were perfect enough for life to
sustain itself.... now in this universe, why
cant there be another world where the
conditions can be perfect for life? The
probability is still there, though not large.
Have a look at the Drake Equation...it
pretty much sums it up...
http://www.seti.org/site/pp.asp?c=ktJ2
JOMMISE&b=179073
http://www.activemind.com/Mysteriou
s/Topics/SETI/drake_equation.html

To post your comments on Digit Forum,
visit www.thinkdigit.com/forum

Yeh Dil Maange NMore These days, it would be a cliché to say
I am an active member of the ThinkDigit | that Digit is India’s No 1 technology
online forum. Add dedicated to active, magazine. I would be the first in line to
and you will know what I actually feel say that you get all your readers on the
about the forum. Most of my computer right track of technology knowledge.
or technology related problems are Having said that, may I suggest a couple
solved by my peers and buddies on the of things to take Digit to the next level:
forum. Sometimes, even I help other [E Add a glossary with every issue of
people with their problems. It is a Digit; it would help beginners to
perfect society out there—you get as understand the language that
much as you give. technocrats use. I am not a beginner
But most of my friends are not even myself, but I found some terms in the
aware of the ThinkDigit forum. What is January and February issues daunting.
shocking is the fact that most of them [E Please avoid ads in the middle of an
actually subscribe to the magazine. Just article. It diverts the reader’s mind, and is
imagine if they had known about the more irritating than informative.
forum, how vibrant and active the online Until now, Digit has been the single-
discussions would have been. I am sure largest reason for all the change in my
they lose out in the end. life, thanks to the gyan on technology.
But all is not lost. There is a way Ditto for my fellow students in college.
around this. Why not accumulate all the My suggestions could just take Digit to an
great posts on the forum, and publish undefeatable level.
them in the form of a separate book (just
as you had compiled 1001 Amazing Tech R X Marshall
Facts last June for the anniversary issue). Tuticorin

And once you have released such a book,
maybe you can keep compiling a “Best of | Dear Lovedeep and Marshall,
ThinkDigit Forum” series, and give them It is really heartening to note that our readers

along with the magazine every six are thinking of innovative ideas. It keeps us on
months. Here are the benefits: our toes all the time. We will definitely work out
[E Magazine subscribers, who are not the feasibility of your idea. In the meantime,
forum members, would get a chance to please enjoy our newly-introduced book ‘Fast
read some great posts of the forum. Track’, your handy guide to everyday technology,
[E They will find out what’s going on in bundled free with this issue.
the forum, and may be influenced to This time around, we have an entire book on
take part there. Digital Photography. And for the next 12 months,
[E The original authors of the posts will Digit will publish a book on a specific topic with
get recognition, and would be every issue, thus delivering reader delight month
encouraged to post more forums. after month. It is value for money like nothing
else, right?
Lovedeep Wadhwa As far as your other suggestions are
New Delhi | concerned, we will definitely try and implement
them soon.

—Executive Editor

Digit

Click here to go back to Share your views with the Digit Community, exchange tips and tricks, look for previous Digit issues, etc.
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The ThinkDigit forum: a place to exchange ideas




Bust The Google Myth

On Page 81 of the February 2005 issue of
Digit, in the story relating to Gmail, the
Web site address provided in Step 1 was
incorrect. The correct address is
www.viksoe.dk, and not www.viskoe.dk
as mentioned.

But that is not the real reason for
writing this mail. The media the world
over goes gaga whenever Google does
something. It may have been justified at
one point of time. Not any more. Google
may have become synonymous with
online search, but if Microsoft’s beta
version of search is anything to go by,
then hard days are up ahead for Google.

Search for any term on both Google
and MSN, and check the results for the
following:

[E Number of results generated

[B Relevance of the results

B Speed of loading the page

B Last updated date of the cached
version of the page

Is MSN Search really better than Google?

The truth is that MSN wins hands
down in most cases. I am no MSN junkie
nor am I being paid by Microsoft to write
this mail. I also know there are a lot of
people who swear by Google, and will
vehemently disagree with me on this. So,
how about checking it out on your own?

Maybe Google could strengthen
its search capabilities, and retain its
No 1 position.

Ramanpreet Singh
New Delhi

Dear Ramanpreet,
Cola wars are part of advertising and marketing
folklore. The 215t century’s online history could
well begin with the war of the searches. With
Google, MSN and Yahoo vying online for a piece
of the search pie, it is only logical that all three
players come out with more and more
innovative products every month. While most
people at Digit prefer Google, we are not
loyalists. If a better search engine comes along,
we will hop there. Having said that, we just
cannot take Google lightly. After all, it has some
of the world’s best software engineers and
leaders including Sergey Brin, Larry Page and
Eric Schmidt heading its dynamic team. Our
opinion is, don’t write off Google just yet.
—Executive Editor

Write to the Editor
E-mail: editor@thinkdigit.com

snail Mail: The Editor, Digit, D-222/2, Om Sagar
Building, MIDC, TTC Industrial Estate, Nerul,
Navi Mumbai 400 706

Some Random Observations
Digit’s December and January issue were
simply great! Thank you for the
Encyclopaedia Britannica Concise
Edition CD. It was a pure treat to read
all the gadget reviews, and I even got to
learn a lot about Formula 3, courtesy
the race driver Karun Chandok. The
story on Jagdeep Dangi and his Hindi
browser was unique, and was a positive
piece on how one can overcome
challenges to succeed in life.

When I read the piece I wondered
why Indian technology biggies do not
come out with affordable software
products for the Indian market. Given
their expertise and financial prowess,
they could easily give even the giant
Microsoft a run for its money, and
greatly help in reducing piracy due to
cheaper software.

Fuelling The Need For Speed

Discover Ehe technology that
Farmuls 3 raing cirewit

oo vmrperim

Digit: navigating you through more than just tech

I have a similar opinion about
hardware. Unless India gets
manufacturing plants to produce all the
components of a PC here, I doubt
whether we will be able to achieve the
sub-Rs 10,000 PC dream.

Let’s hope that we see a day when
affordable computing becomes a reality.

Nitin
Via E-mail
Dear Nitin,
Your observations are well thought-out and
perceptive. It is indeed a paradox as to why India
supplies some of the world’s best customised
software to various countries, but has no product
to show off for the domestic market. Perhaps the
day will come soon when we will be able to
assemble sub-Rs 10,000 PCs in India.
—Executive Editor

Digit will publish the best letters on these pages.
Letters may be edited for clarity

For subscription queries, call the Help Desk at
022-27629191/9200 Fax 022-27629224, or

send an e-mail to help@jasubhai.com

Inbox

Apple Of My Eye

Ilearn, breathe and sleep design at
the National Institute of Design
(NID), Ahmedabad. I may not be a
technologist anymore, but I have to
deal with it in every product, which
I design or think of.

For years, Digit had been my
‘navigator for technology’, and it
continues to be so for me, a loyal
subscriber, even after that
‘sensible’ decision I took to LETTER
leave all the so-called service OF THE
packs, patches, blue screens, MoNTH
and viruses behind and switch
over to the Apple Macintosh!

As expected from the Mac cult,
it is not just brand loyalty that
prompts me to write this mail. The
“Old Way Tech Way” article
comparing an iPod with the
Walkman (Digit, February 2005)
does no justice to the
Apple product.

Admittedly, the Walkman was a
revolution when it was introduced.
It created a new concept of carrying
music; but so did iPod change the
way people buy and share music.
Even Steve Jobs might not have
anticipated that music could bring
more revenue for Apple than all
their products put together.

Does Digit really feel your brand
head’s Walkman deserved a smiley
face for that it takes more than an
hour to load a 20-song playlist
compared to less than half an hour
the executive editor took to import
your entire music collection for life
to an iPod? Or do you feel the total
cost of Rs 1,055 for only 20 songs is
much cheaper than Rs 15,000 for
3,000 songs? I guess the total cost
for the Walkman didn’t consider
the cost for hiring a truck to
carry the entire music collection as
audio tapes!

It is a wrong to say that Apple
product owners are only show-offs;
the user-experience that one goes
through can never be replaced by
anything else! I did not expect Digit
to make a comparison based only
on someone’s personal views.

Nithin Ismail
Ahmedabad
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People And Events That Grabbed Headlines—For Better Or For Worse

Preference
for Pink

Melanie Griffith: | want pink—now!

The associate,
who asked to
remain anony-
mous, said Griffith
came right up to
him and “pretty
much demanded”
a pink iPod mini.
The mini was in
short supply, and
the associate told
her there were
none in stock.

He told Wired
News, “She then
proceeded to get
pissed off at me
personally
because we didn’t
have any in stock.
She said we have a
special stock of
iPods for people
like her.... I hadn’t
seen any celebri-

Apple retail stores in the

Los Angeles area have
plenty of opportunities to rub
elbows with Hollywood
celebrities. And it turns out
isn’t always pleasant.

Hollywood actress Melanie
Griffith, according to one
associate, threw a tantrum
when she was unable to buy a
pink iPod mini early last year.

Sales associates at the four

ties there up until
then, so at first I was like,
‘Oh wow, cool, Melanie
Griffith.” But then she
opened her mouth and used
me as a doormat.”

Other celebrities who
have indulged in pompous,
obnoxious or cheap behav-
iour at Apple’s LA stores
include singer Pink, and
actors LeVar Burton Val
Kilmer and Fred Durst.

So It Was You?

Jordanian recently
Adivorced his wife after

discovering that she was
also his virtual girlfriend.

Bakr Melhem had been
flirting with a woman on an
Internet chat room for several
months before the two decided
to meet. When they finally met
at a bus station in Zarqa near
Amman, he recognised her to
be his wife Sanaa!

The wife had described
herself as an unmarried
Muslim lady whose cultural
interests included reading.

Bakr Melhem immediately
shouted the Arabic words for ‘I
divorce you’ thrice. Jordanian
news agency, Petra, reports
when the man uttered the
words that effectively ended
their marriage, she called him
“a liar” before fainting.

Sleeptexting!

ritain is a nation of
B prolific texters, as we

reported earlier. As a sort
of ‘proof’ of this, it has emerged
that a man in Swansea, Wales,
sends text messages in his
sleep—a sign of the times,
according to a sleep expert.

Richard Griffiths, 23, has
sent a series of messages while
asleep—one even mirroring a
nightmare he was having.

He said: “I text so much it’s
second nature. But I was still
freaked out.” He once sent a
text message to his friend

Ashley Jones saying: “Help, I'm
in trouble, someone’s chasing
me.” She immediately rang
back, and found that he had
been only dreaming and was
not in trouble.

Another text, referring to
the film Jungle Book he had
seen, read: “Baloo, have you
seen Bagheera?”

Sleep expert, Professor
Chris Idzikowski, said: “I
have not heard of this before,
but it is entirely plausible—
and possibly a sign of the
modern age.”

‘Cybersex’ Takes
On New Meaning

im Jong-Hwan, director
I( of IRRC (Intelligent

Robot Research Centre)
in South Korea, plans to give
the gift of sex to robots. He
has developed a series of arti-
ficial chromosomes, which,
he claims, will allow robots to
“feel lusty.” It could eventual-
ly lead to them reproducing,
reported Free Internet Press, the
news portal.

OK, so it’s all about soft-
ware in the end. Jong-Hwan
said the software would,
amongst other things, give
the machines the ability to
“feel, reason and desire.”

“We must consider this as
the origin of an artificial
species. Until now, most
researchers in this field have

focused only on the functional-
ity of the machines, but we
think in terms of the essence
of the creatures,” said Jong-
Hwan, a leading authority on
the technology and ethics of
robotics. According to him, the
‘essence’ is a computer code
modelled on human DNA.

“Robots will have their
own personalities and emo-
tions, and as films like ‘I
Robot’ warn, that could be
very dangerous for humanity.
If we can provide a robot with
good, soft chromosomes, they
may not be such a threat,”
Jong-Hwan said.

We are not very clear on
what “good, soft chromo-
somes” means—but let’s wait
and watch.
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